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Foreword

VisualAge Pacbase WorkStation Reference Manual

Operation of the VisualAge Pacbase WorkStation requires at least the
installation of the Repository module and of Personalized Documentation
Manager (its extension) on the host. The reader should be familiar with these
products.

For complete information, refer to the following VisualAge Pacbase Reference
Documentation:

= User Interface Guide

= Specifications Dictionary Reference Manual

= Personalized Documentation Manager Reference Manual
The User Interface Guide introduces basic VisualAge Pacbase concepts and
functionalities, for example:

» Entities and their related screens

= Hierarchical library network

= Current and frozen sessions

= User access authorizations
The WorkStation operates on PCs connected to the VisualAge Pacbase host.
The host part and the corresponding host platform may be one of the following:

= Mainframe

= 0S/2

= WINDOWS N/T

= UNIX
The WorkStation runs under:

* DOS/MS-WINDOWS 3.1 or 3.11

= WINDOWS 95

= WINDOWS/NT

= WINDOWS for Workgroups

= 0S/2 2.1 with WIN-OS/2

A good working knowledge of the operating environment is therefore required.
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Organization of the WorkStation Documentation

The WorkStation Reference Manual is divided into five sections:

The first section, entitled General Principles , provides a general
presentation of the WorkStation and its functionalities. This introduction
presents an overall picture of the product.

The second section, entitled Navigation in the WorkStation , describes
how to connect to and disconnect from the WorkStation. This section
also describes the WorkStation Manager window and navigation in the
WorkStation.

The third section, entitled Description of the WorkStation Windows
provides a full description of each window in the WorkStation. Each
window is described in a separate section.

NB: The description of all dialog boxes related to a given window
constitutes a specific subchapter.

The Business Components window (semi local) specific to Folder and
Folder View entities, run exclusively by Pacbench Client/Server, is
documented in the User’s Guide — Pacbench C/S — vol Il.

The fourth section, entitled Appendices , contains three subchapters
describing the correspondence between the VisualAge Pacbase
WorkStation commands and the host commands, the keyboard and
mouse shortcuts in the Logical Screens and the error messages.

The configuration, installation, starting up and everything related to the
management of the WorkStation and its modules are described in the
VisualAge Pacbase WorkStation Operations Manual.

The Communications - VisualAge Pacbase WorkStation and PAW Manual
describes the installation and optimization of communications between the
host and PCs (also includes the PACLINK ultility).
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The following typographic norms are used in this manual:

¢ Titles of manuals are shown in /talics.

* Titles of Chapters, subchapters, sections and paragraphs are indicated by
“Quotation Marks”.

e WorkStation menu and command names are in Bold .
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SECTION 1 GENERAL PRINCIPLES
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The Evolution of Data Processing Environments

The development and increased use of Personal Computer (PC) data
processing has changed the type of hardware involved in business information
services. Since PCs can be connected to a host via emulation boards and have
a capacity for local storage and processing, PCs have been progressively
replacing traditional terminals. The result is the decentralization of tasks and the

use of sophisticated Graphic User Interfaces (GUI) involving windows and a
mouse.

Terminal

Terminal

Emulation
Board

Terminal

Emulation
Board

This new configuration is not yet operating to its full potential because a
boundary still sometimes exists between host-based software and PC-based
software. For example, the host manages batch and online applications, and

PCs manage local applications. With such systems, transferring files via
external utilities is sometimes required.
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,///”', \
On-line and Batch [ HOST
Applications
" File transfer
A - ~
Emulation P Emulation
Board T~ Board
—— [ — _
S [
PC in emulation mode Local
PC in local mode Application

A software type which gets the most out of this new hardware architecture has
now crossed this boundary: it runs on both the host and PCs so that all
processing facilities can be accessed entirely from the PC through a user-

friendly interface.

HOST

Application operating

PC

on both host and PC

Emulation
Board

With the VisualAge Pacbase WorkStation, which optimizes PC/host
cooperation, you have genuine client/host software . You can optimize your

work by taking the most of the storage and processing capacity available on the
host and on your PC.
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Objectives of WorkStation

Productivity of application development requires that the entire application life
cycle be considered as a whole from the design phase up to the maintenance
phase Today, applications cannot be designed without a methodology.

System designers and analysts need a user-friendly data processing tool used
throughout the development process: their work must be continually re-used
from one phase to another.

It is essential to establish good communication between the people in the Data
Processing Department. It is also important to establish good communication
with the end-users in order for these people to participate efficiently in the
project.

The methodological approach relies on the building of models and graphs. As
these models and graphs are validated, a detailed image of the project
emerges.

To achieve these objectives, you must use a unique and integrated software in
order to cover the entire life cycle of an application. This software will:

* Provide design support
* Guide and facilitate the methodological approach

e Be fully integrated with the development software, thus allowing
programmers to use the work of designers and analysts immediately

* Be user-friendly so that all participants, end-users included, can be truly
involved in their respective phases
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The WorkStation is a software product which operates simultaneously on a host
and connected PCs.

With its modules (Pacdesign and VisualAge Pacbase), the WorkStation covers
the design, analysis, production and maintenance phases of an application. It
provides complete logistical and methodological support, integrating models
associated with different design methodologies such as MERISE, SSADM, YSM,
OMT or IFW.

The WorkStation benefits from all VisualAge Pacbase functionalities, making
them accessible from a PC via a GUI.

The system designer or analyst has online access to the Specifications
Database for consulting or updating. During subsequent phases, the
programmer accesses the same information. As a result, the vocabulary used is
consistent throughout the entire application life cycle, thus facilitating
communication between all participants.

The WorkStation also facilitates:

* The construction, local printing, and validation of graphs with respect to the
design methodology,

* Processing and local printing of texts,
* Local printing of complete design documents containing graphs and texts
together (refer to chapter “The WorkStation Manager Window”, subchapter

“The Menu Bar of the WorkStation Manager Window”),

* The possibility of working in draft mode (purely local processing: drafts need
not to be defined in the Specifications Database)

* Local Screen Mapping and Simulation
* Semi-local management and processing of Segment Calls

* Semi-local management and processing of Business Components Calls
(Folder and Folder View)

* Specific coding of Programs and Screens

Occurrence descriptions are entered locally and modified under the GUI. When
desired, they are uploaded into the Specifications Database.

The WorkStation offers an integrated methodological tool which enables you to
visualize managed entities for each module at each design and development
phase.

Using the WorkStation, a company Management Information System is fully
consistent. The VisualAge Pacbase functions provide total data integration to
ensure perfect continuity from the application design phase through to the
maintenance phase.
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Division of Tasks

Host

PC

Since the WorkStation operates on both a host and PCs, tasks are divided as
follows:

* Checks and ensures data consistency
* Allows data sharing

* Ensures integrity of the Specifications Database

* Manages the GUI and offers a user-friendly tool with multi-windowing,
mouse, colors and graphic functions

For example, a toolbar is available in almost all windows. The icons which
constitute this toolbar vary according to the window and facilitate access to
some of the menu commands they represent. Generally, this toolbar is not
documented since you can activate tooltips that explain each icon's
functionality.

* Manages access to the host making access transparent to the end-user

* Temporarily stores those elements not affecting the integrity of the
Specifications Database
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Information Distribution and Consistency

Since the Specifications Database is updated by both the host and the PC, data
consistency is required.

All occurrences are defined in the Specifications Database and consist in:

* A definition which includes basic information (code, name, keywords, etc.)
* Descriptions which make up an occurrence

* Comment lines

* Cross-references with other occurrences, automatically maintained online by
the system

Elements which affect data consistency (definition, some descriptions, cross-
references and general documentation) are stored in the Specifications
Database only.

Elements which do NOT affect data consistency (i.e. some descriptions) may be
automatically downloaded and temporarily stored on a PC. However, for
security reasons, the Specifications Database remains the primary data storage
space.

Data consistency is ensured because:

* |t is impossible to create two occurrences with the same code for a given
entity (in the same library)

e An occurrence cannot be deleted if it is cross-referenced to other
occurrences

Management of entities is illustrated in the following diagram:

Definition

—pp X-References

Data consistency affected

General

Documentation

HOST

PC

Ca

Description
Stored on the host

Description

Data consistency not affected

Description

Description

May temporarily be stored and
managed on a PC, then uploaded
onto the host
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Data Sharing and Consistency

All data managed by the Specifications Database can be shared.

In order to ensure consistency in the Specifications Database, simultaneous
updates of locally managed descriptions (text, graph, etc.) must be prohibited.

To achieve this goal, each update must pass an Update Lock Test, performed
at two different levels:

1. The host level, or the Logical Lock (organizational order), may be requested
by users for any occurrence.

This lock applies to the occurrence as a whole: only the occurrence owner,
the user who locked the occurrence, can update it.

For complete information, see the User Interface Guide, chapter “Online
Access Language”, subchapter “Entity Update Lock”

2. The WorkStation level, or the Technical Lock, is automatically applied to each
description downloaded on a Pc for update.

You can do the following:

* Locally update a description:

= |If the occurrence has NOT been assigned a Logical Lock, its description is
automatically assigned a Technical Lock under the user's code and is
downloaded

This description may only be updated on the PC which it has been
downloaded to. The local file cannot be deleted by the user unless it is
unlocked.

= |f the occurrence has been assigned a Logical Lock under another user's
code or if the description already has a Technical Lock from another user,
it can be downloaded

The local file may be deleted by the user.

* Locally consult a description:

= The description can be downloaded for consultation. The local file may be
deleted by the user

* Upload the description into the Specifications Database, once work is
completed:

= |If the description owner releases the Technical Lock, other users may
consult or update it. The description in the local file is not automatically
deleted. It can be kept for consultation and deleted later

= |f the description owner does not release the lock, he/she can continue to
update it locally while other users consult the most recent host update of
the description

= |f the description owner decides to re-assign ownership to another user,
only the new owner may update the description on the same local base
on the PC

* Unlock the description without upload: the host description is not updated
and the local description is automatically erased
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You cannot locally download host descriptions that have an occurrence code
containing characters listed in chapter “Definition”, subchapter “Functionalities”,
paragraph “Occurrence Name and Code Restrictions”.

For complete details on Description Download and Upload, refer to chapter
“The Local List Window”.
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Data Integrity

The host is the primary place for storing information permanently. The PACBASE
batch procedures:

* Freeze the contents of the Specifications Database during a given session,
in order to keep the image of the session for viewing or updating purposes

* Archive the Journal File created by update transactions (ARCH procedure)

* Backup the entire Specifications Database (SAVE procedure)

Refer to the VisualAge Pacbase Operations Manual - Batch Procedures:
Administrator’s Guide and User’s Guide for complete information on these
procedures.

Data storage on the PC is temporary. We recommend uploading locally

modified descriptions onto the host so that the Specifications Database contains
current descriptions when the above mentioned procedures are run.
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Architecture - the Modules

The entry point into the WorkStation is the WorkStation Manager window. When
the WorkStation starts, the WorkStation Manager performs the host
(Specifications Database) connection and checks access to the selected
module. It then provides a graphic display of the entities managed by the
Module in use (see next chapter).

From the metamodel displayed, you can view the contents of the Specifications
Database and access the definition and various descriptions that make up an
occurrence.

The WorkStation contains two Modules geared towards data processing
professionals: Pacdesign and Pacbench, which cover the entire life cycle of
applications.

* The Pacdesign Module is the system analyst/designer's workstation. It
provides complete logistic and methodological support during the analysis
and design phases, and integrates models associated with different design
methodologies and validates them

e The Pacbench Module is the system analyst/designer's workstation. It
integrates VisualAge Pacbase functionalities, and is geared towards the
implementation and maintenance of systems

Specifications Dictionary

W orkStation Manager

PACBENCH
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A Complete Methodological Support

The WorkStation offers a complete methodological support by integrating
several design methodologies.

* With the Pacdesign Module, the systems analyst/designer has access to the
complete metamodel associated with the methodology used

* With the Pacbench Module, the programmer and maintenance programmer
have access to the VisualAge Pacbase metamodel appropriate to the
metamodel of the methodology used

These metamodels are presented as Entity-Relationship diagrams. They
include all the entities managed by each module and the relationships between
these entities (and in some cases their occurrence ranking).

Complete metamodels are too large to be represented in a single schema on
the screen. They are therefore divided into sub-schemas.

This division into sub-schemas reflects the logical process of application design
and development:

= Distinguishing between the different levels of application design:
conceptual, logical and physical

= Differentiating between data and processing

Some entities are common to all sub-schemas: Text, Document, Free Entity.
They are described in the on-line help.

DSREF000254A



Metamodels 2-3

Methodological Help

The WorkStation has methodological help.

The methodological documentation gives access to WinHelp-type files, with

hypertext links for browsing between the various help pages. Links are shown
as green underlined text.

Navigating in the methodological help:

[General index j

description description

List of sub-schemas

Sub-schema Description
List of entities of run entities
List of entities

Definition
List of fields

Description [Cross-ReferencesJ
List of fields
CFieDj Field

The main entry point to the methodological help is the sub-schema. To access
the Help window, first select the required sub-schema from the Metamodel
menu in the WorkStation Manager. Then choose ?=F1 from the WorkStation
Manager menu bar, or press F1. The corresponding help page appears.
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== PacDesign MERISE Documentation v| =

Fichier Edition 3Signet Aide

Index Iﬂechercherl Précédent I Historique I £< I > _

Conceptual Data Modeling

Back to: Merise Metamodel Deseription |2

Purpose Investigate all data manipulated by a Business System:
- establish data significance and format
- suppress ambiguities in language, such as homonyms and synonyms

- define general concepts of information (objects) pertaining to a
specific business system

Principle Entity Conceptual Data Model.

Other Entities Object.

Relationship.
Attribute.

External Entity.
Business System.

Process. El

It consists of three items:
¢ The Object item which describes the sub-schema object

e The Entity item which specifies the main entity as well as the other entities in
the sub-schema

e The Description item which describes the sub-schema links

In the top right of each help page is a hypertext link which returns you to a help
page at a higher level where possible.

N.B.: A different type of online help is available. This is Input Help which is

accessible from the Definition and Formatted Description windows. For more
information, see the corresponding chapters.
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Conventions Used with Metamodels

ENTITIES

CDM

RELATIONSHIP

2-5

Property ' Entity name

Entity with graphic description(s)

Relationship name

Project 0.1

LINKS
1,n

Recursive relationship:

the arrow shows the occurrence

ranking direction.

An occurrence ranking is the minimum
and maximum number of occurrences
which can exist for a given relationship.
Example: a project may be decomposed
into 0 to n sub-projects.

Reciprocally, a project is linked

to 0 or 1 parent projects.

Link with an occurrence ranking

This type of link is used in
sub-schemas to show the entities
that can be drawn in a graphic
description.

B can be drawn in the graphic
description of A.

NOTE: This example corresponds to the Merise methodology. For information on
other methodologies, refer to the appropriate documentation.
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WorkStation Navigation Guide

NOTE:

The metamodel facilitates navigation within the WorkStation and facilitates data
viewing in the Specifications Database.

To access a sub-schema, select an option from the Module menu, then select

an option from the Metamodel menu. Once the selected sub-schema is

displayed, open an Entity dialog box:

* Double-click on the desired entity icon

* Or click on the desired entity icon, then choose Entity... from the menu bar.
You do not need to have a sub-schema displayed in order to access the

Entity dialog box of an entity. For complete details, refer to chapter
"Navigation in the WorkStation".
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Types of Description Windows

NOTE:

There are various types of description windows. These types are not to be
confused with the specific titles given to description windows. Each entity is
made up of a combination of these description windows.

The Formatted Description window displays an ordered sequence of
formatted lines. This window is available for a number of entities (i.e. Event,
Object, Relationship). This window has specific titles depending on the entity
being described (i.e. "Attributes/Data Elements Featured" is the Formatted
description for the entity Event).

The Non-Formatted Description window provides a free-form textual
description area. This window is available for entities specific to the
WorkStation: Business System, Project, Process, Task/Rule, etc.

The Graphic Description window is used for Conceptual Data Models,
Conceptual Process Models, Organizational Charts, etc.

The Textual Description window is specific to the Text entity. This window
offers standard text processing facilities.

The Data Extraction window is used to constitute a local repository by
extracting Attributes/Data Elements required by the Local Mapping.

The Screen (local & host) Mapping and Simulation Description windows
allow you to build and simulate screen maps.

The Local Specific Code window is a local word processor window for the
different Program and Screen specific processing lines.

The Call of Segments (semi-local) window is used to describe the segments
called in occurrences of the Screen entity (Online Systems Development
Function) or occurrences of the Business Component entity (Pacbench
Client/Server).

The Call of Data Structures window is used to describe the Data Structures
called in occurrences of the Program entity (Batch Systems Development
Function).

The Business Components window (semi-local) is used to process semi-
locally the "Business Components" descriptions of the Folder and Folder
View entities of Pacbench Client/Server.

The Chart Facility Description window is used for the Free Entity. This
window is used to enter tables, charts, etc.

All examples correspond to the Merise methodology. For information
concerning other metamodels, refer to the on-line help.
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SPECIFICATIONS
DICTIONARY
HOST { }
PC
Generation-Print
window
Keyword search
window
List of Journalized ¢ ) WORKSTATION «—> Data Extraction window
Trans_window MANAGER WINDOW
Library/Session
window A
| X-Ref. window
Local Lists window
Definition window 4 ) H.OSI Qccurrence
List window
\ v /
DESCRIPTIONS
Graphic Text Non-formatted Formatted & Chart Screen Mapping Local Specific Call of Call of Data
General Doc. Facility & Simulation Code Segments Structures
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SECTION 2 NAVIGATION

Chapter 3  WorkStation Connection

The Connection Dialog BOX..............ccuuueueieuiiiiiiiiiiiiiiiiiiiiiiiiiiiiisiiiaiaiaiaiaaaaaaaaaa, 3-2
The Connection Dialog Box 3-2
Local Connection 3-4
Host Connection 3-4
Automatic Opening 3-5
Switching from a Local to a Host Connection 3-5
Interrupting a Host Connection 3-5
Library and Session List Loading (Initial Connection and
Connection to a New Database) 3-5
ConnNection SCript EXECULION ...........c..ccouvcueeeiiciiee s 3-7
DISCONNECHION ...ttt 3-7
CONEEXL ... s ssss s snnsnsnsnsnnnnnnnens 3-8
WorkStation Context 3-8
Changing the WorkStation Context 3-9
Current Context 3-9
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The Connection Dialog Box

The Connection Dialog Box

When you start up the WorkStation (for details, see the VisualAge Pacbase
WorkStation Operations Manual , chapter “Starting up the WorkStation”), the
initial screen displays the VisualAge logo. After clicking the mouse, pressing
any key, or waiting a few seconds, the Workstation Connection dialog box
opens. Enter the necessary parameters for host or local connection, as
described below.

NOTE In some cases, the Connection dialog box will not contain the
Connection part (local connection mode is not available). See the VisualAge
Pacbase WorkStation Operations Manual, chapter “WorkStation Installation”,
subchapter “PC Installation”.

= VisualAge Pachase WorkStation
User
Code | PDCFI Password | xyxuzx

" Modification New Password

{Qatabases

D1ME Base Développement Méthodes 2.0
D100 Base Test Isabelle 1l

-Library
MTAa |[MTA  Tests MERISE anglais i
Session
+
O Frozen @ CurrentfTest -
~Connection DSMS Checkpoint
Product code Ii
O/ Local
Change number Ii

(4] 4 Cancel
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User

NOTE

Databases

NOTE

Library

Session

3-3

Enter the User Code (required) and the Password (required if so defined in the
User Parameter Management). The user code, password and access rights are
validated by the host. A new user must perform a host connection when first
connecting.

A password modification forces a host connection: Host is automatically
selected. If you want to change your password, select the Modification option
and enter the New Password . A second dialog box asks you to confirm the
new password. (If you select the Modification option and do not enter a new
password, you will have a blank password. Also, if you enter a new password
without selecting the Modification option, the new password is ignored and the
current password will not be modified.)

If you are connected in Top Secret mode, you need not enter your user code
or your password. This will only work if you made this option available when
you installed the WorkStation (see the WorkStation Operations Manual,
chapter “Starting Up the WorkStation”, subchapter “The Pacbase.Dat File”).

This list indicates databases available via the WorkStation. Select a database
by clicking on the desired line.
See the VisualAge Pacbase WorkStation Operations Manual, chapter
“Connection and Disconnection Scripts”, subchapter “Cataloging a Database”
for details concerning how to load the list.
Enter the Library code (required) in one of the following ways:

* Enter the library in the edit box located to the left

* Click in the list located to the right and select a library from the displayed
list. (For information concerning how to load this list, refer under "Library
and Session List Loading".)

The Inter-Library code *** can only be used during Emulator processing. (See
chapter “The Emulator Window.)
Enter the Session number (optional) in one of the following ways:
* Enter the session in the edit box located to the left
* Click in the list located to the right and select a session from the
displayed list. (For information concerning how to load this list, refer
under "Library and Session List Loading".)
If the session is entered, select the type: Frozen or Current/Test .
If the session is not entered, the current session is selected by default.
You can carry out an implicit search of the session code by entering a session

code (complete or incomplete) in the edit box located to the left and click in the
list located to the right:
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Connection

NOTE

DSMS Checkpoint

OK / Cancel

Local Connection

Host Connection

VisualAge Pacbase WorkStation Reference Manual

in the list box to the right:
* If the code exists in the list, the corresponding label is displayed

* If the code is incomplete, the session selected is the first with a code
similar to the incomplete code entered

* |If the code does not correspond to any code in the list, an error message
will be displayed at the time of connection

Select Local or Host connection. (See the following paragraphs for details
concerning the host and local connections.)

In some cases, this part is not available (the local connection mode is not
available). See the VisualAge Pacbase WorkStation Operations Manual,
subchapter “PC Installation”.

When the database is under DSMS control, enter a Product code (3 characters
maximum) and a Change number (6 characters maximum). (See the DSMS
Reference Manual for complete information.)

Select the OK button to start the connection procedure or the Cancel button to
close the Connection dialog box.

If the connection procedure ends normally and the user parameters pass
validation, the Connection dialog box closes and the WorkStation Manager
window opens.

Local connection allows the system to operate on the local descriptions only. In
this mode, all host-related commands are disabled. A local description can be:

* Adraft, which may be updated (see chapter “The Local List Window.)

* A downloaded description: the way this description has been downloaded
determines access to it (consultation or update).

In the case of a local connection, the Library entered must exist in the local
library list. (For complete information on updating this list, see the VisualAge
Pacbase WorkStation Operations Manual, chapter “Installing the WorkStation”,
subchapter “WorkStation Directory Structure”, paragraph “Directory Structure
Modification: User Network”).

The host connection is used for online access to the Specifications Database (in
additon to local descriptions) for consulting, updating, and
downloading/uploading data sections.

Defining an occurrence and initializing its descriptions requires a host
connection, even for locally managed descriptions, so that they be locked at the
host level when downloaded.

The first connection to a new database (and a new database user) requires a
host connection.
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If a user already connected tries to connect a second time, a Host message
warns him of the dupplicate connection and requests a confirmation. If the user
confirms the second connection, then the first connection is no longer valid and
disconnects the WorkStation.

The connection procedure invokes the execution of a connection script.
Information regarding the script syntax is found in the appendix "The Script
Language" of the VisualAge Pacbase WorkStation Operations Manual.

There are two modes of execution for a connection script: test mode and
execution mode. Both are described in subchapter “Connection Script
Execution”.

Automatic Opening

You can memorize a connection context (user code, database, library, session,
connection site, DSMS control, and any module or sub-schema) when you exit
the WorkStation.

For more details, refer to chapter “The WorkStation Manager Window”,
subchapter “The Menu Bar of the WorkStation Manager Window ”, paragraph
“The Preferences Menu”.

Switching from a Local to a Host Connection

To switch from a local connection to a host connection, choose Host
Connection from the Host-Access menu in the WorkStation Manager or click
the corresponding button on the toolbar.

Interrupting a Host Connection

If the host connection is interrupted (because of host malfunction or because
the period of inactivity has been exceeded), all windows in communication with
the host close, the WorkStation automatically switches to local mode and the
Host Connection in the Host-Access menu in the WorkStation Manager is
reactivated together with the corresponding button.

Library and Session List Loading (Initial Connection and Connection to a New

Database)

The first time you connect to the WorkStation or to a new database, you must
connect to the host. A dialog box asks you if you want to load the library and
session lists locally.

= Lists to be loaded

¥ Sessions
OK I Cancel

When library and/or session lists are loaded, you can work locally on any of the
libraries and/or sessions in the lists.
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When library and/or session lists are not loaded, only the connected library
and/or session is available.

For details about how to refresh local library and session lists, refer to chapter
“The Library/Session Window”, subchapter “The Menu Bar of the
Library/Session Window"under The List Menu.
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Connection Script Execution

There are two ways to execute connection script: test mode (used to test your
connection script) and execution mode. (See the VisualAge Pacbase
WorkStation Operations Manual, chapter “Connection and Disconnection
Scripts”, subchapter “Script Modes”.)

When you select the ok button in the Connection dialog box (in execution
mode) the connection script is executed and displays:
= The message "Connection in progress..." while the script is executing
= The name of each processing step (label entered in the corresponding
OUTPUT command)

If execution ends normally, the WorkStation Manager window opens
automatically.

If a user or system error is detected, the script execution is interrupted and the
Connection dialog box is redisplayed.

If an access authorization error is found, you may modify the input in the
Connection dialog box, and script execution resumes validation of the user
access authorization.

When a bpispLAY command is found in the connection script, a 25 x 80 host

screen is displayed. Close this window (do NOT perform any other
manipulation) to resume script execution.

DSREF000254A



3-8 VisualAge Pacbase WorkStation Reference Manual

Disconnection

To exit the WorkStation, close the WorkStation Manager window via the System
menu. A confirmation message is displayed and all windows close: the
WorkStation Manager automatically performs the host disconnection.

NOTE For security and integrity reasons related to the Specifications Database,

you will not be allowed to close the WorkStation if an information exchange
with the host is in progress.
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Context

WorkStation Context
At a given moment, the WorkStation runs in a given context.

The Context... command in the System menu of the WorkStation Manager
window opens up this dialog box:

Pachench Version 2.0V01

@ © CGlHnformatique 1997

Work Station Manager

Database : D1ME

User : PDCFI
Library : MTA
Session : 1720
Product code

Change

Connection : Host
Methodology : CGl MERISE

In descending order, the information displayed represents:

—Module called (Pacbench in the example)

— Database x)
— User x)
— Library
— Session

— DSMsS Product Code

— DsSMs Change Number

— Connection Mode

— Methodology x)
Iltems marked with an (x) cannot be modified during a work session. You will
have to re-connect to modify them.

NOTE To change methodology, see the VisualAge Pacbase WorkStation

Operations Manual, chapter “Installing the WorkStation”, subchapter
“PClnstallation”, paragraph “Installing Methodologies”.
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Changing the WorkStation Context

NOTE

Current Context

To change the module, select another in the Module menu of the WorkStation
Manager window

To change the library, session, bsMs product code or bsMS change number,
select the Library-Session command from the Host-Access menu in the
WorkStation Manager window. (If you change the context via the Emulator, it
will also change the WorkStation context.)

To change the connection (from local to host) choose Host Connection from
the Host-Access menu in the WorkStation Manager window.

Refer to the previous page to see which items require re-connection before
modification.

See chapter “The Library-Session Window” for more information about
changing context.

A window inherits the current WorkStation context at the time the window is
opened. The context for an open window is not modified when the WorkStation
context is changed. This feature enables you to work simultaneously in
different contexts.

For each window, the Context... command in the System menu indicates the

context specific to this window. The Context... command in the System menu
of the WorkStation Manager window indicates the current WorkStation context.
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Chapter 4  The WorkStation Manager Window
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Getting to the Window 4-3
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The Deferred Download/Upload Requests Window 4-16
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The WorkStation Manager window is the WorkStation entry point. The
WorkStation Manager:

Allows you to select a WorkStation module (Pacdesign, Pacbench)

Displays the list of entities managed by the selected module

Is a methodological aid that displays the metamodel of a selected module in
a specific methodology. (A metamodel is a series of sub-schemas where the
entities and their relationships are graphically presented.)

Is the entry point to all WorkStation windows, ensuring access to

occurrences in the Specifications Database and local access to downloaded
occurrences. It allows you to:

= Access the Specifications Database contents through occurrence lists or
cross-references related to specified occurrences

= Expand the Specifications Database contents by updating definitions and
descriptions of occurrences

Allows you to access open WorkStation windows

Extracts Data Elements from the Specifications Database in order to
proceed to local screen mapping

Interrogates the Specifications Database for keyword search purposes and
consultation of the Journalized Transactions

Allows you to switch from local to host connection and to connect to another
context

Allows you to write JCL lines and submit Generation-Print (GPRT) jobs
Allows you to access the host Emulator
Allows you to change the Library-Session

Allows you to convert documents generated by VisualAge Pacbase in RTF
format.

Allows you to activate or cancel Deferred Upload/Download requests

Allows you to change the colors of the Entity dialog box or the revamped
host screens

Allows you to set options, colors and formats of graphs

Allows you to set options for the downloading of Texts, Non-Formatted
descriptions and Screens

Allows you to memorize the current context, module and sub-schema
Allows you to edit Documents locally

Allows you to set automatic save options
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8 visualAge Pacbase WorkStation (Pacbench)
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The WorkStation Manager window is displayed when you connect to the
WorkStation. For complete information about how to connect, refer to chapter “

WorkStation Connection”.

You access this window by choosing the Pacbench module from the Module

menu.

Module Metamodel Enfity... Search Host-Access
Windows 7=F1
AR ERERIEEEE
APP Application =
BFL Batch Flow Chart
CAT Category
CID Client{Server Interaction Diagram
cu C/S Screen o
DBD DataBase Block
DEL Data Element
DLG Dialogue
DOC Document
DFO Dialog Processor Object
DST Data Structure
DWA Folder

M=l B3
Preferences

You will be able to reactivate it later during your work by clicking on it in the

WINDOWS (or WIN-OS/2) Task List , opened via CTRL+ESC.
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The Menu Bar of the WorkStation Manager Window

Module

Metamodel

Entity...

Search

Host-Access

Preferences

Windows

System Menu

This menu contains commands that allow you to connect to a module.

This menu contains commands that allow you to access sub-schemas specific
to the selected module in the methodology installed.

This command leads you to the Entity dialog box.

This menu contains commands that:

Search keywords

List Journalized Transactions

This menu contains commands that:

Connect or reconnect the host
Access the Emulator
Access the Library-Session window

Extract data from the host Specifications Database for local screen
mapping purposes

Access the Generation-Print window

Access the Generation-Print Monitor window (with an OS/2, Windows NT
or UNIX host)

Print Documents generated by VisualAge Pacbase in RTF format

Activate or cancel Deferred Upload/Download request of local
descriptions onto or from the Specifications Database

This menu contains commands that allow you to:

Define colors, fonts and character sizes for Logical Screens
Set preferences for graphic descriptions

Set options for downloading Texts, Screens and Non-Formatted
descriptions

Memorize the context, module and sub-schema

Set options for automatic save

This menu lists the currently open WorkStation windows, thus allowing you to
display them when they are hidden or iconized.

In addition to its standard commands, this menu contains a command that
allows you to consult the WorkStation context.

For

information concerning the context, refer to chapter “WorkStation

Connection”, subchapter “Context”.
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The Module Menu

Module Pacdesign
Pacbench

This menu displays the commands that allow you to access modules (installed
modules only).

Pacdesign Adapts the contents of the Metamodel menu to the sub-schemas associated
with the Pacdesign module and displays the list of entities which can be
accessed from this module.

For a complete description of Pacdesign entities, refer to the online help.

Pacbench Adapts the contents of the Metamodel menu to the sub-schemas associated
with the Pacdesign module and displays the list of entities which can be
accessed from this module.

For a complete description of Pacbench entities, refer to the online help.
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The Metamodel Menu

Metamodel

List of Sub-Schemas

List of Entities

List of Sub-Schemas

List of Entities

This is the list of all sub-schemas of the installed methodology pertaining to the
Module you have selected from the Module menu.

A sub-schema is part of the Metamodel. The list of sub-schemas is ordered
according to the logical steps of the methodology. For a given step, a sub-
schema displays all the entities included and their relationships in the Entity
Relationship Diagram drawn according to the Methodology. (see chapter
“Metamodels”, for standards used in sub-schema displays.)

When a sub-schema is displayed, the list of entities managed by the module
automatically closes. To reopen this list, click on the "List of entities" in the
Metamodel menu.

The Entity dialog box of any entity can be accessed via a sub-schema in one of
the following ways:

= select an entity and select the Entity... command on the Menu Bar

= or select an entity and ENTER

= double click on an entity
Displays the list of available entities. With a local connection some entities
might be "grayed" because all their descriptions are local. These entities
become available with a host connection.
To open the Entity dialog box of any entity:

= Select an entity and select Entity... in the Menu Bar

= Select an entity and click Open

= Select an entity and press ENTER

= Double-click on an entity

For a complete description of the Entity dialog box, refer to chapter “Navigation
in the WorkStation”.
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The Entity... Command

Entity... After you select an entity from the list of entities or in the sub-schema, this
command opens the Entity dialog box.

For a complete description of the Entity dialog box, refer to chapter “Navigation
in the WorkStation”.
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The Search Menu

Search Keyword Search
List of Journalized Transactions

The following commands require a host connection.
Keyword Search

Allows you to search for occurrence codes by using keyword(s) as search
criteria.

These keywords can be implicit, explicit or synonymous. This window is fully
described in chapter “The Keyword Search Window”.

List of Journalized Transactions
List of Journalized Transactions

Opens the List of Journalized Transactions window and displays the last
transactions entered in the Database to which you are connected.

This window is fully described in chapter “The List of Journalized Transactions
Window”.
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The Host-Access Menu

Host-Access

Host Connection

Emulator

Library-Session

Data Extraction

Generation-Print

Host Connection
Emulator

Library-Session

Data extraction

Generation-Print
Generation-Print Monitor (OS/2, Windows NT and UNIX hosts).
Local Edition of Documents

Deferred downloads...
Deferred uploads...

Allows you to establish a host connection (this command is not available if you
already have a host connection). If the connection request fails (due to a host
communication problem or script failure), the connection mode remains local
and this command is still active.

Allows you to work in the Specifications Database in Emulation mode. (Enabled
only in Host Connection mode.)

This window is fully described in chapter “The Emulator Window”.

Opens the Library-Session window, which allows you to switch to another
Library, Session, DSMS Change number and/or DSMS Product code.

This window is fully described in chapter “The Library-Session Window”.

The following commands require a host connection

This command allows you to extract Data Elements from the Host
Specifications Database in order to proceed to Local Screen Mapping.

This window is fully described in chapter “The Data Extraction Window”.

Used to view and update Generate-Print commands as well as the startup JcL
for the GPRT procedure, then to submit the job after validation of the JcL line and
GPRT commands.

This window is fully described in chapter “The Generation-Print Window”.
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Generation-Print Monitor
This command is only available for OS/2, Windows NT and UNIX hosts. For
information concerning the Generation-Print Monitor, refer to the chapter “The
Generation-Print Window”.

Local Edition of Documents

Information about local editions are gathered under subchapter “Local Edition of
Documents”.

Deferred Download...
Deferred Upload...

These commands are active when at least one deferred download or upload
has been requested.

For details about requesting deferred download/uploads, see chapter “The
Local List Window”.

These Deferred Download/Deferred Upload commands open the Deferred

Download/Upload Requests dialog box. For a complete description of this
dialog box, refer to subchapter “Auxiliary Dialog Boxes”.
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The Preferences Menu

Preferences

Logical Screens

Graphs...

Downloads

Context memorization

NOTE.

Logical Screens...

Graphs...
Downloads > Text...

Non-Formatted Description...
Context memorization Screen...

Automatic save...

This command opens the Logical Screens dialog box in which you set the fonts,
character sizes and colors used in the Logical Screens. For a detailed
description of this dialog box, refer to the subchapter “Auxiliary Dialog Boxes”.

This command opens the Preferences dialog box in which you set the default
options regarding colors, format and parameters used in the Graphic
Description window. (However, the WorkStation supplies initial default options.)

For a detailed description of the Preferences dialog box, refer to chapter “The
Graphic Description Window”, subchapter "Auxiliary Dialog Boxes".

= Text...
Non-Formatted Description...
Screen...

These commands lead you to dialog boxes in which you specify the following
downloading options for Texts, Non-Formatted descriptions and Screens:

= Request confirmation of downloading options

= Set default conversions, formats and font

For a detailed description of this dialog box, refer to subchapter “Auxiliary
Dialog Boxes”.

Saves the current connection context for each user (database, library, session,
connection mode, DSMS control, and any module and sub-schema) when you
exit the WorkStation . At the next connection, the WorkStation automatically
opens in the context corresponding to the user code chosen in the list.

This command is not selected by default. If you do not activate it, the
WorkStation opens by default in the last context you have saved. If no context
has ever been saved, you will have to redefine your context at any new
connection.

The context which is memorized can be used for automatic opening only as

long as you keep the same version of the WorkStation and the same
methodology.
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Automatic save...

This command leads you to a dialog box in which you indicate the time desired
between saves, activate the automatic save command, and request the display
of a confirmation message before each automatic save. This command is active
for the following local descriptions:

= Texts

= Graphical Description

= Non-Formatted Description
= Chart Facility

= Screen Mapping

= Local Specific Code

NOTE: Automatic save is deactivated when you minimize your application. It is
automatically reactivated when you maximize the application.
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The Windows Menu

This menu lists all the currently open WorkStation windows (visible, hidden or
iconized). Select a command from this menu to redisplay the corresponding
window and to activate it.
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Moving Between the WorkStation Manager Window and Sub-
Windows

Use Ctrl+F6 to move in the direction indicated by the continuous-line arrows.

WorkStation Manager Window

L A A
Local List
List of
Entities
Dialog A
Box j
Information
Dialog Box
2

(Open via the Description
menu of the Local List window.)

Use Ctrl+Shift+F6 to move in the direction indicated by the dotted-line arrows.
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Auxiliary Dialog Boxes

The Logical Screens Dialog

Box

This dialog box is displayed via the Logical Screens

Preferences menu.

4-15

command in the

With this dialog box you indicate the fonts and character sizes as well as the

colors of the Logical Screens.

‘ ‘

Style field

Updatable field

Protected field

Label

Current field

Requested field background
Screen background

Error

Editbox

Listbox

Error field background

| Restore

| Standard

Colors
-Model
Updatable field 1)
Protected field _
Label
Current field
Requested field |
3
Editbox: I
Colors

To change the character font in a Logical Screen, choose a character font from
the list. One or more character sizes appear according to the font selected.
Select the required size where this is possible. An example of a 24 x 80 window
is displayed (the standard dimensions for a WorkStation window). The
appearance of the window changes according to the font selected.

As regards the Colors group, only the colors of the Definition or Formatted
Description Logical Screens can be modified.
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To display the current color of a field, select the desired item from the Field
type list. You will see the result in the Model part of the dialog box.

To change the color of an item, click Modify . A standard Windows dialog box
opens. You can then select the color you require by choosing a default color or
defining a customized color.

Restore cancels all modifications since the last OK.

Standard sets the colors to the default colors supplied at the installation.
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The Download Dialog Boxes

The following dialog box is displayed via the WorkStation Manager Window (via
the Download —Text... command in the Preferences menu). It is used to set
options for the first download of texts that have originally been described on the
host. In other words, the download parameters defined in this dialog box are not
taken into account in the case of already downloaded or locally created text.

‘=-‘ Download of Texts

I iConfirm options during downloads

-Default conversions

Convert the lines of type '+, *_", '="to lines:
@ of title type (3 C of PACBASE type (+._.=)
Convert the lines of type 'L’ to lines:
@ of title type (K) C of PACBASE type (L)
Take by default the edit mode:
® Word Wrap (§) O No Word Wrap ($5)
-Default formats -Default font
Left margin: |5_ Courier b
Right margin: W ﬁﬂﬂLrn ?0
Indentation: Iﬁ_ Fslg'TpE}(n }g
oK ‘ Cancel

Confirm options during downloads

When this option is enabled, a confirmation box opens up each time you are
downloading a text without layout option on the host.

Default conversions

When text occurrences originally described in the Specifications Database
are downloaded onto the PC for the first time, certain adjustments need to
be made (if the text does not contain alignment commands or if there are
lines of type '+, '="or '_").

The WorkStation manages only lines of type -' and lines of type VisualAge
Pacbase. You must convert lines of type '+, '="and '_' into one of these line

types.

You must also determine the default edit mode: Word Wrap or No Word
Wrap. The selected edit mode is applied when you download a text with no
layout option on the host for the first time.

= Word Wrap mode formats the text according to a defined or default
format, with automatic carriage return.

= In No Word Wrap mode there is no automatic carriage return.
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For more details on these two modes, refer to chapter “The Textual
Description Window”, subchapter “The Menu Bar of the Section Window”,
section “The Paragraph Menu”.

Default formats
Define the default formats for the next texts you will download.

For more information on the different text formats, refer to chapter “The
Textual Description Window”, subchapter “Upload/Download and Data
Element Cross-Reference”, section “Download”.

NOTE

If no format is defined, the default formats will be applied when you
download texts with no layout option on the host for the first time. The
formats defined in this dialog box can be modified in the Style dialog box
(Table of Sections window) for all the sections of a text, or in the Define
Formats dialog box (Section window) for the current section. For more
details on these two dialog boxes, refer to chapter “The Textual Description
Window”, subchapter “Auxiliary Dialog Boxes”.

Default font
Select the font that will be used for the next texts you will download.

NOTE

If no font is selected, the font set by default will be used for any text
downloaded for the first time. The selected font can be modified in the Style
dialog box (Table of Sections window) for all the sections of a text, or in the
Screen Fonts dialog box (Section window) for the current section. For more
details on these two dialog boxes, refer to chapter “The Textual Description
Window”, subchapter “Auxiliary Dialog Boxes”.

The following dialog box is displayed via the WorkStation Manager Window (via
the Download —Non-Formatted Description... command in the Preferences
menu). It is used to set options concerning the first download of Non-Formatted
Descriptions:

‘=-‘ Download of Non Formatted Descriptions

I” ‘Confirm options during downloads:

‘Default conversion
Take by default the edit mode:
® Word Wrap ($) O No Word Wrap ($$)
‘Default formats Default font
Left margin |5_ Courier b
Arial 8
Right margin W Modern 10
Roman 12
Indentation |5_ Script 13
0K Cancel
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Confirm options during downloads

When this option is enabled, a confirmation box opens up each time you are
downloading a description without layout option on the host.

Default conversions

Determine the default edit mode: Word Wrap or No Word Wrap. The
selected edit mode is applied when you download a description with no
layout option on the host for the first time.

= Word Wrap mode formats the description according to the selected or
default format, with automatic carriage return.

= In No Word Wrap mode there is no automatic carriage return.

For more details on these two modes, refer to chapter “The Textual
Description Window”, subchapter “The Menu Bar of the Section Window”,
section “The Paragraph Menu”.

Default formats
Define the default formats for the next descriptions you will download.

NOTE

If no format is defined, the default formats will be applied when you
download descriptions with no layout option on the host for the first time. The
formats defined in this dialog box can be modified in the Style dialog box
(Non-Formatted Description window, Options menu, Preferences
submenu) or in the Define Formats dialog box (Non-Formatted Description
window, Options menu). For more details on these two dialog boxes, refer
to chapter “The Textual Description Window”, subchapter “Auxiliary Dialog
Boxes”.

Default font

Select the font that will be used for the next non-formatted descriptions you
will download.

NOTE

If no font is selected, the font set by default will be used for any non-
formatted description downloaded for the first time. The selected font can be
modified in the Style dialog box, or in the Screen Fonts dialog box
(Characters menu). For more details on these two dialog boxes, refer to
chapter “The Textual Description Window”, subchapter “Auxiliary Dialog
Boxes”.
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The following dialog box is displayed via the WorkStation Manager Window (via
the Download —Screens... command of the Preferences menu). It is used to
set options concerning the downloading of Screens:
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The Deferred Download/Upload Requests Window

The following window

is displayed when you select

4-21

the Deferred

Download/Upload command from the Host-Access menu in the WorkStation
Manager window.

= List of Deferred Download Requests
Send!
N* Lib Sess. Ent Code Description
01 MTA 1536 TXT TEXTDS Contents [Local Word-Processor)
02 MTA 1536 TXT TEXTGE Contents [Local Word-Processor)
The following information is displayed in this window:
= Download/Upload order number
= Library code
= Session (& status) of its last update
= Entity local code
=  Occurrence code and description label
The menu bar of the window includes:
Send! This command starts the immediate Download/Upload of all listed occurrence
descriptions and closes the window.
Delete This command deletes the selected request from the list.

If you decide to exit from the WorkStation prior to sending Deferred
Download/Uploads, a message will ask you if you want to abandon the deferred
download/uploads. If you answer yes, the requests will be deleted. If you
answer no, the WorkStation will not close. You must send the requests or delete
them in order to exit.
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Local Edition of Documents

Introduction

You can convert Documents generated by VisualAge Pacbase into an RTF
format adapted to a word processing (standard description format), and
print/view them using any word processor capable of reading documents in RTF
format.

You can edit some elements of the folder of entity occurrences stored in the
VisualAge Pacbase repository using the functionalities of a PC word processor.

Functionalities

Editing Documents locally allows you to:

Include graphs automatically

&

Graphs are automatically printed according to the print options set by the
user in the print layout (see chapter “The Graphic Description Window”,
subchapter “The Menu bar of the Graphic Description Window”, section
“Print Layout” of the File Menu. This print layout is memorized in the graph.

However, if the user chooses not to specify print options (the page layout set
to 0), ILRTF considers the ‘useful’ dimension of the graph (height and width)
to set the page orientation. Headers and footers are taken into account. The
graph is printed on one page only.

If the installed methodology (indicated in the WorkStation configuration file)
is not compatible with the methodology in use to generate graphs, these
graphs will not be generated in the RTF format. A dialog box proposes you
either to continue or to quit the application.

Respect the fonts and styles positioned via the WorkStation word processor
The layout dedicated to the character fonts is not taken into account.

Manage lists and charts generated by VisualAge Pacbase in RTF-format
cellular tables

Manage the Table of Contents and Index automatically

Customize the style sheet in use.
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How to proceed

You must first generate the Document to be processed, with the C2 option (see
chapter “The Generation- Print Window").

When generation is complete, a file created on the host and named PAC7G6 by
the GPRT procedure (the external name depends on the coding used on your
site) contains the elements required to create the RTF file. For more details on
the GPRT procedure, refer to the VisualAge Pacbase Operations Manual:
User's Guide. Transfer this file onto your PC.
= This file must meet two criteria:

- It must contain ASCIl-coded characters.

- The carriage returns must be CR/LF.

You can then submit the local edition request from the WorkStation General
Manager Tool bar by selecting ‘Local Edition of Documents’ in the Host-Access
menu.

You can now convert your PDM file into an RTF format.
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CONVERSION OF A PDM FILE INTO AN RTF FORMAT:

| d:\user\SPACV2IOFAFSTYLSHY . RTF |

|
s \GDPARTF |
®
A user\SPACA210F\PACBASE DAT | o
® ® ° ® . o

A/ Files used:

In the " PDM Source" field, specify the local name of the transferred PDM
file.

In the "Stylesheet" field, specify the file of the style sheet from which the RTF
output file will be created. A standard style sheet (ASTYLSHY.RTF) is
provided.

The preset styles of the standard sheet (sizes and character fonts) will be
applied to the Document. However you can modify styles and create your
own customized style sheet. It will be taken into account in the next
generation.

The use of the style sheet varies according to the word processor in use.

For users of Microsoft Word: the style sheet can be used with release 6 and
higher only.

In the "Target" field, specify the name of the RTF output file.

In the "WorkStation Configuration File" specify the full WorkStation
configuration file path (default name PACBASE.DAT). This file contains the
name of the methodology used by the WorkStation which is required for
generating graphs. If the Document to be generated does not contain any
graphs, this information is irrelevant but the file must still exist in
PACBASE.DATformat.

When the "Convert PDM file into RTF format" window is opened for the first
time, only the "Style Sheet" and "WorkStation Configuration File" files are
indicated. Subsequently the last files used will be displayed, with the other
files remaining on the drop-down list.
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B/ Generates contents only:

This option enables you to generate the body of the Document without section
skip.

Headers and footers are not managed automatically. You can then manage
them in a customized way, according to your needs.

C/ Titles style:

e Standard

The Document titles from the Document description lines (type Tn) and the titles

generated if this option is selected are printed in the body of the Document in

the "titre" style.

<= |f the word processor you use is not in French, you must change a line in the
parameters file. See the WorkStation Operations Manual, chapter

“WorkStation Utilities”, subchapter “ILRTF Local Editing Application”.

You can automatically generate the Table of Contents from the Document
description lines under your word processor.

Face pages, headers and footers, frames, title numbers do not keep their PDM
formatting characteristics.

You can re-define these elements directly under your word processor as you
wish.

e PDM

This generation mode reproduces PDM and WorkStation mapping
characteristics (fonts and attributes). You can obtain an exact image of the
generated Document under your word processor without specifying anything.
The map dedicated to fonts is not taken into account.

NB: the "Title" styles are special: "Titlengdp”

The following table associates the styles from the ASTYLSY.RTF stylesheet
with the styles as they are defined in PDM.
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RTF Styles

PDM Styles

content footer

Style used in the footers of the body of the
generated Document

content header

Style used in the headers of the body of the
generated Document

definition screen

Unused

fixed font list

Style applied to one-column Lists and Descriptions

fixed font list title

Style applied to the titles of one-column Lists and
Descriptions

graph

Style applied to Graphs and to their labels.

heading page title

Style applied to the titles displayed in face pages

index

Unused

index entry

Unused

index footer

Style used in index footers

index header

Style used in index headers

list Style applied to multi-columns Lists (without frame
between columns)

list title Style applied to the titles of multi-columns Lists
(without frame between columns)

map Style applied to Maps

nice sheet footer

Style used in face page footers

Nice sheet header

Style used in face page headers

normal indent Unused
screen Unused
style-Arial Character-font style applied to text in Arial font

style-Courier

Character-font style applied to text in Courier font
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RTF Styles PDM Styles

style-Modern Character-font style applied to text in Modern font

style-Roman Character-font style applied to text in Roman font

style-Script Character-font style applied to text in Script font

style-System Character-font style applied to text in system font

style-Times Character-font style applied to text in Times font

table Style applied to multi-columns Descriptions

table title Style applied to the titles of multi-columns
Descriptions

titte 1 GDP Style applied to level 1 titles in the body of the
Document generated with the PDM title option

title 2 GDP Style applied to level 2 titles in the body of the
Document generated with the PDM title option

title 3 GDP Style applied to level 3 titles in the body of the
Document generated with the PDM title option

title 4 GDP Style applied to level 4 titles in the body of the
Document generated with the PDM title option

titte 5 GDP Style applied to level 5 titles in the body of the
Document generated with the PDM title option

title 6 GDP Style applied to level 6 titles in the body of the
Document generated with the PDM title option

title 7 GDP Style applied to level 7 titles in the body of the
Document generated with the PDM title option

titte 8 GDP Style applied to level 8 titles in the body of the
Document generated with the PDM title option

titte 9 GDP Style applied to level 9 titles in the body of the
Document generated with the PDM title option

tm footer Style used in the table of contents footers

tm header Style used in the table of contents headers

tml ... tm9 Unused

wide map Style applied to Maps whose width is more 82 char.

D/ Generated for...

The radio-buttons are used to indicate the target word processing for the
generation, taking into account the specificities of the differents environments.
The radio-buttons mainly allow a correct display of the graphics.

< All the information indicated in the "Conversion of a PDM File into RTF
Format" window is contained in the ILRTF.PRO file. For a description of this
file, refer to the WorkStation Operations Manual.
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Once you have entered all the information required in this window, click
"Generate".

The following window appears. It shows the progress of the operation.

100%

A window showing the Document report then opens.

REPORT:

{m CATMPMTARGET.RTF

Statistics

The result file contains :

455445
13131
i

3 Texts b Lists
Graphs 0 % Descriptions
Maps

-Result display

Word processor used :

FAMSOFFICEAWINWORD.EXE i

Display
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The elements taken into account are grouped in the following five categories:

the Texts represent the
- Text descriptions,
- Description 8 of User Entity Occurrences.

the Graphs represent the:
- Graphical descriptions of User Entity Occurrences,
- Graphical descriptions of WorkStation specific entities.

the Maps represent the:

- Report maps,

- Screen maps,

- Description of User Entity Occurrences (except description 8 and
graphical descriptions).

the Lists represent the:
- Lists of entity occurrences,
- PDM+ lists (H- and G-type lines).

the Descriptions represent the:

- Segment Call of Elements,

- User Entity Call of Elements,

- Methodology Entity Call of Elements (Object, Relationship),
- Screen Call of Elements,

- Report Call of Elements,

- Data Element descriptions.

Descriptions are displayed in the form of tables.

The "Statistics" field indicates the contents of the Document, i.e. the number of
the various elements it contains.

In the "Associated word processor” edit box, specify the location of the word
processor you will use to display and print the result of the generated RTF file.

The icon for the word processor application then appears in the "Display"
button.

Click on "Display" to start the word processor to display and modify the RTF file
as you wish.
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Getting to the Windows

The WorkStation windows open as follows:

Connect to the WorkStation. This opens the WorkStation Manager
window
For details about connecting, refer to chapter “WorkStation
Connection”.

In the WorkStation Manager window, select a module from the Module

menu. Select a sub-schema or List of Entities from the Metamodel menu
For details about modules, refer to chapter “Introduction”, subchapter
“Architecture - the Modules”

In the WorkStation Manager window, double click on an entity in a sub-
schema or in the List of Entities to open the Entity dialog box
For details about different ways to access the Entity dialog box, refer
to subchapter “The Entity Dialog Box”.

Now choose a description. This will open a new WorkStation window
For details about the descriptions listed in the Entity dialog box, refer
to subchapter “The Entity Dialog Box”

The various WorkStation windows are adapted to the selected description. All
the different types of description windows are described in this manual. Not
every module necessarily accesses all of them.

The following schema illustrates navigation when you first enter the
WorkStation:

The WorkStation Manager Window

VAN

The Sub-Schema
The List of ‘
Entities
Dialog Box
The Entity
Dialog Box
Window A
Window B V
Window C
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Multi-Windowing

The multi-windowing feature of the WorkStation allows you to:
* Open several windows at the same time

* Manage open windows via different menus: in the WorkStation Manager
window via the Windows menu and in other WorkStation windows via the
Cascaded and Pop-Up Entity menus.

* Re-activate each of these windows from any open window

The WorkStation Manager Window

The Windows
Menu

The Cascaded

or Pop-Up Menu
Window A

The Pop-Up

Menu

Window B
Window C (

—> Re-activates

To re-activate means to redisplay a currently open WorkStation window (visible,
hidden or minimized).

Re-activate WorkStation windows (even if they have been hidden or iconized)
via the:

* Windows menu in the WorkStation Manager window

* Checked commands in the Cascaded and pop-up menus
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Hyper-Navigation

Use the hyper-navigation feature of the WorkStation to open any window using
the relationships between the information they display.

The main entity is the entity you are working on. The related entity is an entity
used in the description of the main entity. For example, in the Data Element
Calls description of a Segment, the Segment is the main entity and the Data
Element is the related entity.

Main Entity
Window A Window A
The Cascaded Menu Pop-Up Menu of
Main Entity » the main entity

Window B

—> Follow this arrow to any window
concerning the same occurrence
of the main entity.

Pop-Up Menu of
the related entity

— > Follow this arrow to any window
concerning the occurrence of the
related entity.

\
|
\
|
\
Y
Window C

To display a Pop-Up menu, place the cursor in the field that contains an
occurrence of the main or the related entity and click the right mouse button.

Open a window via the unchecked commands in the Cascaded menu and in the
pOp-up menu.

Window A
The Cascaded Menu
Main Entity »
Other Occurrence... 9
J
The Entity
—>  Follow this arrow to another Dialog Box
occurrence of the main
entity. ¢
Window B
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Related Entity

Window A
The Cascaded Menu

Related Entity...

First, place the cursor in the field that
contains the related occurrence.

Then select the Related Entity...
command.

———> Follow this arrow to any
occurrence concerning
the related entity.

v

The Entity
Dialog Box

v

Window B
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The Entity Dialog Box

You can access the Entity dialog box of an entity via the WorkStation Manager
window. This is done via:

= The list of entities, in one of the following ways:

Double-click on an entity in the List of Entities (the scroll bars can be
used to move in the list)

Select an entity from the List of Entities and Entity... on the menu bar
Select an entity from the List of Entities and click the Open button
Select an entity from the List of Entities and click ENTER.

= A sub-schema in one of the following ways:

Double-click on an entity

Select an entity and the Entity... command on the menu bar
Select an entity and ENTER

You can also access the Entity dialog box from other WorkStation windows
(definition, description, X-reference) by using the Entity menu.

The Entity dialog box allows you to navigate within the WorkStation and access
its windows:

= Host Occurrence Lists (host connection only)

= Local Description Lists

= Occurrence Definition (host connection only)

= Occurrence Descriptions (local descriptions only if local connection)

= X-References (host connection only)

The Entity dialog box displays different list boxes, depending upon whether or
not you are connected to the host.
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Local Connection

5-7

Graphic Descriptions
Chart Facilities

Non-Formatted Description
Graphic Description
Chart Facili

Only local lists and descriptions are displayed. You cannot access the host
Definition window, nor the host lists or cross-references. On the other hand, you
can work on previously downloaded host occurrences, or create drafts via the
Local List window.

Host Connection

Graphic Descriptions
Chart Facilities
By code ! Host

General Documentation
Non-Formatted Description
Graphic Description

Chart Facility

Assigned Texts
X-References in Documents
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With a local connection, this list box contains only lists of local descriptions.
With a host connection, this list box contains host occurrence lists and local
description lists. Drafts are local descriptions, so they appear in local lists
together with downloaded host occurrence descriptions.

There are several ways to access these lists:

= Select a list and click on ok, From... (if it is active) or ENTER

= Double click on a list

Local Occurrence/Occurrence

Code

There are several ways to enter a code in this field:
= Simply type the code in the edit box

= Click the arrow located to the right of the Code field to display the list of
codes which have already been used and click on one of these codes to
enter it in the Code field

A maximum of twenty codes are memorized by the WorkStation (twenty is
the total number of codes for all of the entities combined). These codes are
specific to a user and are saved when you exit the WorkStation.

The following commands are exclusive:

Host Definition

This button, available only when connected to the host, allows you to access
the definition of the occurrence specified in the Code field.
This button opens the Definition window and closes the Entity Dialog Box.

Descriptions

This list box displays all the descriptions available for the entity in the
selected Module.

Once a code has been entered in the Code field, there are several ways to
access a description:

= Select the description and ok, From... (if it is active) or ENTER

= Double click on the description

When a user connected to the host calls a local description which has not

yet been downloaded onto the PC, a dialog box opens and offers to
download that description for update or consultation.

Downloading for update locks the description on the host. If the required
description is already locked, downloading can only be done for consultation,
since another user is currently working on it.

If a disconnection occurs during downloading, the user cannot access the

local description which is incomplete. However, downloading can be
resumed. For complete details, refer to chapter “The Local List Window”.
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NOTE.

X-References

From...

OK / Cancel

For security reasons, you cannot download:

= A description of an occurrence defined in a library which is hierarchically
higher than your connection library

= A description of an occurrence for which a logical lock has been
positioned in a library of your connection network

This list box displays all the X-references available for the entity (available only
with a host connection).

Enter a code in the Code field. There are several ways to access a X-
reference:
= Select the X-reference and ok, From... (if it is active) or ENTER
= Double click on the X-reference
This button is available according to which list related item is selected from the

Entity dialog box. For a complete description of the From... dialog box, refer to
subchapter “Auxiliary Dialog Boxes”.

Select oK to open the requested window and close the Entity Dialog Box. Select
Cancel (or ESC) to close the Entity dialog box and ignore any selection entered.

NOTE:  When both the ok and From... buttons are active, press From... to
display the From... dialog box and ok button to bypass the From... dialog box.

When the From... button is unavailable, the From... dialog box is bypassed.

When the OK command button is unavailable, the From... dialog box is
required.

The default button (i.e. the button which is automatically activated when you
press Enter) has a thick black surrounding line.
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The Cascade Entity Menu

The menu bar of most WorkStation windows contain the Entity menu:

=-| Segment DD01: Call of Elements ‘ v| -
Entity Update+Display Special choices ¥Yiew... Options Repositioning 2=F1
Main Entity ¥ [ [i=
Related Entity... | g) eMENTS [DDO1 KEY
A LIN : ELEM. INT.FORM. U OCC GR K CMD456 CONT UALUE/SFC UPD/TRGET DOC LIBR
[ [o2e : |aLEADH [ [ W] 1539
[ [o40 : [aRROW [ [ W] 1539
| |ese : [pAEME [ [ ] 1539
| Jose : [cDaoe1 [ [ W1 1539
| 100 : [FBeoe1 [ [ W1 1539
| IENl
_ IEnl
1H NI
The Main Entity submenu is Cascaded as it contains a set of related
commands. To display these commands, select the Main Entity submenu.
=-| Segment DDO1: Call of Elements ‘ vl -
Entity Updatet+Display Special choices Yiew.. Options Repositioning 2=F1
Main Entity ) [ [s= =]
Related Entity... |'g) eMENTS [DDO1|KEY
A LIN : ELEM. INT.FORM. U OCC GR K CMD456 CONT UALUE/SFC UPD/TRGET DOC LIBR
| o2 : |aLEADH [ [ ] 1539
| Jouo : JarroOW [ [ W1 1539
| Joso : |pREME [ [ W1 1539
[ [ese : [cDAeeN [ [ W1 1539
[ [1ee : |FBoGET [ [ W] 1539
1 I1H N}
1 I1HNE]
[ 1H NI

Lists, Descriptions and X-references are also Cascaded because they contain
related commands.
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=-| Segment DD01: Call of Elements ‘ v| -
Entity Update+Display Special choices ¥Yiew... Options Repositioning 2=F1
Main Entity Definition

Related Entity...| Lists M

Descriptions 4

A LIN : ELEM, | ~Heferences ’R K CMD456 CONT UALUE/SFC UPD/TRGET DOC LIBR
| [p20 : [aLEADH| Other Occurrence... [ [ 1539
[ [o40 : [aRROW i [ W] 1539
[ |eso) : |pAEMB 1 [ W] 1539
| [pso : [cDaeo1 [ [ W] 1539
F 100 : [FBEOOT F FIE 1539
i IHNEI
1 1INl

The Related entity... submenu is active if you place the cursor in a field
containing an occurrence of the related entity. This command leads you to the
Entity dialog box of the related entity.

EXAMPLE: In the Data Element Calls description of a Segment, the Segment is
the Main Entity and the Data Element is the Related Entity. Place the cursor
in the desired Data Element occurrence field and select Related Entity ... to
display the Entity dialog box of the Data Element occurrence.

Entity Menu with a Host Connection:

Entity

NOT

Main Entity

E

Related Entity...

NOT

E

Main Entity =>» Definition...
Lists => Available lists
Descriptions =>» Available descriptions
X-References => Available x-references

Other Occurrence...
Related Entity...

With a local connection, only Lists and Descriptions are available.

This menu leads you to the definition, lists, descriptions, and X-references of
the currently accessed occurrence, according to the selected module and
connection mode.

If any of these windows is already open, a check mark will appear by the
corresponding command. Click a checked command to re-activate the
corresponding window (which is hidden or iconized). Click an unchecked
command to open the corresponding window.

To access the Entity dialog box of the occurrence you are working with, select
Other Occurrence... in the Main Entity Cascaded submenu of the Entity
menu.

This command leads you to the Entity dialog box of an entity related to the
occurrence currently being accessed. Place the cursor in a field containing an
occurrence of the related entity and select it.

The Related entity... command is not active in the Formatted Description of

a Volume if the cursor is positioned in the "Title, Option, Font, Comments or
Selection” field as it may contain occurrences of very different entities.
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The Pop-Up Entity Menu
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If you click with the right mouse button in a field which displays an occurrence of
a main or of a related entity, a pop-up menu will appear. This menu leads you to
the definition, lists, descriptions, and X-references of the occurrence of the main
or related entity. In the example below, we clicked on a related entity
occurrence, which is here the Main Entity, the Segment code.

=-| Segment DD01: Call of Elements ‘ v| -
Entity Update+Display Special choices ¥Yiew... Options Repositioning 2=F1
Main Entity Definition |H! |
Related Entity...| Lists M
Descriptions General Documentation
a LIN : ELEM. X-Beferences Sub.—schen?as and Sub-systems TRGET DOC LIER
" [o20 : [ALEADH| Other Occurrence...|, -0dic@! Child Segments 1539
= ¥ Call of Elements
O 0 r General Documentation on Elements 1=
|_ 060 : [DAEMB |_ Level - Address - Length 1539
| fese : [coaoe! 1 Data Element Details 1539
[ [1ee : [FBoG01 [ Statistics 1539
|_ |_ 5@QL View Description
[ [ Socrate Description
[ [ Distributed Activities
NOTE When hyper-navigation is triggered from a field which does not contain an
occurrence code, the description and X-reference submenus are de-
activated.
In the following example, we clicked on an occurrence of the related entity, in
this case a Data Element appearing in the CORUB column.
=-| Segment DR01: Call of Elements ‘ vl -
Entity Update+Display 3Special choices Yiew.. Options Repositioning 2=F1

Main Entity
Belated Entity...

Definition
Lists
Descriptions
X-References

M

LI

General Documentation
Sub-schemas and Sub-systems

A LIN : ELEM.
| [p20 : [ALEADH| Other Occurrence...
| [ouo : [arROW [
| [os0 : |paEMBE [
[ Jose : [cDaoe1 [
[ J1ee : [FBooE1 [

I -

Logical Child Segments
¥ Call of Elements
General Documentation on Elements
Level - Address - Length
Data Element Details
Statistics
S5@L View Description
Socrate Description

Distributed Activities

TRGET DOC LIBR

1539
1539
1539
1539
1539

This pop-up menu is also a Cascaded menu. For more details on Cascaded

menus, refer to the subchapter “The Cascaded Entity Menu”.
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Auxiliary Dialog Box

The From... Dialog Box

NOTE.:

The From... dialog box appears via the Entity dialog box or via the Entity
Cascaded menu (only when the From... dialog box is required).

In the From... dialog box, you can enter a display start key (required in certain
cases) for a list or X-reference. This key is used to enter the occurrence code,
name, line number, etc. to determine the start of the display.

The content of the From... dialog box is variable. Two examples are given
below.

Request of an occurrence list by code:

= From...

Occurrence code ||

OK | Cancel

Request of X-references for a Data Element, e.g. "Used in Screens™:

= From...

Occurrence code
" Working
Section
Line
" Procedure
Function
Sub-function

Line

0OK Cancel

The hierarchical organization must be followed when entering information in this
box. For example, input in the Section field requires that the hierarchically

higher fields also be entered (i.e. the Working check box and the Occurrence
code field).
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OK
Click to save changes made in the From... dialog box.
Cancel

Click to close the From... dialog box without saving changes.
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SECTION 3 DESCRIPTION OF THE WORKSTATION

Chapter 6

WINDOWS

The Host Occurrence List Window

FUNCHIONANHES .......cceveeeeieeeeeee et

Getting to the Window

The Host Occurrence List Window Menu Bar .........................

The Entity Menu

The Display Menu
The Match! command
The View... Command
The Screen Menu

The System Menu

Auxiliary Dialog BOXES............ccoceivieeeiisiiiiiisiiie e

The View Dialog Box

6-3

......................... 6-4

6-5
6-6
6-6

6-6

......................... 6-7

6-7
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Functionalities

NOTE:
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Use the Host Occurrence List window to:

Consult the Specifications Database contents formatted in occurrence lists in
real time

Select occurrences to access (view or edit) their descriptions or their cross-
references

Select occurrences to associate them with objects (icons or occurrence-
bearing links) of a Graphic Description during matching operations

You can select an entity occurrence code from a host list in order to place it in a
Definition window, a Formatted Description or a Graphic Description using drag-
and-drop.

In Definition windows or Formatted Descriptions, only occurrence codes can be
loaded, while in Graphic Descriptions the code and the name are
simultaneously transmitted to icons and occurrence-bearing links.

Simultaneously open the host list and the Definition window or the Formatted
Description or Graphic Description of an entity

Select the occurrence code (or the name in the case of a Graphic
Description) from the host list by clicking the left mouse button, then move
the mouse to the required window, keeping the button pressed

Release the mouse button on a field which will accept an occurrence code of
the same entity for Definitions and Formatted Descriptions or on the icon or
link to be entered for Graphic Descriptions: the code (and the name in a
Graphic Description) appear simultaneously in the field or on the icon/link.

For more details on lists and descriptions in the Entity dialog box, see the
chapter “Navigation in the WorkStation”, subchapter “The Entity Dialog Box".

When the local list is open, the entity list is de-activated. If you open a
Definition window or a Description from a local list, you must access the host
list via the Entity menu for the local list.
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Getting to the Window
A host connection is required.

Select one of the Host Occurrence List options in the List section of the Entity
dialog box.

For details on the Entity dialog box, see the chapter “Navigation in the
WorkStation”, subchapter “The Entity Dialog Box”.

For the occurrence list of the following entities:

Entity Type
+Screen ___(blank)
+C/S Screen C

+Business Component S
FM: Communications monitor folder mode
MV: Communications monitor simple mode
E : Error host
Other types exist, consult your documentation.
+Folder F
+Folder View FvV

Select the command Lists by type, when it is available, by entering the
appropriate type in the From... box.
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The Host Occurrence List Window Menu Bar

Entity

Display

Match!

View...

Screen

System Menu

This Cascaded menu contains commands which allow you to access the
definition, lists, descriptions and X-references of the occurrence selected from
the list.

This menu contains several commands which allow you to choose the point
from which the list is displayed.

This command is active only when the Host Occurrence List has been
requested from a Graphic Description window for matching purposes.

This command leads you to the View dialog box. From this dialog box you can
select a Library sub-network and the list display type.

This menu allows you to copy and print the current window.

In addition to standard commands, the system menu allows you to consult the
context of the current window.

Function Keys and Mouse Control

For the use of function keys and mouse in this screen, see the Appendix at the
end of this manual.
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The Entity Menu

Entity

NOTE

After you select an occurrence (i.e. click on a line in the list), this Cascaded
menu contains commands to access the definition, lists, descriptions and cross-
references of the selected occurrence or of another occurrence of this entity.

You may also right-click on an occurrence code and the pop-up Entity menu
appears on the list. (Also, a double click on an occurrence code will open its
entity dialog box.)

For more details on this menu, see the chapter “Navigation in the WorkStation”.
In local mode you cannot download host occurrences which have a code

containing the special characters listed in the chapter “Definition”, subchapter
“Functionalities”.
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The Display Menu

Display

Next page
NOTE

Same page

Start

From...

Repositioning

NOTE

VisualAge Pacbase WorkStation Reference Manual

Next page
Same page

Start
From...
Repositioning > Type of memaorization

Displays the next page in the host list.
Pressing ENTER has the same effect.

Redisplays the same page. This command is used to display the latest
modifications made to the host list. For example, use this command to display
new occurrences which may have been defined after the window was opened.

Displays the list from the start.

Opens the From... dialog box in which you enter the position from which to
display the list.

Each position indicated in this dialog box will be memorized. These positions
can be requested again via the Repositioning choice.

For a complete description of the From... dialog box, see the chapter
“Navigation in the WorkStation”, subchapter “Auxiliary Dialog Boxes”.

= Type of memorization

Opens the Position Memorization dialog box. In this box, select the type of
memorization you want:

Explicit Memorization
This type of memaorization memorizes each display position specified via the
From command of the Display menu as a sub-choice of the Repositioning
choice.

Implicit Memorization
This type of memorization memorizes each current position you obtained
through a simple transmit as a sub-choice of the Repositioning choice.

You can select both types of memorization in the Position Memorization
dialog box. The Repositioning choice can store up to 20 positions while the
window remains open.

The Match! command

Match!

This command is available when the Host Occurrence List is requested from a
Graphic Description window. It is used to match an occurrence selected in the
list with an icon or occurrence-bearing link previously selected on the graphic
description.  (For complete instructions, refer to chapter “The Graphic
Description Window”.)

During a matching operation, the Match! command may be used several times

without closing the window. To perform another match, select another object in
the graphic description, select another occurrence in the list and select Match!
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The View... Command
View... Opens the View dialog box.

For full details, see the subchapter “Auxiliary Dialog Boxes”.

The Screen Menu

Screen Menu Copy Host Screen
Print Host Screen...

Copy Host Screen
Copies the current Host Screen in the SPAC\BASE\SPAC.PRT. When you
select this command, a dialog box offers you either to reinitialize the file, or to
add the screen at the end of the existing file.

Print Host Screen...

Prints the current Host Screen.

The System Menu

System Menu  Context...
Context... Displays the current context.

For more information about the context, refer to the subchapter “Context”,
chapter “WorkStation Connection”.
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Auxiliary Dialog Boxes

The View Dialog Box

NOTE

NOTE

This dialog box allows you to select a part of the Specifications Database sub-
network (i.e. the view from which the host occurrence list will be drawn or the
scope of the search by keyword) via the "icon" buttons. This dialog box also
allows you to select a display option via radio buttons.

You can not open more than one View dialog box. The corresponding View
menu is therefore disabled if a View dialog box is open.

=] View

AR
A A

A4l

Screen

(E =]

oK ‘ Cancel

Network

Meaning of the icons (from top left to bottom right):

OPTION CORRESPONDS TO --> HOST OPERATION CODE
(FIRST CHARACTER)

greater levels

greater & equal levels (default)

greater & equal levels with duplicates

selected library only

whole hierarchical branch I
lower levels

lower & equal levels

crov

N A

When this dialog box opens, the current view of the selected sub-network is
indicated by the selected button. To change the network view, select
another button.
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NOTE

Screen

The buttons numbered from 1 to 4 correspond to the host operation code and to
4 different presentations of the same screen.

The significance of the view type depends on the list. Refer to the User
Interface Guide, chapter “Online Access Language”, subchapter “The
Operation Field (O:)”. Inactive options are disabled.

OK

Click this button to save changes made in the dialog box.

Cancel

Click this button to return to the Host Occurrence List window without saving
changes made in the dialog box.
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Chapter 7  The Local List Window

FUNCHIONANHES. ...

Getting to the Window
The Menu Bar of the Local List Window.
The Entity... Command
The Description Menu
The Host-Access Menu

7-1

7-2

..................................... 7-4

7-5
7-8
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Functionalities

This window presents the list of descriptions downloaded on your workstation
for a specific kind of entity.

There can be several local lists for a given entity, each one for a specific kind of
description (e.g. Graphic Description, Non-Formatted Description). These lists
are sorted by occurrence code.

Local descriptions are classified into categories for each description displayed
in the Local List window. The category to which a description belongs is
indicated by an appropriate symbol in column U:

* Update authorized

X Updatable and cross-referenced graphic descriptions
only

BLANK Consultation only

@ Draft

~ Intermediate status
The description is already locked on the host, whereas
the download is not yet completed.
The Local List window is used for a number of operations:
= Consult information on local descriptions
= Access (view or edit) local descriptions
= Upload local descriptions to the Specifications Database

= Create and edit draft descriptions (i.e. local descriptions NOT related to a
host occurrence).

= Copy a local description onto another updatable local description
= Replace an updatable local description with another local description
» Transfer ownership of a description to another user

= Clear a local description and download it again from the Specifications
Database (revert to the host description)

= Unlock a host description and delete the corresponding local description
= Delete local descriptions
Depending on the category (column U), not all menu commands will be

available. For example, a draft description cannot be uploaded, and a
consultation-only description cannot be replaced with another description.

Getting to the Window

As local lists are managed at local level, i.e. at WorkStation level, the Local List
window is accessed in local connection as well as in host connection.

Choose a local list in the List group of the Entity dialog box.

For details about the Entity dialog box, refer to chapter “Navigation in the
WorkStation”, subchapter “The Entity Dialog Box”.
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The Menu Bar of the Local List Window

Entity...

Description

Host-Access

Each command in the Description and Host-Access menus is available only
for specific categories of descriptions. In this subchapter, an explanation of the
commands is given along with the symbols of the categories for which the
commands are active. For the definition of the category symbols, see
subchapter “Functionalities”.

This command leads you to the Entity dialog box.

This menu contains commands which open the description window, create and
rename draft descriptions and copy/replace/delete selected local descriptions.

This menu manages the host communication for uploading, unlocking,
downloading and transferring descriptions.

Function Keys and Mouse Control

For the use of function keys and mouse in this screen, see the Appendix at the
end of this manual.
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The Entity... Command

Entity...

Opens up the Entity dialog box for the selected occurrence in the list.

The Description Menu

Description

Open (*, blank, x, @)

Open
Information

Create Draft...
Rename Draft...

Copy to...
Replace by...

Delete

Opens the window corresponding to the selected description (graphic
description, text description, etc.).

You can also open the window by double-clicking on a description of the list (or
by selecting the description then pressing ENTER). The Information dialog box
must remain closed.

Information ( *, blank, x, @, ~)

Opens the Information dialog box which displays the following information for
the selected description:

* User code of the description owner

* User authorization to consult or update the description

* DSMS change

* Date, time and session of the description download on the PC

* Date, time and session of the last description upload on the host
* Date and time of the last local save

* Information as to whether the local description or draft description is empty
or not.

The Information dialog box remains open when you select another description.
The information in the dialog box changes with respect to the selected
description.
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Create Draft...(@)

Rename Draft...

7-5

Creates a draft description (i.e. a local description NOT related to a host
occurrence). However, a draft description depends on the connection context
(Database, Session, Library and Product Code and Change Number) in which it
is created.

The Create Draft command opens a dialog box where you enter its code and
name. Certain characters cannot be used in the draft code: for these codes
refer to chapter “The Definition Window”, subchapter “Functionalities”. If the
chosen code already exists in the local list, creation is not possible.

Once you click ok, the dialog box closes and the new draft is listed in the Local
List window.

Allows you to change the name (the code cannot be changed) of the draft.

Copy to...( *, BLANK, X, @)

NOTE:

Replace by...(*, @)

Copies the selected description (source) onto another updatable description of
the same type (target description).

Warning : the content of the source description cancels and replaces the
content of the target description (example of the Text entity: if you copy text
TEXT1 which has two sections AA and BB onto text TEXT2 which has three
sections 01, 02 and 03, the result will be TEXT2 with only two sections, AA and
BB).

To perform a copy, you must be the owner of the target description. The

target description must have the same Product Code and Change Number

as those of your current connection context (Context in the System menu).
A dialog box, containing two sections, opens up:

* The Source section indicates the code of the source description you have
selected

* Enter the code of the target description in the Target section
If the target description is located in a Database, Session, or Library which is

different from your current connection context, enter them in the corresponding
input fields (type over the displayed values).

Furthermore, if the target description does not exist, you may create a draft
description.

You can also select a different target context through the Help button which
opens up a dialog box containing three list boxes:

1. Databases available for your user code.

2. For the Database selected in the first list box, locally “known” Sessions.'

3. For the Session selected in the second list box, locally “known” Libraries.'
The target context selected by default appears in these list boxes.
After changes have been made, a confirmation dialog box is displayed (oK =

confirm, Cancel = ignore changes).

Replaces the selected description (target) with another description of the same
type (source).
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NOTE:

Delete (blank, @)

NOTES
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Warning : the content of the source description cancels and replaces the
content of the target description (example of the Text entity: if you replace text
TEXT1 which has two sections AA and BB with text TEXT2 which has three
sections 01, 02 and 03, the result will be text TEXT1 with three sections 01, 02
and 03).

To perform a replacement, you must be the owner of the target description.
Target descriptions must have the same Product Code and Change Number
as the current WorkStation window context (Context in the System menu).

When Replace by is called, a dialog box similar to the preceding one is
displayed (except that all targets are replaced by sources).

Deletes the selected description: a dialog box requests confirmation.

To delete a "description” downloaded locally for update
(* or x), first delete its content then upload the description via the Host-
Access menu (see below). A dialog box asks you if you want to delete the
local file corresponding to the description.

To delete an "occurrence” downloaded locally for update (> or x), first delete
all lines depending on the occurrence (X-references, comments and
descriptions). Then upload the "empty" description to the host and, in the
Definition window, select Delete from the Occurrence menu. See chapter “The
Definition Window” for a complete description of this window.
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Host-Access Deferred Upload...
Immediate Upload...

Unlock

Clear and Download

Transfer to ...

These commands all require a host connection except for Deferred Upload .

Deferred Upload...
Immediate Upload...( *, X)

Select one of these commands to upload the description into the Specifications
Database. Other applications cannot communicate with the host during upload.
You must close the window of the description you want to upload.

A deferred upload does not require a host connection. Once a deferred upload
is requested, the request is stored in an upload queue. Once connection to the
host is established, the actual upload can be performed.

Selection of one of these commands may have one of the following results:

1. The display of messages, if:

In

The local description is empty

The local description is similar to the description which is already in the
Specifications Database

Links have been deleted from a graphic description and you have not

selected Operate links . In this case there is a chance that the links in

the graph and the actual links that exist in the Database are not the

same. For example:

+ A link is shown in the graph but does not exist in the Specifications
Database

+ A link exists in the Specifications Database but is not shown in the
graph

You may choose to keep these differences. For more details of graphic
descriptions, refer to chapter “The Graphic Description Window”.

each of these cases, a dialog box opens up with a message

corresponding to the problem.
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2. The opening of a dialog box:

This dialog box asks you whether the description is to be unlocked in the
Specifications Database.

If you perform the upload for archiving or safety purposes, or simply in
order to “refresh” the host description, and if you intend to update the
description further, you must upload the description without unlocking it.

On the other hand, if your work is finished and if you want to make the
description available to the other users, you must unlock it.

Refer also to chapter “Introduction”, subchapter “Data Sharing and
Consistency”.

You are also asked if you wish to delete the local description file after
uploading and unlocking the description.

When a description is uploaded and unlocked without local deletion, the
access mode for the corresponding local file is changed to Consultation
Only.

After an upload of this type, the system verifies that the Technical Unlock has
occurred. If the upload was not correctly performed, it is not possible to delete
the corresponding local descriptions.

See also Delete in the Description menu.

Deferred Upload...( *, X)

Save the update request in an upload queue. To start the effective upload of the
description, select Deferred Upload from the Host-Access menu in the
WorkStation Manager window. For more details, refer to chapter “The
WorkStation Manager Window”, subchapter “The Deferred Download/Upload
Requests Window”.

Immediate upload...( *, X)

Unlock...( *)

Uploads the description immediately. The Upload/Download icon appears on
the icon bar. The Upload/Download icon is displayed on the icon bar.

You cannot request an immediate upload for a description for which you have
already requested a deferred upload or download. You must send or cancel the
deferred requests before requesting the immediate upload.

Unlocks the description selected on the host and deletes it on your workstation
without uploading it.

The unlock results in restoration of the initial version of the host description, i.e.
the version which existed before the description upload (and any update).

Only one description can be unlocked at the same time.

Clear and Download( *, blank, ~)

If you have wrongly modified a local description, or have downloaded a
description which has subsequently been modified in view mode only, you can
refresh it and retrieve the initial version. This command does not modify the
description update category. (For example, if the description is in view mode
only and you wish to update it, you must delete it locally and request clear and
download from the Entity dialog box.)

No communication is possible between the host and any other application
during download.
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Transfer to ...( *, X)

7-9

A confirmation message appears: "Download is overDo you wish to access the
Description?" If you confirm, you directly access the new local description.

If disconnection occurs during downloading, you cannot access the description,
which is incomplete, but you will be able to select the command again.

This command is used to transfer ownership of the selected description from
the owner to another user. Caution: the owner cannot transfer the logical lock
to another user if a technical lock is positioned.

As ownership transfer directly updates the Specifications Database, it is
available only with a host connection. The selected description must be owned
by the connected user.

This command opens a dialog box in which you enter the code of the new
owner. Click OK to confirm, which then runs an application on the host. An icon
for authorization transfer appears in the icon bar and remains displayed during
the "Transfer to..." operation.

As soon as your request is recorded at the host level, the local list is re-
displayed to show the new owner.

Only one description ownership can be transferred at the same time.

See also chapter “Introduction”, subchapter “Data Sharing and Consistency”.
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Use the Definition window to:

* Consult and/or update occurrence definitions in the Specifications
Database in real time

* Select occurrences in order to match them with objects (icons or
occurrence-bearing links) in a graphic description, and to define new
occurrences for this purpose

* Consult the host Definition online help

Whatever the type, the Definition window displays the following information:

* The occurrence Code, Name, and explicit Keywords, if any

* Host environment information (i.e. Library and Session, and also any
occurrence lock)

* Afield for standard error messages generated by the host

Other fields are displayed according to the entity and the module. Some of the
fields displayed in the Definition windows are controlled by the host. For a
complete description of the Definition window, use the on-line help.

The colors of all these fields can be changed via the Logical Screens dialog

box in the WorkStation Manager window. Refer to the chapter “The
WorkStation Manager Window”, subchapter “The Auxiliary Dialog Boxes”.
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Getting to the Window

A host connection is required.

Enter an occurrence code in the Code field of the Entity dialog box and press
the Host Definition button.

For more details on different ways of entering occurrence codes in the Entity

dialog box, see the chapter “Navigation in the WorkStation”, subchapter “The
Entity Dialog Box”.
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Occurrence Name and Code Restrictions
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The following symbols are not allowed in occurrence names since they are

used as delimiters in the system:

Two consecutive semi-colons

G

The following symbols are not allowed in occurrence codes because the
names of local files are created using these codes, and the special characters
may have a special meaning for the PC operating system:

Semi-colon
Colon

Comma

Quotes
Apostrophe
Equals sign
Plus sign
Square brackets
Pipe

At sign
Paragraph mark
Asterisk
Question mark
Period

Blank
Underscore
Forward slash
Backslash
Greater than sign
Less than sign
Power of 2

G;
(:
G
¢
(

— O — —

=
(+)
([and])
()
(@)
€)
*
(?)
()
()
O
0]
()
*)
(<)
®

Accented characters are not permitted. They are automatically changed to
their non-accented form on validation.

Occurrence Code Input made easy

You can use the drag and drop technique to fill in the occurrence code in a
Definition window (target window) from a host list, a Formatted Description or
another Definition window (source window).

Open simultaneously the Definition window and the Formatted Description,
the host list or another Definition window.

Select an occurrence code in the source window by clicking the mouse's
left button and drag the mouse to the target window while keeping the
button pressed.

Release the button above a field which accepts an occurrence code of the
same entity.
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The Definition Window Menu Bar

Entity

Occurrence

Match!

Options

?=F1
Screen

System Menu

This Cascaded menu contains commands used to access the definition, lists,
descriptions and cross-references of the occurrence selected in the list.

This menu contains commands used to create, modify or delete an
occurrence.

This command is active when a Definition window is selected from a Graphic
Description window in order to associate an occurrence with an object in the
graph.

This menu contains commands used to display the source occurrence or the
target occurrence.

This command accesses host online help.
This menu allows you to copy and print the current window.

In addition to standard commands, the system menu allows you to consult
the context of the current window.

Function Keys and Mouse Control

For the use of function keys and mouse in this screen, see the Appendix at
the end of this manual.
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The Entity Menu

Entity
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Main entity =>» Definition...
Lists =>» Available lists
Descriptions => Available descriptions
X-references => Available X-references

Different occurrence...
Related entity...

For full details of this menu, see the chapter “Navigation in the WorkStation”,
subchapter “The Cascaded Entity Menu”.

The Occurrence Menu

Occurrence

Create/Modify

Create

Modify

Delete

NOTE

Create/Modify

Create
Modify
Delete

Creates or modifies the occurrence depending on the contents of the
Specifications Database.

Pressing ENTER has the same effect.
It is possible to create or modify the definition of another occurrence of the
same type without calling the Entity dialog box. Type over the displayed

occurrence code with the code of the second occurrence:

* |If the second occurrence already exists, it's values will be modified
according to those displayed

e |[f it does not exist, it will be created with these values
See also the Options menu.

Creates the occurrence. If the occurrence already exists, an error message is
displayed.

Modifies the occurrence. If the occurrence does not exist, an error message is
displayed.

Deletes the occurrence. If the occurrence does not exist, an error message is
displayed.

Everything related to the occurrence (X-references, documentation,
descriptions) must first be deleted. To delete local descriptions, see the
chapter “The Local List Window”, subchapter “The Menu Bar of the Local
List Window” under The Description Menu (Delete).
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The Match! command

Match! This command associates an occurrence defined in the Definition window with
an object (icon or occurrence-bearing link) in the graphic description.

Select an object (icon or occurrence-bearing link) in the graphic description
and then select By Definition in the Reference menu. For additional
information, refer to chapter “the Graphic Description Window”.

During a matching operation, the Match! command may be used several
times without closing the window. To perform another match, select another
object in the graphic description, select another occurrence in the list and
select Match!

NOTE If you modify the definition, the Match! command will become inactive. You

must transmit the modification to the host (select ENTER or Create/Modify
from the Occurrence menu) to re-activate this command.
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The Options Menu

Options

Stay on Source

Go to Target
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Stay on Source
Go to Target

This menu allows you to specify which occurrence is to be displayed after the
creation (or modification of the definition) of an occurrence by duplication, or
after the deletion of an occurrence from the Definition window of another
occurrence. The checked command indicates the current mode.

Duplication procedure
Type the target occurrence code over the source occurrence code. Attention
should be paid to the correspondence of description line identifiers.

For full details on duplication, see the User Interface Guide:
= chapter “Online Access Language”, subchapter “Online Updating”
= chapter “Text Editing Facilities”, subchapter “Editing from the Action
Code”

Displays the definition of the source occurrence after the update is performed.
This is the default option unless you access the definition via By Definition in
the References menu of a Graphic description.

Displays the definition of the target occurrence after the update is performed.

This is the default option when you access the definition via By Definition in
the References menu of a Graphic description.
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The Screen Menu

Screen Menu Copy Host Screen
Print Host Screen...

Copy Host Screen
Copies the current Host Screen in the SPAC\BASE\SPAC.PRT. When you
select this command, a dialog box offers you either to reinitialize the file, or to
add the screen at the end of the existing file.

Print Host Screen...
Prints the current Host Screen.

The Help Command

?=F1 This command accesses the online help.
For more information, see subchapter “The Auxiliary Window: The Help

Window”.

The System Menu

System Menu  Context...
Context... Displays the current context.

For more information about the context, refer to the subchapter “Context”,
chapter “WorkStation Connection”.
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Auxiliary Window: Help Window

Input Help

Two types of help are available on the Definition windows:
¢ Input help, used to fill in unprotected fields with an authorized value

¢ General help on the Definition window

To access the Input Help window corresponding to the Help on an input field,
position the cursor in the input field and choose ?=F1 from the menu bar or

press F1. A Help page corresponding to the relevant field appears.

= PACBASE Documentation vl -~
Fichier Edition Signet Aide
Index Iﬂechercherl Précédent I Historique I £ I > -
TYPE OF COBOL TO GENERATE
Back to: DEFINITION OF & PROGREAM| 4
Specifies the COBOL wariant for the genereted program.
) Ho adaptation to a language wvariant (Default wvalue
at creation). It is used to prevent program genera-
tian.
o Adaptation to AMNSI COBOL: IBM MVE
1 Adaptation to AMNSI COBOL: IBM DOS
2 Adaptation to COBOL : IBM 36
3 Adaptation to COBOL MICROFOCIIS, IBM WISUAL SET
4 Adaptation to COBOL : BULL DES7
5 Adaptation to AMSI COBOL: (74) BULL DPI8
B Adaptation to COBOL (BCD) EBULL DFPSZ8
7 Adaptation to COEBEOL : HP-3000
8 Adaptation to ANSI COBOL: BURROUGHE (large svstems)
: UNISYS & Series
9 Adaptation to ANSI COBOL: UNISYS 9030
B Adaptation to COBOL (74) PRIME
E Adaptation to COBOL BUEROUZHZ (Medium swstems)
¢ UMISYS V Series
c Exztraction of COBOL Source Code.
(Refer to chapter "APPEMDIX: PURE COEBOL SOURCE CODE"
in the STRIICTUEED CODE Reference Manual).
D Adaptation to ANSI COBOL: (74) CONTROL DATAE CORP.
E Adaptation to ANSI COBOL: (68) CONTROL DATA CORP. I!

If values have been defined for the field, the Help page displays the various
authorized values with explanations. If you select a value (underlined and
located to the left of the screen) it is input directly and the Help page closes.

The value entered in a field is referenced against the list of authorized values
for this field. This verification is performed each time the cursor exits a field. If
the value entered is not one of the authorized values, an error message
appears requesting confirmation of the entry. If the entry is confirmed, the
invalid value is accepted (it may subsequently be refused by the host) and the
cursor is positioned on the next field. If the entry is not confirmed, the cursor is
repositioned in the field for a new input.
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General Help

To access the General Help window for a Definition window, position the
cursor anywhere but in an input field and choose ?=F1 from the menu bar or
press F1.

_ PACBASE Documentation vl -
Fichier Edition Signet Aide

Index Iﬂechercherl Précedent I Historique I < I >>
DEFINITION OF A PROGRAM

Back to: General indes]+]

The Program entitw is used to develop all the batch
procedures
defined during the detailed analwsis phase.

The Program entity includes:

. A reguired Definitian SCcreen ., for entry =33
general
characteristics (clear name: . kevwords . twpe of

COBOL  tao
gensrate. etoc.);
. Description screens of the following tyvpes:

- Call of data structures tao ensure the generation of the
DIVISION in the program.

- Structured code to eEnsurs the generation of the
PROCEDLURE
DIVIZION in the program.

- Call of parameterized macro-structures, Tt
standardize
specific procedures executed several times in one or
more
programs ;

The list of fields in this Definition window appears at the end of the page. These are
hypertext links you can use to read online help on these fields.

= PACBASE Documentation v| -
Fichier Edition Signet Aide
Index Iﬁechercherl Précedent I Historigue I << I >

DEFINITION OF A PROGRAM

PROGRAM CODE

CODE FOR SEQUENCE OF GEMERATION
PROGRAM NAME

TYFPE OF COBOL TO GEMERATE

COBOL NUMBERING AND ALIGHMENT OFTIOMN
9 CARDS REMUMEBERIMNG

SQL INDICATORS GEMNERATION WWITH -
CONTROL CARDS [N FROMT OF PROGRAMS
COMTROL CARDS M BACK OF PROGREAMS
COBOL PROGRAN-1D

MODE OF PROGEAMMIMNG

TYFE AND STRUCTURE OF PROGRAM
TYFE OF PRESEMCE WALIDATION
PROGRAM CLASSIFICATION CODE
EXFLICIT KEYWORDS

For more details on navigation in the on-line help, refer to chapter “Metamodels”, sub-
chapter “Methodological Help”.
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Functionalities

The Cross-References window allows you to consult the cross-references of an
occurrence. The Cross-Reference lists vary according to the type of entity
being cross-referenced.

Getting to the Window

A host connection is required.

Enter an occurrence in the Code field of the Entity dialog box and select a type
of cross-reference from the list of cross-references in the Entity dialog box.

For details about different ways of specifying an occurrence code in the Entity
dialog box, refer to chapter “Navigation in the WorkStation”.
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The Menu Bar of the Cross-References Window

Entity This Cascaded menu contains commands that allow you to access the
definition, lists, descriptions and cross-references of the occurrence selected in
the list.

Display This menu contains several commands which allow you to choose the point

from which the list is displayed.
Match! This command is inactive in this window.

View... This command leads you to the View dialog box. From this dialog box you can
select a Library sub-network and a list display type.

Screen This menu allows you to copy and print the current window.

System Menu In addition to standard commands, the system menu allows you to consult the
context of the current window.

Function Keys and Mouse Control

For the use of function keys and mouse in this screen, see the Appendix at the
end of this manual.
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The Entity Menu

Entity

Display

Next Page
NOTE:

Same Page

Top

From...

NOTE:

Repositioning

NOTE

VisualAge Pacbase WorkStation Reference Manual

Main entity =>» Definition...
Lists =>» Available lists
Descriptions =>» Available descriptions
X-references = Available X-references

Different occurrence...
Related entity...

For full details of this menu, see the chapter “Navigation in the WorkStation”,
subchapter “The Cascaded Entity Menu”.

Next Page
Same Page

Top
From...
Repositioning = Type of memorization

Displays the next page of the Cross-Reference List.

Pressing the ENTER key has the same effect.
Re-displays the same page. This command is used to display an updated
version of the Cross-Reference List. For example, use this command to view
new occurrences which may have been defined after opening this window.
Displays the list from the beginning.
Opens the From... dialog box in which you enter the position from which the list
is to be displayed. Each position you indicate in this dialog box will be

memorized.

For a complete description of the From... dialog box, refer to chapter
“Navigation in the WorkStation”, subchapter “Auxiliary Dialog Boxes”.

This command is not available for all types of cross-references.
= Type of memorization

Opens the Position Memorization dialog box. In this box, select the type of
memorization you want:

Explicit Memorization
This type of memorization memorizes each display position specified via the
From command of the Display menu as a sub-choice of the Repositioning
choice.

Implicit Memorization
This type of memorization memorizes each current position you obtained
through a simple transmit as a sub-choice of the Repositioning choice.

You can select both types of memorization in the Position Memorization

dialog box. The Repositioning choice can store up to 20 positions while the
window remains open.
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The View... Command
View... Opens the View dialog box.

For a complete description of the View dialog box, refer to chapter “The Host
List Window”, subchapter “Auxiliary Dialog Boxes”.

System Menu  Copy Host Screen
Print Host Screen...

Context...

Copy Host Screen Copies the current Host Screen in the SPAC\BASE\SPAC.PRT. When you
select this command, a dialog box offers you either to reinitialize the file, or to
add the screen at the end of the existing file.

Print Host Screen... Prints the current Host Screen.

Context... Displays the current context.

For more information about the context, refer to the subchapter “Context”,
chapter “WorkStation Connection”.
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Functionalities

Building
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You use the Graphic Description window to create, update and print diagrams
associated with the Application Design Methodology. You can also validate
graphic descriptions with regard to the methodology in use and integrate them
into the Specifications Database.

For further details on entities with graphic descriptions, refer to the online help.
Graphic descriptions vary with the selected entity.

When used for a Free Entity, the Graphic Description window provides
restricted functionalities. For more details, refer to chapter “The Free Entity”.

You can use the drag and drop technique to fill in the occurrence code in a
Definition window (target window) from a host list, a Formatted Description or
another Definition window (source window).

* Open simultaneously the Definition window and the Formatted Description,
the host list or another Definition window.

* Select an occurrence code in the source window by clicking the mouse's left
button and drag the mouse to the target window while keeping the button
pressed.

* Release the button above a field which accepts an occurrence code of the
same entity.

A graphic description involves three different operations: Building, Matching,
and Link/Cross-Reference Updating.

If you want to update a description which is defined on the host, it must be
downloaded for update. Since graphic descriptions are managed locally,
building does not require a connection to the host, if the description has
previously been downloaded to the PC. You may also choose to create a Draft
description of a graph. This can be done locally. (See chapter “The Local List
Window”.)

To build a graphic description you use icons and links specific to the entity and
description of the methodology in use.
A number of building features are available:

= Create, move, modify and delete icons and links

= Assign, modify and delete the names of icons and links

= Move and delete groups of icons and links

= Cut, copy and paste sections of a graphic description onto another
graphic description

= Scroll with the help of scroll bars within the graphic description

= Display various scales and zoom
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Matching

NOTE

10-3

= Use various grid sizes
= Set parameters of the components used in the graph

= Print all (or part) of a graphic description

Once the graphic description is complete, it must become stable. To do this, it
must be integrated into the Specifications Database. In other words, the
Database is expanded by matching the icons and links of the graphic
description with occurrences in the Specifications Database. For more
information, refer to subchapter “The Menu Bar of the Graphic Description
Window”, the References menu.

Since Matching updates the Specifications Database directly, all commands
involved in the matching operation are only active if you are connected to the
host.

You must specify which icon or link corresponds to which occurrence in the
Specifications Database. There are three ways to do this:

= Direct matching when you already know the code (and name) of the
occurrence which will reference the icon or link

= Access the Host Occurrence List window in order to match the icon or
link with an already existing occurrence

= Access the Definition window in order to create a new occurrence and
match it to the icon or link, or match the icon or link to an already existing
occurrence

In the Specifications Database these matches are translated into cross-
references between each occurrence matched with an icon or link and the
occurrence being graphically described.

In practice, the building and matching operations may occur concurrently.
However, manipulations on matched icons or links are restricted in order to
maintain data integrity at the host level. For instance, icons or links cannot
be removed from the graphic description if they are matched with
occurrences.

Link/Cross-Reference Updating

Links drawn in graphic descriptions are translated into cross-references
between host occurrences.

Link/cross-reference updating requires a host connection. For more information,

refer to subchapter “The Menu Bar of the Graphic Description Window”, the
References menu.
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Parameter Definition Levels of a Graphic Description

WARNING

Graphic descriptions are stored in the Specifications Database in an internal
format which cannot be read on the host. This description must UNDER NO
CIRCUMSTANCES be modified on the host. IBM accepts no responsibility for
any inconsistencies resulting from modifications of this type.

You can set the preferences (colors, formats, options) and styles (of icons, links
and comments) for a graphic description at different levels:

For all entities

In the WorkStation Manager window, from the Preferences menu, choose
Graph

= Set the user default preferences for all graphic descriptions of all entities
= These preferences are disabled by parameters defined at the level of:

a specific entity

a graphic description

a component of a graphic description

= For more details, refer to subchapter “Auxiliary Dialog Boxes”, the
Preferences dialog box

For a special entity

In the Graphic Description window, from the File menu, choose Preferences
= Define default preferences for all graphic descriptions of a specific entity

= These preferences are disabled by parameters defined at the level of:
a graphic description
a component of a graphic description

= For more details, refer to subchapter “Auxiliary Dialog Boxes”, the
Preferences dialog box

For a specific graphic description

In the Graphic Description window, from the Style menu, choose a type of
component (e.g. link).

= Set the default styles for all component(s) of the same type in the
graphic description

= These styles are disabled by parameters defined at the level of a specific
component

= For more details, refer to subchapter “Auxiliary Dialog Boxes”, the
Default Style dialog boxes for Icons/Links/Comments

Component (icon/link/comment)

In the Graphic Description window, double-click the required component to
open a dialog box

= Define the style for the selected component(s)

For more details, refer to subchapter “Auxiliary Dialog Boxes”, the
Icons/Links/Comments dialog boxes.
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Getting to the Window

Select a graphic description from a List group or from the Descriptions group in
the Entity dialog box.
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The Menu Bar of the Graphic Description Window

Preliminary Remarks

NOTE

Entity

File

Draw

Edit

References

Display

Style

System Menu

In the Graphic Description window, certain commands remain selected until you
select a new one. This allows you to perform for example repeated
manipulations (see for example Icon in the Draw menu). The message "The
previous command is still selected" is displayed in this case. To go to a different
manipulation, you must either exit the current command, or press ESC or the
right mouse button before selecting another command from the menu bar.

The Draw and References menus are only active when the description has
been downloaded for update.

Occurrence codes and names must follow the rules in chapter “Definition”,
subchapter “Occurrence Name and Code Restrictions”.

This menu contains commands which select or redisplay another description of
the current occurrence, open the Entity dialog box for the occurrence containing
the graphic description or the Entity dialog box which references the selected
graphical component.

This menu contains commands which save or restore the graphic description on
your workstation, print it and validate links.

This menu contains commands for using the various components which can be
integrated in your specific graphic description, as well as the commands for
inserting links, free lines and comments.

This menu contains commands that allow you to select, cut/copy/paste, move or
delete a graphical component or group of components.

This menu contains commands that match occurrences from the Specifications
Database to graphic description icons/links and update names and links.

This menu contains the commands which manage the graphic description
display type: zoom, select display size, expand/contract the graph area, repaint,
display toolbar and icon box.

This menu contains commands that allow you to assign default values to graph
components: icons, links, comments, and grid and to open the Preferences
dialog box (in which you can change colors/formats/options).

In addition to standard commands, the system menu allows you to consult the
context of the current window.
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The Entity Menu

Entity Main entity = Definition...
Lists =>» Available lists
Descriptions =>» Available descriptions
X-references = Available X-references

Different occurrence...
Related entity...

For full details of this menu, see the chapter “Navigation in the WorkStation”,
subchapter “The Cascaded Entity Menu”.

The File Menu

File Save

Restore

Print Layout...

Select pages to print

Proportional scale

Free scale

Print Parameters ...

Print

Printer ...

Validate

Save Saves the graphic description on your workstation. If a Match! (see the
References menu below) was performed before the save, all menus will be
grayed while the X-references are being saved.

NOTE If the Updating application has detected a host disconnection, it
automatically switches to local connection. To connect to the host again,
select Host Connection in the Host-Access menu in the WorkStation
Manager.

Restore Returns to the last save of the graphic description, replacing the current version
of the graph being edited with the last version saved on disk.

Print layout...
You can "divide" the width of the graphic description ("column" wise) into
several pages. The graphic description will be divided into a number of "lines"
(horizontal subdivisions) corresponding to the number of "pages" defined.

If you choose 0, the page layout is not specified. If you choose 1, the full

graphic description is sprinted on a single page. From 2 to 6, the width of the
graphic description is divided into 2 to 6 across pages.
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NOTE

Select pages to print

Proportional scale

Free scale

NOTE

Print parameters...

Print

NOTE
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The height is set according to the page orientation. For example, if you choose
landscape orientation, selecting 3 displays three pages across and three pages
down on the screen. You will see nine pages in total.

The format and orientation of a page are set according to selections made via
the options in the Printer command. The number of divisions (in pages) and the
graph orientation are memorized in the graph.

Once the page layout is set, you need to select the pages to be printed. Select
this menu and click on the page(s) to be printed. Then, the page is displayed in
reverse video. Clicking again on the page clears the selection.

Allows you to define the section of the graphic description to be printed. The
system will pick up proportions based on the size and orientation of the printer
page (See Printer options.) Draw a rectangle around the section you wish to
print by moving the mouse, holding the left button. When you release the
button, the section to be printed is highlighted.

Allows you to "freely" define the section of the graphic description to be printed.

To change the section to be printed, press Esc (or the right mouse button) and
redefine the section.

Displays a dialog box which allows you to set print options.

The dialog box displays the various types of icons drawn in the graphic
description. For each icon, you can select the element which you wish to print :
occurrence code, name in plain text, attributes (independently of the code) or
the icon itself.

You may also print the code of an occurrence bearing-link, the attributes
associated, the name of a link or the labels of free lines.

Other options are available: print of title (i.e. the name of the occurrence being
graphically described), frame and comments.

Choose Save to save your options and close the dialog box.

Once Printer options and Print options are set, is choice allows you to print all or
a section of the graphic description. This is done in two steps: selecting the
section and printing.

Once one of the following commands is selected (Selection of the pages to
print, Proportional or free scale ), this menu allows you to request the actual
printing.

If pages are not selected to print, the whole graph will be printed by default.

A dialog box opens up where the printing procedure can be canceled using the
Cancel button. As long as this dialog box remains open, printing is in progress.
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Printer... Open a dialog box listing the printers connected to your PC.

You can select print options in this dialog box, such as Paper size, and
Orientation (Portrait/Landscape) to print a graph.The parameters defined will
be saved in the file containing the description of the graph. Afterwards, each
time you print the graph, the printer is automatically configured to the
parameters defined for the graph.

If no page orientation has been selected for the printing of your graph, the
default orientation selected is that one specified in MS/Windows.

Validate Validates the graphic description according to the methodology in use.

For more details and examples concerning validation, refer to subchapter
“Validation of a Graphic Description”.
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The Draw Menu

Draw
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List of available icons

Link

Free line

Comment

Column (according to entities)
Time column (according to entities)

You can use the Preferences dialog box and the Style menu to define your own default options for the
grid, icons, links and comments before editing your graphic description.

List of available icons

Link

NOTE

Displays all available icons for the entity and the specific graphic description
which you are working on.

Select an icon and click in the graphic description to insert it at the required
location.

This command remains active: if you click in another location, an icon of the
same type is inserted.

The icons can appear twice in the list, once on their own and again
accompanied by the term Attributes in parentheses. Attributes are data
appearing in the occurrence definition. If you select the icon with attributes
and enter them, the attributes are displayed on the icon (in addition to the
code and name) in the graphic description. For more details about attributes
according to entities, refer to the online help.

The characteristics of an icon inserted into the graph can be changed via the
Icon dialog box. Refer to chapter “Auxiliary Dialog Boxes”.

To create a link, click on the source icon (or on a comment), then on the target
icon (or on a comment). If you wish to include mid-way points on the link, click
on the source icon, then on the locations where you wish to place the mid-way
points, and finally on the target icon.

If there are several mid-way points, only the first point will appear and will have
the link handle/square and name. The other points are however saved and
appear when you select the link.

For a pipe link, the handle/square is also positioned on the first mid-way point. If
there is no mid-way point, the handle/square is positioned on the link elbow and
in this case is only used to select the link: it is only moved if one of the ends is
moved.

To draw a reflexive link (valid only for certain entities), select this command,

click on the source icon, click on one or more mid-way points near the source
icon and then click again on the source icon.
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Free line

Comment
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If you place a mid-way point of a curved link inside a rectangle including an
icon, the icon will be considered as both source and target icon. The link
created will be drawn as an arc.

* The system automatically checks that the link you try to create is compatible
with the methodology in use.

* The link display varies with:
» The linked icons

= The link direction

Once the link has been placed on the graph, its characteristics can be changed
via the Link dialog box. Refer to subchapter “Auxiliary Dialog Boxes”.

Allows you to draw lines without linking them to icons.

To draw a free line, click on the graphic description where you want the line to
start, then on the different places where you want mid-way points to appear. To
end the line, click on an end point.

If there are several mid-way points, only the first point will appear on the screen
and will bear the handle and the name. The other points are however saved and
appear when you select the free line.

You can modify the characteristics of a free line via the Link dialog box. Refer to
subchapter “Auxiliary Dialog Boxes”.

This facility allows you to enter short text comments on the graphic description.

Select this command, then click on the place in the graph where you want to
place comments and move the mouse diagonally, holding the left button down,
towards the bottom-right in order to "stretch" the comment area to the desired
size. This will draw a box in which you can place comments. Release the left
mouse button and a dialog box appears for your comments. Once you have
entered text and pressed oK button, the dialog box closes and the text appears
within the area defined. If the Frame option is checked in the default Comment
Style dialog box (Style menu), the text appears within a rectangle.

Here is an example Here is an Here

which shows how text example which is an

appears in comments shows how text exam
appears in which
comments

For complete information concerning the Comment dialog box, refer to
subchapter “Auxiliary Dialog Boxes”.
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Column

NOTE
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This command allows you to create containers (grouping icons). The command
is not available for all entities: when it is, its label can vary according to the
entity and/or the methodology used. For instance, the label is "Column” for the
Free Entity as well as for all MERISE entities, when available. For more detalils,
refer to the online help.

You can:
1. Create a chart of containers:

Select this command. Click where you want the chart of containers to be
positioned. The first container is then inserted. In order to add n containers,
simply click n times inside the first container. Containers will be added to the
right of the initial one.

2. Add n containers to an existing chart of containers:

Select this command. Click n times anywhere within the chart. New containers
will be added to the right of the initial chart.

3. Move containers:

If there is only one container in a chart, click once on the container and drag it
to the new location. If there are several containers in the chart, select the entire
chart (point the cursor to the upper-left corner and drag it to the lower-right
corner: the chart will change color) and move (click on the chart and drag) it to
the new location.

4. Change the size of a container:

Click once on the container (even if it is in a chart of containers) to select it and,
using the cursor, drag the handles (rectangle shapes) on the container to
change its width and length.

5. Change the size of a container by copying the size of other containers in the
same chart, and centering icons within a container:

Double-click on the container whose size you wish to modify or whose icons
you wish to center. A dialog box will open. For a description of this dialog box,
refer to subchapter “The Container Dialog Box”.

6. Deleting a container

After selecting a container, choose Delete from the Edit menu. A dialog box
asks you if you want to delete the icons located in the container. Displaying this
dialog box is optional. In the Preferences dialog box (Preferences in the File
menu) set the Display confirmation messages item in the Option part to
Yes/No.
Enlarging a container in a chart does not move the icons it contains.
Adjoining containers will accordingly be nudged with the icons they contain if
they are part of the same chart (otherwise they will overlap).
When deleting a container, you are asked to confirm the deletion of the icons
it contains. The default answer is NO.
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Time Column This command is not available for all entities: when it is, its label can vary
according to the entity and/or the methodology used. For more details, refer to
the online help.

For instance, the label is "Time Column" for the Free Entity as well as for all
MERISE entities, when available. When MERISE methodology is used, a time
column is used to indicate periodic processing cycles. It is generally placed to
the left of a chart of columns.

Graphic components managed by this command are manipulated in the same
way as the previous command.
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The Edit Menu

Edit
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Select group

Cut

Copy
Paste

Move

Delete

COMMENTS ON THE CLIPBOARD

Select a group

Cut

Copy

NOTE

It is possible to work on groups of components. These edit operations can be
performed inside the same graphic description or between two graphic
descriptions of the same entity.

The Copy and Cut commands transfer the group selected from the graphic
description to the clipboard where it remains until replaced by another group.

The clipboard is a temporary storage area in the memory.

The Paste command calls the group from the clipboard and pastes it into the
graphic description. This command is only active if the content of the clipboard
is compatible with the graphic description displayed.

Whatever the content of the clipboard, it can be pasted into PAINTBRUSH or other
programs running under the same graphic environment as WorkStation.

Draw a rectangle around the group you wish to select by moving the mouse
diagonally, holding the left button down, towards the bottom-right. When you
release the mouse button, the elements inside the rectangle are selected. As a
result, the color of the objects outlines has changed.

The links between the selected icons are also selected even if they overlap the
rectangle.

If a selected icon is linked to a non-selected icon, this link is automatically re-
positioned if you move the icon. When a Cut is performed, the link is lost.

|t is possible to modify the size of a selected group without modifying the other
parts of the graph. When a group is selected, the icons are displayed with a
specific shape. The selection rectangle is displayed with handles that allow to
enlarge or reduce its size according to the mouse movement. The fixed point is
the center of the selection rectangle. This operation modifies the shape and the
position of the selected icons and links while the general disposition of the
group remains unchanged.

Removes the selected group from the graphic description and transfers it to the
clipboard.

An icon (or link) matched with an occurrence defined in the Specifications
Database cannot be cut.

Transfers the selected group from the graphic description to the clipboard. The
selection mark (a rectangle) is held.
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Paste Calls the group contained in the clipboard and pastes it into the graphic
description. This command is only active if the content of the clipboard is fully
compatible with the graphic description. Otherwise, the operation fails.

Once a group of objects is pasted, it is displayed in a selection rectangle so that
it can be moved.

NOTE

= Each entity represented graphically in the selection (by an icon or a link)
must also be managed in the target graph

= Each non-entity bearing link and each container must have an equivalent
in the target graph

= The copied graphic components (icons, links, containers) adapt to the
format of the target graph. A component cannot therefore have the same
graphic appearance after it has been copied onto the target graph

= |f the selection contains icons connected by a link, it must also be
possible to connect them in the target graph

After selecting Paste, point the cursor at the position where you wish to paste. If
you hold the left mouse button down, the rectangle surrounding the group is
displayed, allowing you to adjust the position of the group before releasing the
button to paste the component. Once they have been pasted, icons and links
are drawn in the same way as in the target graph.

Move Moves a selected group to within a graphic description. Click on the selected
field (in reverse video) using the left mouse button and drag it to the required
position.

For more details about this functionality, refer to subchapter “Editing Tips”.

Delete Delete the selected component(s). An icon (or link) matched with an occurrence
cannot be deleted.
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The References Menu

References

NOTE

By Host Occurrence List
By Definition
Direct Match
Delete Match

Update Names
Update Link/X-Ref.

All commands in this menu require access to the Specifications Database and
are therefore only accessible with a host connection. This menu is used to
match components of a graph with occurrences in the Specifications Database.

Matching allows you to go from a local graphic description to an actual view of
graph cross-references in the Specifications Database.

The graphic description icons of a Free Entity and certain other entities (see
the relevant documentation for your methodology) cannot be matched with
host occurrences.

Click on the icon (or link) before selecting a command. The icon (or link)
changes color when it is selected, and changes color again after matching.

By Host Occurence List

NOTE

By Definition

Select the icon (or link) to be matched before activating the command: the host
occurrence list opens (at the beginning of the list)

To match the icon (or link) selected by an occurrence, select the occurrence
from the list then choose Match from the menu bar in the Host Occurrence List
window.

You hear a "beep" and the color of the icon (or link) changes, thus indicating the
match.

The matched icons or links are displayed with the code, name and any
attributes of the selected occurrence.

To repeat this operation, select another icon (or link) of the same type , then,
another occurrence in the list, and finally the Match command.

When working on a draft description, you may use this command in order to
retrieve an existing occurrence code and name for the selected icon (or link).
There will be no actual matching: the color of the selected icon (or link) does
not change. A host connection is however required.

Select the icon (or link) to be matched then activate this command. A Definition
window opens:

* |If the icon (or link) already has a code:

= Either the code entered for the icon (or link) identifies an occurrence
already defined in the Specifications Database. In that case, the
Definition window is automatically filled in by the information which is
already on the host. If the information on the icon (or link) is different, you
can transfer it to the host definition. Press ENTER. The occurrence will
then be modified on the host
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Delete Match

NOTE

NOTES REGARDING
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= Or the code entered for the icon (or link) is not the code for the
occurrence defined in the Specifications Database. In this case, the
Definition window only displays details of the icon (or link). If necessary,
you can complete this information and then validate it by pressing ENTER.
The occurrence will be created on the host

* If the icon (or link) has no code, the Definition window is displayed empty.
You must fill it in

To match the icon (or link) selected by an occurrence, choose Match from the
menu bar in the Definition window.

You hear a "beep" and the color of the icon (or link) changes, thus indicating the
match.

The icons, links or attributes are displayed with the corresponding host values
of the matched occurrence.

To repeat this operation, select another icon (or link) of the same type,
display/update the definition of the corresponding occurrence and finally choose
Match.

You can open several Definition windows, each one corresponding to a type of
icon or link. Click the right mouse button to close lists and Definition windows
after matching graph components.

This matches graph components with host occurrences without immediately
checking the validity of the match with the host. The match is verified when you
save the graphic description.

Either the icon (or link) has not yet been matched, or the icon (or link) has been
matched but you must modify the code, name or attributes of the occurrence
which matches it:

=  Double-click on the icon (or the link)

= A dialog box opens up where you enter or modify the code and/or name
and possibly the attributes of the occurrence to which the selected icon
(or link) must be matched. Click ok

= Select the icon (or link) again

=  Select the Delete Match command.
The color of the icon (or link) changes, thus indicating the match.

This command deletes the match between an icon (or a link) and the host
occurrence.

Select the icon (or the link), then Delete Match . The icon reverts to its initial
color.

The now unmatched icon (or link) can be deleted if necessary.

THE FOUR PRECEDING COMMANDS:

The commands described above involve modifications of cross-references at
the Specifications Database level. To avoid excessive response times, these

updates are performed locally. This also allows for the immediate deletion of
invalid references before unnecessary transactions are performed.

DSREF000254A



10-18

Update Names

Update Link/X-Ref.
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Actual updating in the Specifications Database takes place when you close the
Graphic Description window or select the Save command. A message appears:
"X-References updating on the host" and a special icon will appear in the lower
part of the screen during this operation.

If, for whatever reason, the cross-reference update cannot be executed, the
system displays a corresponding error message and the icons/links involved
change color.

The purpose of the Update Names command is to override - whenever
necessary - an icon or link local name, a primary cross-reference label: and/or
an attribute by the name (or corresponding attribute) of the occurrence
referenced to this icon or link.

For further details concerning Update Names and attributes, see subchapter
“Updating Names”. For further details concerning primary and secondary cross-
references, see subchapter “Updating Link/X-References”.

The main purpose of the Update Link/X-Reference operation is to translate
each link between two matched icons into a cross-reference between their
referenced occurrences in the Specifications Database.

For more details, refer to subchapter “Update Link/X-Ref.”.
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Alignments
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Zoom

Magnitude x1
Magnitude x2
Magnitude x3
Magnitude x4
Magnitude x5
Magnitude x6

Alignments

Expansion

Shrinkage

Repaint

Tool Bar
Icon Box

Allows you to zoom in on a specific section of the graphic description. This
command is checked when in use.

Point to the upper-left corner of the section to be magnified and move the
mouse, holding the left button down. When the mouse button is released, this
section occupies the whole screen.

This command allows you to select a display size for the graphic description.
With x1 magnitude the complete description is displayed. With the other
maghnitudes (x2, x3, x4, x5, x6), the user sees a section of the description.

Magnitude Display on screen
x1 full page
X2 1/4 of page
X3 1/9 of page
X4 1/16 of page
x5 1/25 of page
X 6 1/36 of page

Used to align icons of a selection on the reference icon. In a group of icons
selected, one is automatically assigned as the reference icon by default, that is
to say, the fix icon on which the other ones will be aligned. The reference icon is
presented with full handles.

To change the reference icon, just click on a selected icon while pressing the
Ctrl key.

A new icon added to the selection becomes automatically the new reference
icon.
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Expansion

Shrinkage

Repaint

Tool Bar

Save

E]

Print

Icon Box
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When you withdraw a reference icon from the selection, another one is
automatically assigned as the new reference icon.

For more details on the adding and withdrawal of an object from a selection,
consult subchapter “Drawing Hints”.

The Left and Right sub-menus are used to align vertically the left side or the
right side of the objects selected.

The choices Top and Bottom are used to align horizontally the upper side or
the lower side of the selected objects.

When you choose Vertical Center , the objects selected are centered and
aligned vertically. When you choose horizontal Center , the objects selected
are centered and aligned horizontally.

Expands the graph area to the right and the bottom, without changing the
characteristics of the existing objects (coordinates, icon and font size, etc...).
This expansion makes the graph look further as a greater area is displayed in
the same window, in view 1. This expansion operation can be processed
several times. To compensate for the moving away effect, you can use the
existing magnitudes or the zoom.

Contracts the diagram area if the area retrieved at the corresponding expansion
does not contain any object. The graph will then look nearer.

Refreshes the graphic description when several modifications have left gaps or
other marks.

This command is activated if you have selected Update Names or moved
components in the graph.

Displays the tool bar when the command is checked.

©]

Preferences Select a group Cut Copy
= dE
Paste Move Zoom Magnitude Repaint

; - _} ]

Print options Print layout Left Right

Alignment Alignment

W w (W=
Top Bottom Vertical Horizontal Display/Hide
Alignment Alignment Center Center Tooltips

Displays the icon box when the command is checked. The icons are the same
as those in the Draw menu.

Click on an icon: the icon label is displayed in the information bar. Then click in
the graphic description to insert the icon.
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Style

Icon...

Link...

Comment...

Grid...

Preferences...

The System Menu

System Menu

Context...
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Icon...
Link...
Comments...
Grid...
Preferences

The commands in this menu allow you to set default options in the current
graphic description for the styles of icons, links and comments. Most of these
options can be customized for individual components of the graphic description.
For further information, refer to subchapter “Drawing Hints”.

This command brings up the Default Icon Style dialog box. For complete details,
refer to subchapter “Auxiliary Dialog Boxes”, Section “The Default Icon Style
Dialog Box".

This command brings up the Default Link Style dialog box. For complete details,
refer to subchapter “Auxiliary Dialog Boxes”, Section “The Default Comment
Style Dialog Box”.

This command brings up the Default Comment Style dialog box. For complete
details, refer to subchapter “Auxiliary Dialog Boxes", Section “The Default
Comment Style Dialog Box”.

This command brings up the Grid Layout dialog box. For complete details, refer
to subchapter “Auxiliary Dialog Boxes”, the Grid Layout dialog box.

Opens the Preferences dialog box. See subchapter “Auxiliary Dialog Boxes”.

Context...
Displays the current context.

For more information about the context, refer to the subchapter “Context”,
chapter “WorkStation Connection”.
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Drawing Hints

MOVE

ENLARGE/REDUCE

DESELECT
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Before they can be changed, components must have been selected. Click on an
icon, comment, or container to select the component or, to select a link, click on
its handle (small square) or name. Selecting a component changes its color.

The time required to display a graphic description may vary according to the
performance of your workstation. It is not always necessary to wait for all
components of the graphic description to be displayed before you can begin
work.

NOTE

A link may contain several mid-way points. The handle is the first mid-way point
and displays the name of the link. The handle can also open the Link dialog box
if you double-click on it.

Click on a component. Drag the component to the desired location holding the
left mouse button down, then release the button. The links without mid-way
points are redrawn after they have been moved.

To redraw a link, first select it by clicking on its handle/square. Then click on the
source icon, any hew mid-way point(s) you wish to insert, and the target icon:
the link is redrawn accordingly.

To move the mid-way points of a link, select the link by clicking on its
handle/square or name. The mid-way points are displayed in the selection color.
Select the point to be moved and drag it to its new location. Release the mouse
button: the points remain selected and you can move another one. To clear the
selected link, click the right mouse button or press ESC.

The default size of a component in a graphic description is set through the Grid
command in the Style menu.

Click on the icon, comment, or container. A rectangular outline is displayed with
sizing handles on its sides and corners. Click on a side handle and drag it to
enlarge or reduce the component width or height accordingly. Click on a corner
handle and drag it to modify both component width and height.

To deselect, click out of the selection rectangle.

ADD/WITHDRAW AN OBJECT

To add an object (icons, links, free lines or charts), press the Shift key and click
on the object. Its handles are displayed in bold and the selection rectangle fits
the new selection.

To withdraw an object from a selection, perform the same action. You can
notice that the object no longer has selection handles.

A link can be added to a selection only when the related icons already belong to
the selection. A link with no mid-way point will follow the icons when the
selection moves. On the contrary, links with mid-way points must be selected to
enable the mid-way points to be moved too.

In some graphs, charts can be included in a selection but they cannot be
withdrawn afterwards.
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CENTER ICONS For graphic descriptions with containers: to center or re-center the icons in a
container, double-click inside the container (but not on an icon) and use the
options offered by the dialog box that opens.

FONTS The fonts available during the use of a graphic description are those fonts
available with wiNDOwWS on a specific workstation. In some cases, fonts exist on
one workstation, but not on another.

EXAMPLE: When a graphic description is downloaded and the font of a
component is not found on the current workstation, there is no font
selected in the font list box. In this case, you have the following
commands:

» Do not select a font. wiINDOWS will select a default font for the display
of the graphic description on the current workstation.

=  Select a font. The graphic description will be displayed on the current
workstation using the selected font. All other workstations will also
display the graphic description using the font selected (if it exists on
the workstation).
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Update Link/X-Ref.

NOTE

The Update Link/X-Ref. command of the References menu allows you to
translate each link between two matched icons into a cross-reference between
their referenced occurrences in the Specifications Database.

This command only applies to matched components of the graphic description.

Make sure you have saved your graphic description
(Save in the File menu)

If the Updating Link/X-References application detects a host disconnection,
it automatically switches to local connection. To connect to the host again,
select Host Connection in the Host-Access menu in the WorkStation
Manager.

Example of Update Link/X-Reference

If you match Iconl with occurrence OCC1, and Icon2 with occurrence OCC2,
and then link both icons, you automatically create a cross-reference between
OCC1 and OCC2 in the Specifications Database.

This type of cross-reference (secondary X-Ref) should not be confused with the
cross-reference - automatically created via Save - between the occurrence
described by the graph and each occurrence referenced to an icon or
occurrence-bearing link drawn in the graph (primary X-Ref).

Both types of X-Refs are assigned labels in the Specifications Database. These
labels are originally built from the names of icons (or links) matched with host
target occurrences.

A source occurrence refers to an occurrence from which the cross-reference
originates. Source occurrences are listed in the left-hand container of the
update report (see below for complete information). A target occurrence refers
to an occurrence to which the cross-reference is directed.

The direction of the link in the graph cannot be considered as an indicator of
which occurrence is the source or target occurrence. See the corresponding
Entity dialog box or the online help for more details on the cross-references for
each entity.

DSREF000254A



Graphic Decription Window 10-25

Special case of occurrence-bearing links:

The cross-reference created for an occurrence-bearing link is double: it involves
two secondary X-Refs.

EXAMPLE: If you match Iconl with occurrence OCC1, and lcon2 with
occurrence OCC2, and if you link both icons with a link matched with
occurrence LINKO, you automatically cross-reference OCC1 to LINKO and
OCC2 to LINKO in the Specifications Database.

Whatever the direction of the link, occurrences referenced to icons are
considered as source occurrences (OCC1 and OCC2 in the preceding
example).

NOTE An occurrence-bearing link involves two secondary X-Refs when it is a 1-way
link. A 2-way link (for instance, Send/Receive type) actually involves four
secondary X-Refs, reflected by four cross-references in the Specifications
Database.

Update report

The Update Link/X-Ref. command first opens a dialog box which asks whether
you want to ignore the missing links in the Graph. The choice YES opens up a
blank Update Report dialog box with the following message Update in
Progress . It means that the graphic description links between matched icons
are being compared to cross-references existing in the Specifications Database.

When the Link Analysis is completed, an Update Report appears summarizing
the status of each link in the graphic description compared to the Specifications
Database.

* If a link has not yet been translated into a cross-references in the
Specifications Database, it is automatically created. In this case, the report
message is Update Performed

* For each link which have already been translated into a cross-reference in
the Specifications Database, there is no update and the report message is
No Update, already existing X-Ref

Two preliminary checks are performed before this Update Report is displayed.

@ The second preliminary check is not performed if you chose to ignore the

missing links in the links (see the Second Preliminary Check paragraph
below).
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First Preliminary Check: Labels of Secondary X-Refs

The Update Link/X-Reference operation will first check whether names
assigned to icons (or occurrence-bearing links) matched with target
occurrences are identical to the labels of the corresponding secondary X-Refs
in the Specifications Database.

For each discrepancy detected, a dialog box will ask you if you wish to change
the label of the secondary X-Ref in the Specifications Database to the icon or
link name found in the graphic description:

* If you say YES, the corresponding Update Report message will be Update
Performed

* If you answer NO, the message will be No Update, Update not Requested
Second Preliminary Check: Existence of Additional Secondary X-Refs

% This check is not performed if you chose to ignore the missing links in the
graph (see the “Update Report” paragraph above).

If you chose not to ignore these missing links, the Update Link/X-Reference
operation then checks whether source occurrences have other cross-references
in the Specifications Database through the same secondary X-Ref.

If other cross-references of the same type are found, a dialog box prompts you
to:

* Delete these additional cross-references from the Specifications Database.
The corresponding Update Report message will be X-Ref Deleted

* Ignore the suggested deletion. The corresponding Update Report message
will be Missing X-Ref in the Graph . However, you may choose to translate
these additional cross-references by drawing the relevant links and icons
onto your graphic description

You may use the Print button to produce a printed copy of all messages issued
by the Update Link/X-Reference operation.

If you click Quit, you exit without accessing the system menu.
We recommend that you activate the Update Names command after selecting

the Update Link/X-Reference in order to ensure overall consistency between
your graphic description and the Host Specifications Database.
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Updating Names

NOTE

The purpose of this operation is to replace, where necessary, the local icon or
link name, any attributes which are positioned and the primary cross-reference
label by the name of the occurrence which references the icon or the link.

We recommend that you activate the Update Names command after selecting
the Update Link/X-Reference in order to ensure overall consistency between
your graphic description and the Host Specifications Database.

Make sure you have saved your graphic description
(Save in the File menu)

This command only applies to matched components of the graphic description.

Select the components you wish to update (all components will be updated by
default).

Use the Update Names command in the References menu to check that:

* lcon (or link) names in a graphic description are identical to the names of
host occurrences with which they are matched

e Labels of primary cross-references found in the Host Specifications
Database are identical to the names of the matched occurrences. This check
is performed for all the components of the graphic description (including
those which you have not selected)

For complete details on primary cross-references, see subchapter “Updating
Link/X-References”.

* Attributes of the host occurrence are identical to the attributes used by the
icon or the link in the graphic description

For each icon with at least one inconsistency, a dialog box asks you if you want
to replace the local value displayed in the graphic description with the host
value. If you check the box, the local value will be replaced by the host value.
On the other hand, if you clear it, the local value will not change.

Update Names operations are summarized in the final Update Report where all
your answers are listed.

If the Update Names application has detected a host disconnection, it
automatically switches to local connection. To connect to the host again,
select Host Connection in the Host-Access menu in the WorkStation
Manager.
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Validation of a Graphic Description

EXAMPLES :

The validation of a graphic description allows you to check whether the relations
between the entities of the graph are consistent with the metamodel.

The number of links attached to each icon of the graphic description must be
between the minimum/maximum numbers of links described in the metamodel
(called respectively minimum/maximum meta-cardinality). It is validated against
a list of possible values: (0,1), (0O,n), (1,1), (1,n), or of type x,y, with x and y
variable from 0 to n where x[7]y and y[ O.

For example, the cardinality of an Object/Relationship relationship in a
CDM, according to the MERISE methodology, is (1,n). The cardinality of a
Relationship/Object relationship is (2,n), a Relationship being related to a
minimum of 2 Objects and a maximum of n Objects.

A Validation Report is displayed and you may choose whether or not to correct
the errors notified.

ENT OCCURR ENT OCCURR EFF MIN MAX ERROR MESSAGE

REL COREL1 OBJ 1 2 n NOT ENOUGH RELATIONSHIPS
REL entity on which error is found
COREL1 code of occurrence on which error is found
OBJ entity linked to occurrence REL COREL1
1 cardinality found in graphic description (EFF)
2andn minimum (MIN) & maximum (MAX) cardinalities

shown in corresponding sub-schema

ENT OCCURR ENT OCCURR EFF MIN MAX ERROR MESSAGE

REL CDREL1 0BJ cCDOBJ1 7 2 n INCORRECT CARDINALITIES
REL entity for which link is invalid
CDREL1 occurrence code for which link is invalid
OBJ entity linked to occurrence REL COREL1
coosJl occurrence code linked to occurrence REL COREL1
7 cardinality found in graphic description
2andn minimum (MIN) & maximum (MAX) cardinalities

shown in corresponding sub-schema

If you click on the Show errors on graph button, errors will be shown in red
once you have closed the Validation Report window.

If you click on a line, the corresponding error will be shown in red once you
have closed the Validation Report window.
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NOTE To stop displaying errors, choose Validate again, then close the report without
clicking on the Display button.
To print the report, click on Print .
To close the dialog box without displaying the System menu, click on Quit.

For complete information on cardinalities, see the online help.
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Auxiliary Dialog Boxes

The Preferences Box

When you access the Preferences dialog box from a graphic description, you
set the parameters for all graphic descriptions of the entity you are working
on. The Preferences dialog box is in this case entitled Preferences for entity
name.

When you access the Preferences dialog box from the WorkStation Manager
window, you set the parameters for all graphic descriptions of all entities
The Preferences dialog box is in this case entitled Preferences for all entities

Preferences for: All Entities | %]
Color

Print
Flain Monochrome

-] R

Selected Icon

Matched Icon Green 128 - - -
lcon Name

rFormat
lcon Name Size I 0 [ Bold
Icon Code 1 ;
Link Name [ halic
Comment [ Underline
Heading

-Option
Link Box displa: vl Manual j Bestore

Delete intermediate points

Grid
Center lcon in mesh

COLORS

Select an item from the list box:
Icon
Selected Icon
Matched Icon

Then assign it another color by selecting the desired color on the color bar. To
create colors other than those shown on the bar, select the nearest color to that
required, then use the Red/Green/Blue scroll bars to "mix" or "tone" one of
these three colors.

The Color area indicates the color given to the selected item.
The Monochrome area (you can click in this area as for the color bar) indicates
the nearest color to the customized color you have created. Very small items

are displayed in this color, rather than the color indicated in the Color area.

The Print area indicates the color used for printing (or on a monochrome
screen display).
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FORMATS

Select an item from the list box:
Ilcon Name
Icon Code
Link Name

Then assign it a format (Font, Size, Bold/Italic/Underline ) by selecting the
desired values. These formats (except the Heading) can be changed via the

Style menu.
OPTIONS
Select an option from the List section, then choose a value from the combo box
to the right:
Link Box display Automatic

Manual

This option gives you the option of automatically displaying the Link
dialog box each time a link is created. This option can also be specified
via Link in the Style menu.

Delete mid-way points No
Yes

If you check this box, the mid-way points of a link will be deleted when
the link is automatically redrawn, that is:

— when you move the source or target icon of the link

— when you change the type of the link (straight <-> pipe)

This option does not affect the links as long as you do not perform any of
the manipulations described above. If this option is selected, you can
continue to create links with mid-way points.

Grid Show
Hide
This option can also be set via Grid in the Style menu.
Center Icon in mesh No
Yes

This option can also be specified via Grid in the Style menu.

Print Heading No
Yes

The heading consists of the name of the entity: the title, code and date of
creation of the graphic description, and the current date and the
coordinates of the graph (line, column).

If you select Yes, the format of the heading can be changed in this dialog
box in the Format section. This option can also be set via Options in the
Print menu.

Print Frame No
Yes

This option can also be set via Options in the Print menu.

Print Comments No
Yes

This option can also be set via Options in the Print menu.
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Icon - shadow With
Without

Display confirmation messages No
Yes

This option allows you to display the confirmation messages which
appear when you choose Save or Restore in the File menu or when you
delete a container.

Icon - shadow (x-axis) 0
10
20

80
If you have chosen With for the Icon - shadow option, this option allows
you to select the x-axis position of the shadow in relation to the icon.

Icon - shadow (y-axis) 0
10
20

80
If you have chosen With for the Icon - shadow option, this option allows
you to select the y-axis position of the shadow in relation to the icon.

Link line mode Pipe
Curve
Straight

This option can also be specified via Link in the Style menu or in the Link
dialog box.

Align Link Name Center
Left
Right
This option can also be specified via the Link dialog box.
Link thickness 0
1
9

This option can also be specified via Link in the Style menu or in the Link
dialog box.

Link line type Line
Dot
Dash
Dash-Dot
Dash-Dot-Dot

Some of these commands can also be specified via Link in the Style
menu or in the Link dialog box.

Mesh number 1
10
99
This option can also be specified via Grid in the Style menu.
Icon outline thickness 0
1
9
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This option can also be specified via Icon in the Style menu.

Column outline thickness 0
1
9
Comments frame thickness 0
1
9

This option can also be specified via the Comments dialog box.

Icon minimum size 0
10
30
50
70
90
Number of pages to print by line 0
1
2
6
This option can also be specified via Page Layout in the Print menu.
Window format A4-210x297mm
Executive (US)
Legal (US)
Letter (US)
Station-8.0.1

This option allows you to specify the window format. These formats
correspond to commonly used printed pages. When you choose one of
these commands, icon positions are recalculated. To avoid any distortion,
icon dimensions are not changed: however, icons which are close
together may overlap. The graphic description printed will be the same as
the description displayed on the screen.

The 8.0.1-WorkStation option exists for graphic descriptions created with
the 8.0.1 release. Once all modifications have been made on these
descriptions, you can open them in 8.0.2 Release and choose a new
format (see subchapter “Graphic Descriptions Created Prior to 8.0.2
Release”).

Displayed label Opaque
Transparent

Displayed labels are names and codes of icons and links displayed on
the screen. Opaque means that the label will be clearly displayed (if
necessary, parts of other icons and links are erased). Transparent
means that the label can be covered by other icons and links.

Printed label Opaque
Transparent

Printed labels are names and codes of icons and links printed in a
graphic description. Opague means that the label will be clearly printed
(if necessary, parts of other icons and links are erased). Transparent
means that the label can be covered by other icons and links.

Label clipping No

Yes
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When this option is set to Yes, the label of an icon does not overlap the
icon border.

Printed label clipping No
Yes

When this option is set to Yes, the printed label of an icon does not
overlap the icon border.

Icon Box display Automatic
Manual

This option allows the Icon dialog box to be displayed automatically each
time an icon is created. This option can also be specified via Icon in the
Style menu.

Align Comments Center
Right
Left

This option can also be specified in the Comments dialog box.

Align Icon Name Center
Right
Left

This option can also be specified in the Icon dialog box.

Comments with frame No
Yes

This option can also be specified in the Comments dialog box.

Display of Selected Field As is
Icons and links
Icons only

The "Icons and links" option extends the selected field to the largest
rectangle including all the selected icons and the links connecting these
icons. The extended field can include icons which are not selected but
these icons will not be taken into account during a later manipulation
(move...).

The "lcons only" option reduces the selected field to the largest rectangle
including all the selected icons.

The "As is" default option displays the selected field without any
extension or reduction.
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APPLY TO GRAPH and APPLY TO COMPONENTS

The Apply to graph command is available when you access the Preferences
dialog box via a graphic description.

The Apply to components command is available when you access the
Preferences dialog box via a graphic description and you check Apply to graph.

The options set in the Preferences dialog box are distributed at the graph level
and at the graph components (icons, links, comments) level.

* Apply to graph re-initializes the options set at the graph level
* Apply to components re-initializes the options set at the components level

CAUTION These two commands override options which may have been re-defined via
the Style menu commands or via lcon/Link/Comment dialog boxes. To avoid
this, rather than use these two commands, we recommend that you adjust
options for a given type of graph once only in draft (and not modify them too
often subsequently). Then if you want to modify:

* Options for a specific graph: we recommend that you use the Style menu
commands or the Icon/Link/Comment dialog boxes

* Options for all graphs: we recommend that you close the current graph, then
open it again. The options set in the Preferences dialog box will be
automatically taken into account. Proceed in the same way for each graph
you wish to modify.

RESTORE

Select this button to restore the most recently saved values in this Preferences
dialog box.

STANDARD

When you access the Preferences dialog box via the WorkStation
Manager window , this button allows you to set the values in this Preferences
dialog box to the original default values set for the WorkStation.

When you access the Preferences dialog box via a graphic description ,
this button allows you to set the values in this Preferences dialog box to the
values set in the Preferences dialog box accessed via the WorkStation Manager
window.

OK

Click this button to save changes made in the Preferences dialog box and
return to the current graph.

CANCEL

Click this button to return to the current graph without saving changes made in
the Preferences dialog box.
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=] Default Icon Style
Align Name
C Left
@ [Center
O Right
Outline thickness: 0

Code format...

Name format...

" Automatic Icon Box display

[ Existing Icons

OK Cancel

Align name

Select the alignment of the icon name.

Outline thickness

Select the thickness of the icon outline (0 = thinnest, 9 = thickest).

Code format
Name format

These buttons open dialog boxes in which you select the font, size and
presentation of the icon code/name.

Automatic Icon Dialog Box display

Check this box to display an Icon dialog box each time you place an icon in
the graph. For complete information, refer to "The Icon Dialog Box".

Existing Icons

Check this box to apply the parameters present in this dialog box to the
existing icons. Otherwise, the options set in these dialog boxes will apply
only to icons placed in the graph after the dialog box is closed.

OK

Applies changes and closes the dialog box.

Cancel

Cancels changes and closes the dialog box.
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The Default Link Style Dialog Box

=] Default Link Style
Type
C Straight
e Thickness : IU ¥
@ Pipe —
. . A *
O Curve Lie: Rl -
" Existing Links

Mame format...

" Automatic Link Box display

[ Delete intermediate Points

OK Cancel

Type

Straight/Pipe/Curved

Select the link draw mode.

Thickness

Select the thickness of the link (0 = thinnest, 9 = thickest).

Line

Select the line type:
- line

- dash

- dot

- dash-dot

- dash-dot-dot

Existing Links

Check this box to apply the parameters present in the dialog box to the
existing links. Otherwise, the options set in this section of the dialog box
will only apply to links placed in the graph after the dialog box is closed.

Name Format

This button opens a dialog box in which you select the font, size and
presentation of the link name.

Automatic Link Box display

Check this box to display the Link dialog box automatically each time you
create a link between two components in the graph. For complete
information, refer to "The Link Dialog Box".
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Delete mid-way points

If you check this box, the mid-way points of a link will be deleted when the
link is automatically redrawn, that is:

=  When you move the source or target icon of the link

= When you change the type of the link (straight <-> pipe)
This option does not affect the links as long as you do not perform any of the
manipulations described above. If this option is selected, you can continue to
create links with mid-way points.

OK
Applies changes and closes the dialog box.

Cancel

Cancels changes and closes the dialog box.
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The Default Comment Style Dialog Box

‘=-| Default Comment Style

Align Texte
C Left

O Right

[ Frame
Thickness: 0

" Existing Comments

Format...
OK Cancel
Align Text
Left/Center/Right

Select the alignment of the text.
Frame
Check this box to place a frame around the comment.
Frame thickness

This command is active once the Frame check box is checked. Select the
thickness of the frame around the comment (0 = thinnest, 9 = thickest).

Existing Comments
Check this box to apply the parameters set in the dialog box to the existing
comments. Otherwise, the options set in this section of the dialog box will
apply only to comments placed in the graph after the dialog box is closed.

Format

This button opens a dialog box in which you select the font, size and
presentation of the comments.

OK
Applies changes and closes the dialog box.
Cancel

Cancels changes and closes the dialog box.
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When you double-click on an icon, a dialog box opens where you set specific

parameters for the selected icon.

To automatically display the lcon box when you draw an icon and a link, choose
Icon in the Style menu and check the Automatic Icon Box Display box.

‘ ‘

lcon

Code |

Name

Type

C Left

© Right

Card
Floppy-Disk
Tape (Attributes)
Disk (Attributes)

-Align Name—— Format

@ Center

Code...
Name...

Outline thickness: 0

Attributes...

OK

Cancel

Code

Specify or change the code of the icon. Icon codes are automatically

switched to uppercase characters.

If an icon has been matched with an occurrence, the code button is inactive
and you cannot modify the code unless you first delete that match
(References menu).

Name

Specify or change the icon name.

It is possible to load the code and the name of an entity occurrence in a Graphic
Description from the host list, the Definition window or from the Formatted
Description window of the same entity by using drag-and-drop. Follow these

steps:

* Simultaneously open the description of an entity and the Definition window
or the Formatted Description window or the host list.

* Select the occurence code in the source window by clicking the left mouse
button (the occurrence name is automatically selected), then move the
mouse to the Graphic Description window, keeping the button pressed.
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* Release the mouse button on the icon or link to be entered. The code and
the name in a graphical description appear simultaneously on the icon or on
the link.

Type
Select the icon type. Icon types are also listed in the Draw menu. When an
icon is not linked to another icon, all icon types are listed. In some cases,
when an icon is linked to another icon, only those types compatible with the
linked icon are listed.
Example:
In the graphic description of a Conceptual Process Model (c.p.M.), the
Operation icon (when not linked) may be one of the following types: Operation
or Synchronized Operation. As long as this icon is not linked, its type can be
changed (Operation/Synchronized Operation). However, if a link is drawn from
the Synchronized Operation icon to an Event/Result icon, the icon type can be
changed.
Align Name
Select the alignment of the icon name.
Format

Select the Code/Name button to open the dialog box in which you change
the format (font, size, presentation) of the code/name.

Outline Thickness
Select the thickness of the icon outline (0 = thinnest, 9 = thickest).
Attributes
This button can be activated only if the methodology which is used provides
attributes for the selected icon. Select this button to open the dialog box in
which you change the attributes for the selected icon.
For complete details of attributes according to entities, see the online help.
OK
Applies changes to the icon and closes the dialog box.

Cancel

Cancels changes and closes the dialog box.
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The Link Dialog Box

When you double-click on a link (its hame/code/attribute or its handle) or on a
free line (its name or its handle) in a graphic description, a dialog box opens
where you set specific parameters for the selected link.

To automatically display the Link dialog box when you draw a link or a free line,

select the Link command in the Style menu and check the Automatic Link Box
Display check box.

=] Link
ﬂamel
-Align Name Type
® Left C Straight
C! Center ® Pipe
C Right C Curve
Ling: | Line B
Thickness: IU ¥
Uses [Line)
Uses [Arrow)
>

& Default graphics

Attributes...

oK Cancel

Code (only for an entity-bearing link).
Specify or change the link code.

Name

Specify or change the link name.
NOTE: It is possible to load the code and the name of an entity occurrence for
entity-bearing links in a Graphic Description window from the host

occurrence list of the same entity using drag-and-drop. For complete
information, refer to subchapter “Functionalities”.
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Align Name

Select the alignment of the link name.

Type

Select the type of link. A link can be:
= astraight line
* apiped line

= acurved line
Line

The link lines can be made up of the following:
= line

= dash

= dot

= dash-dot

» dash-dot-dot

NOTE Line types "dot" and "dash" can only be used if the thickness of the link is 0.
Thickness
Select the thickness of the link (0 = thinnest, 9 = thickest).
List box
The untitled list contains links that correspond to the methodology in use.

Examples:

+ In the graphic description of a MERISE Organization Chart (MOE), a link
between two Organizational Units is a simple line by default. Double-
click on the handle (small square) of the link to open the Link dialog
box. The simple line is indicated by Responsible (Line). If you decide
to change the link into a 1-way arrow, select Responsible (Arrow). For
a 2-way arrow, select <->.

+ In the graphic description of a Process Flow (SEP), a link between a
Process and an Event/Result is a 1-way arrow by default. Double-click
on the handle (small square) of the link to open the Link dialog box.
The 1-way arrow line is indicated by Send. If you decide to change the
link into a 2-way arrow, select Send-Receive. The link in the other
direction between an Event/Result and a Process is also by default a
1-way arrow indicated by Receive. To change the link, select Send-
Receive.
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Default Graphics

This check box allows you to select default graphics for the link ends. In the
list, select a graphics type and check the box. The graphics type will be
assigned to the links you subsequently create.

The set of available graphics types varies according to the linked icons (for
example, in the Batch Flow Chart of MERISE methodology, the link between
the "Program” and "Report" icons is different from the link between the
"Program" and "File/DB" icons). For each graph, one or more series of
available links have been preset according to the icons they can link. You
can define a default graphics type for each series of links. Refer to the
documentation for your methodology for more details about the series of
available links for each graph.

Attributes

This button can be activated only if the methodology which is used provides
attributes for the selected icon. Select this button to open the dialog box in
which you change the attributes for the given link.

For complete details of attributes according to entities, see the online help.

OK

Applies changes to the link and closes the dialog box.

Cancel

Cancels changes and closes the dialog box.
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The Comment Dialog Box

When you double-click on a comment in a graphic description, a dialog box
opens where you set specific parameters for the selected comment.

‘=-| Comment

[+

Align Text

O Left
® Center
C Right

[ Frame

Thickness: 0

Format...

oK | Cancel

Enter the text of your comment in the space provided in this dialog box (use
CRTL+ENTER to go to the next line). This text is limited to 234 characters
(CRTL+ENTER = 2 characters). The initial size of a comment in the graph is one
mesh of the grid (see "The Grid Layout Dialog Box").

A comment containing no character string is automatically deleted (blank
characters are considered as characters, therefore make sure the blank
characters are deleted if you wish to delete the comment).

Align Text

Left/Center/Right

Select the alignment of the text.

Frame

Check this box to place a frame around the comments.

Frame thickness

This command is active once the Frame check box is checked. Select the
thickness of the comments frame (0 = thinnest, 9 = thickest).
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Format

This button opens a dialog box in which you select the font, size and
presentation of the comments.

OK
Applies changes to the comment and closes the dialog box.
Cancel

Cancels changes and closes the dialog box.
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The Grid Layout Dialog Box

® Show

Grid Layout

C Without grid

Characteristics

[T Center Icon in mesh

|?EI
Cancel
|20 Mesh number

OK Icon size

Standard size

[T Adjust Icon size

NOTE ON ICON SIZE

With grid

When you click this button, you can perform the following operations:

* Characteristics

- Show
You may choose whether or not to show the grid in the graphic
description. Keep in mind that the With Grid option may be active
even if the grid is not shown.

- Center icons in mesh
This command centers new or existing icons within the mesh of the
grid.

- Mesh number
The Mesh number represents the grid (from 1 to 99).

Without grid
If you select this button, you can perform the following operations:

Icon size
= Standard size

Enter a value from 1 to 98. (See note below.)
Adjust Icon size
This option adjusts all icons to the size defined in the standard size.

If With grid is active (whether the grid is displayed or not), the standard size of
an icon adjusts to the size of a grid mesh.

With or without a grid, an icon size is expressed by a number "n" (from 1 to 98)
where "n = 99 - s", "s" being the number of containers (= number of rows).
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See the following examples:

1. The grid is made up of 20 columns.
STANDARD ICON SIZE =99 -20 =79

2. Likewise, with a standard icon size of 59:
NUMBER OF COLUMNS =99 - 59 =40

A - -
& -

A -

Excerpt from a 20-mesh grid Excerpt from a 40-mesh grid
The icon size is 79 The icon size is 59
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The Container Dialog Box

To access this dialog box, double-click on a container.

= Container

Current |EI

Current |EI

| Cancel

Center icons

10-49

Re-centers the icons in the container. If several icons were originally
positioned on the same line, they will overlap. See also subchapter “Drawing

Hints”.

Width

A drop-down list offers several options (the options vary according to how
many containers are present in the chart of containers, which container you
select and whether or not the container has already been modified):

Current
First

Previous

Next

Last

Standard

All

Keeps the same width for the selected container.

Sets the width of the selected container to the width of
the first container in the chart.

Sets the width of the selected container to the width of
the container immediately to its left.

Sets the width of the selected container to the width of
the container immediately to its right.

Sets the width of the selected container to the width of
the last container in the chart.

Sets the width of the selected container to the standard
width (can vary between containers).

Sets the width of all containers to the width of the
selected container.
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Height

A drop-down list offers several options (the options vary according to how
many containers are present in the chart of containers, which container you
select and whether or not the container has already been modified):

Current Keeps the same height for the selected container.

First Sets the height of the selected container to the height of
the first container in the chart.

Previous Sets the height of the selected container to the height of
the container immediately to its left.

Next Sets the height of the selected container to the height of
the container immediately to its right.

Last Sets the height of the selected container to the height of
the last container in the chart.

All Sets the height of all containers to the height of the
selected container.

OK
Applies changes and closes the dialog box.
Cancel

Cancels changes and closes the dialog box.
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Graphic Descriptions Created Prior to the 8.0.2 Release

When you access a graphic description created before the 8.0.2 WorkStation
Release, it may cause messages to be displayed:

e "Graph created with previous release. Do you want it updated
automatically?"

= This message will appear in the following cases:
— The graphics of a link are no longer compatible with the methodology
implemented with the 8.0.2 WorkStation Release.
EXAMPLE : 2-way links between Objects and Relationships which
were OK are now 1-way links with the 8.0.2 Release
— A link direction is no longer compatible with the methodology
implemented with the 8.0.2 WorkStation Release.

= If you answer YES to the prompt, links are re-displayed using their default
graphics

If you answer NO to the prompt, the graphic description will not be displayed.

The next two messages appear because the style and size of the fonts
implemented with previous versions are not compatible with those of wiNDOWS:

* "Choose: Printer - in order to keep a printed document comparable to the
preceding version."

= This message does not appear if there are no printers connected

= When you select the Printer button, the way documents are displayed on
the screen may change

* "Choose: Screen - in order to keep a displayed document comparable to the
preceding version."

= When you select the Screen button, the printed document may change

IMPORTANT: In some cases, if you select the Printer button, the document
displayed on the screen is better than the result obtained using
the Screen button.

In order to view the differences between screen displays, test one display
(select one button), observe the document displayed or printed and then exit the
graphic description without saving it . Test the other display (select the other
button), observe the document displayed or printed and decide which you
prefer. Saving the graphic description saves the current display

The following message will appear when a link between two icons is no longer
compatible with the methodology implemented with the 8.0.2 WorkStation
Release.

"The links in red are invalid and will be ignored!"

As a result, invalid links are automatically erased.
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LIST OF CHECKS PERFORMED

EXAMPLE!

Links in each graphic description are analyzed in order to check that they are
compatible with the methodology in use. If they are not, their validity is tested
(the source icon becomes the target icon and vice-versa). If the new link is valid
for the methodology, it automatically replaces the initial link. If it is not valid for
the methodology, it is displayed in red after retrieval, and then deleted.

(MERISE) 2-way links between two phases are invalid and therefore deleted.
1-way links between Reports and Programs are replaced by 1-way links
between Programs and Reports (the arrow is reversed).

Links between a comment and an icon are now represented in the same way:
an arrow pointing to the target icon. When you retrieve graphic descriptions
from earlier releases, such links are checked and re-drawn accordingly.

ATTRIBUTE DISPLAY

It is possible to display and update attributes associated with icons or links in a
graph, even if the graph was created before implementation of this functionality
in the WorkStation.

During the first display operation under the new WorkStation release, attributes
are not displayed because they are not initialized. Choose Update names in
the References menu to initialize attributes.

GRAPH CONSULTATION

A graph which is retrieved under the new WorkStation release cannot
subsequently be displayed using a previous WorkStation release. Downloading
a graph from a previous release for consultation on a new WorkStation release
does not have the same disadvantages: if the links in the graph are modified or
deleted via the retrieval functions, modification is only visual. The graphic
description remains unchanged on the host and fully compatible with the
WorkStation release where it originated.

NOTE: a graph downloaded for consultation can NOT be updated.
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NOTE:

NOTE.
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Textual descriptions concern occurrences of the Text Entity defined in the
Specifications Database and local drafts.

For a description of the Text Entity, refer to the on-line help.
For local drafts, refer to chapter “The Local List Window”.

As on the standard host system, a text has a two-tier structure: a Table of
Sections where up to 250 sections can be specified, and the sections
themselves.

A WorkStation section is equivalent to a paragraph in the standard host system
terminology.

The Textual Description is composed of two windows: the Table of Sections
window and the Section window.

The Table of Sections window allows you to:
Create, duplicate and delete Sections
Hyper-navigate
Open Sections
Modify the title and code of Sections
Assign text to other occurrences defined in the Specifications
Database
Print all or selected Sections
Define customized page headers
Set the various style options which characterize Paragraph Formats
Install Spell Checkers
Access the online help

In the Section window, standard word-processing features are available. The
following options are available through menu commands or keyboard
commands:

Word Wrap

Text entry without justification (useful for charts)

Various paragraph styles and indentations (called formats)

Style, size and font selections

Copy/Cut/Paste/Concatenate/Delete character strings

Search/Replace character strings

Section save and restore on the PC hard disk

Print preview

Print the current Section or specific pages

Online Help

Cross-reference Text occurrence to a Data Element

Spell Checker
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Getting to the Windows
Since actual text processing is done locally, a host connection is only required
for:
= Downloading a Text from the host
= Uploading a Text to the Specifications Database after its local update
The Table of Sections window opens up each time you access a Textual

description. It displays the list of text sections: code (internal paragraph code)
and title.

Double-click on a Section title to open the Section window which displays the
contents of the selected Section.

The background color of the Section window can be changed in the wWiINDOWS
configuration panel.
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The Menu Bar of the Table of Sections Window

Entity

Section

Print

Preferences

?=F1

System Menu

This Cascaded menu contains commands that allow you to access the
definition, lists, descriptions and cross-references of the current occurrence of
the Text entity.

This menu features commands which allow you to create, create from, open,
duplicate, move, delete and modify section(s). It is also used to assign Text
sections to occurrence(s) for documentation purposes.

This menu contains commands that allow you to print all of the text or selected
section(s) and to set print options and printers.

This menu contains commands that bring up dialog boxes in which you set the
default style options and install Spell Checkers.

This command calls the online help.

In addition to standard commands, this menu contains a command to consult
the current context.

For more information about the context, refer to chapter “WorkStation
Connection”, subchapter “Context”.
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The Entity Menu

Entity

The Section Menu

Section

Create...

Create from...

Main Entity =>» Definition
Lists =>» Available lists
Descriptions => Available descriptions
X-References => Available x-references

Other Occurrence...
Related Entity...

For complete details of this menu, refer to chapter “Navigation in the
WorkStation”, subchapter “The Cascaded Entity Menu”.

Create...
Create from...
Open

Duplicate

Move
Delete
Modify...

Assign...

This command opens a dialog box in which you enter the code and title (limited
to 60 characters) and code of the new section. The new section will be inserted
immediately after the Section line selected in the Table of Sections window. If
no line is selected when you choose this command, the new section will be
added at the end of the Table of Sections. The section code is automatically
assigned (in alphabetical order), but you may modify it before clicking oK. You
may move the section within the list of the Sections window using Move (see
below).

Select =+ TOP OF TABLE *++ before you select Create in order to place a section
at the beginning of the Text occurrence.

The default options set via the Style... command in the Preferences menu
apply to sections created with the Create... command.

This command opens the Create from... dialog box. For complete details, see
subchapter “Auxiliary Dialog Boxes”.

The default options set via Style... in the Preferences menu apply to sections
created with the Create from... command.
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Open

NOTE:

Duplicate

NOTE:

Move

NOTE:

Delete

Modify...

Assign...

NOTE:

VisualAge Pacbase WorkStation Reference Manual

This command opens the Section window and displays the selected section.
The Table of Sections window is reduced to an icon.

Several sections can be opened simultaneously. Click on the sections while
pressing CTRL to select a block of sections. Click on the sections while pressing
SHIFT to select sections that do not follow each other in the list. Then select
Open (or ENTER).

After selecting the section to be duplicated, use this command to duplicate the
section. Select the location (the title line which will precede the duplicated
section) and press ENTER.

ESC or the right mouse button cancel the command.

After selecting the section to be moved within the table, use this command to
move the section. Select the location (the section which will precede the moved
section) and press ENTER.

ESC or the right mouse button cancel the command. This command is grayed
when the Table of Sections contains only one section.

This command deletes selected section(s) after a confirmation.

The deletion applies to the section title and to its contents.

This command opens a dialog box in which you modify the code and/or title and
of the section.

This command is used to assign a Text section to one or more occurrences in
the Specifications Database. Assigning creates a cross-reference between the
section and each specified occurrence. This type of cross-reference is
especially useful when creating application documentation via the
Report/Volume entity.

A dialog box opens up. It lists occurrences to which the section is already
assigned (if any).

In order to assign the selected section to an occurrence, enter the host or local
code of the entity and the occurrence code. Select Add to perform the text
assignment.

In order to delete a text assignment of an occurrence, click on that occurrence
in the list and then press Delete.

The Quit button closes this dialog box. Assignments become effective when
the Text occurrence is uploaded into the Specifications Database.

When a Text assigned to an occurrence is downloaded, the host code of this
entity is converted into a local code. However, a host code sometimes
corresponds to several local codes. A default local code is thus chosen (it
may vary according to the Module used). Therefore, in the list of
occurrences, some local codes can be different from those entered
originally. This does not prevent the assignment operation from working
correctly.
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The Print Menu

Print

Print All Text
Print Section(s)

Print All Text
Print Section(s)
Print Table of Sections

Print Options...
Printer...

Print Table of Sections

Print Options

Printer...

These commands print all of the text (all the Sections of the Text occurrence) or
specific Sections (the Sections that are selected in the Table of Sections
window) or the Table of Sections according to options set in the Print Options
dialog box.

If, for Print Section(s) in the Print Options dialog box, you have selected an
Absolute command for Pagination and the Page Number command for the
Header Style, the Absolute Pagination dialog box will prompt you to input the
number of the first page of the Section.

This command opens the Print Options dialog box. For complete details, refer
to subchapter “Auxiliary Dialog Boxes”.

This command opens up a dialog box listing the printers connected to the PC.
The Configure... button opens another dialog box that contains all parameters

associated with the printer driver (i.e. paper format and orientation, specific
characteristics, etc.)

The Preferences Menu

Preferences

Style...

Style...
Spell Checker installation...

Opens the Style dialog box in which you can specify a default presentation for
all the Sections of the Text.

For complete details, refer to subchapter “Auxiliary Dialog Boxes”.

Spell Checker installation...

The Help Menu

?=F1

This command opens the Spell Checker Installation dialog box. For complete
details, refer to subchapter “Auxiliary Dialog Boxes”.

This command calls the online help function.
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Section Contents

Section

A section is composed of text (strings of characters) in which all printable
characters, entered via the keyboard, can feature: lower and upper case
letters, numeric characters and some special characters (blank spaces,
punctuation, etc.).

The size of a section is free if you save the section locally. In this case, the size
of the section is only limited by the memory available for printing and by the disk
space available for the local save.

However, if you want to upload your Text on the host, the section cannot
exceed 998 lines, which is the maximum authorized by the host. You can check
the number of lines your section would occupy when uploaded on the host via
Host Validation in the File menu in the Section window. For complete
information, refer to the description of this command in subchapter “The Menu
Bar of the Section Window”.

Paragraph

The Text contained in a section is composed of paragraphs. The number of
paragraphs in a section is free up to the limit of the number of lines of the
section (see limit of lines above).

Each paragraph ends with a paragraph mark. The display of these marks is
optional (Paragraph mark command of Options menu ). A displayed
paragraph mark is indicated by . This can vary depending on the character
font used for the paragraph.

In most cases paragraphs are composed of words. A word is a character string
delimited at both extremities by one of the following characters ., ;:. ! ?2/+=""
* (), blank space or paragraph mark.

The size of a word is free if you print your Text locally only. However, on the
host, words exceeding 30 characters are truncated when the Text is processed
in justification by PDM. In the Section window, the Host Validation command
of the File menu allows you to check if the section contains words exceeding
this limit. For further information, refer to the description of this command in
subchapter “The Menu Bar of the Section Window”.

Text presentation attributes
The paragraphs and the text they contain are displayed, formatted and printed
according to specific parameters, called attributes. Some of these attributes

concern the characters. Other attributes, called style and format, concern only
a paragraph or a group of paragraphs with the same characteristics.
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Character attributes

These are the character font used, its size in points, and the bold, italic and
underline attributes.  The character attributes, although concerning the
characters, apply to the whole paragraph. Therefore, they can only be modified
for an entire paragraph (or for a group of consecutive paragraphs). In the
Section window, you can modify them via the Characters menu.

A default font and a default format can be selected in the Style Dialog Box
accessed in the Table of Sections window via Style in the Preferences menu.
These attributes will be used for the first paragraph of a new section, or for all
the contents of a Text created on the host, accessed locally for the first time,
and which contains no indication of the font to be used.

Paragraph margins

These are the left margin, the right margin and the indentation. The left margin
defines the space between the left border of the paragraph and the left limit of
the display or print space. The right margin defines the space between the right
border and the right limit. The indentation defines the space between the first
line of the paragraph and the other lines of the same paragraph.

The margins and the indentation are set by a number from 1 to 78. The space
between the left and the right margin and between the indentation and the right
margin must be at least 30.

In the Section window, you can modify the margins and the indentation of a
paragraph with the Ruler. However, this modification will concern all the
paragraphs of the section which have the same format as the modified
paragraph (see below "Paragraph formats").

Paragraph alignment

Paragraph format

Within the margins, the text of a paragraph is automatically set according to the
selected alignment. The paragraph alignment can be left, centered, right,
Jjustified.

In the Section window, you can modify the alignment for each paragraph of the
section, either via the Alignment command of the Paragraph menu, or via the
Ruler. This modification only concerns the selected paragraph(s).

Each paragraph of a section has a format. There are 10 formats, numbered 1
to 10. Format 10 is the default format (modifiable option). A format defines
three attributes: the left margin, the right margin and the indentation.

The attributes of a format can be different from one section to another within the
same Text. You can modify the definition of a format in a specific section,
without affecting the other sections.

To define the same format for all sections of an edited Text, click on Style in the
Preferences menu in the Table of Sections window. In the dialog box which
opens, enter the selected values for each format (in the Default Format area),
then click on Apply these formats . The same definition will be assigned to the
format of all sections in the updated Text.

At the WorkStation installation, the initialization values of the default formats are
as follows (the indentation is always the same as the left margin):
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format 1 6-78

format 2 8-78

format 3 10-78
format 4 12-78
format 5 14-78
format 6 16-78
format 7 18-78
format 8 20-78
format 9 22-78
format 10 4-78 (by defautt)

The default format values defined in this dialog box are applied when you:
= Create a new section
= Access locally for the first time a Text previously defined on the host.

For more details, refer to subchapter “Upload/Download”, Section
“Download”.

The type of a paragraph corresponds to how the paragraph will be used on the
host.

The Word Wrap type is used to enter the majority of the text in a section. The
format values are taken into account, and the contents of the paragraph are not
limited.

The No Word Wrap type can be used to enter information which must be
presented in form of charts, on the condition that a non proportional font be
used. The format values are not taken into account for printing.

The VisualAge Pacbase Line type exists for compatibility with previous versions
of VisualAge Pacbase (Y-, F-, and D-type lines). The content of this type of
paragraph are limited to 61 characters.

The Labeled Paragraph and Title types can be used at the same time and can
be combined with each of the three preceding styles.

All the types are described in detail in subchapter “The Menu Bar of the Section
Window”, Paragraph menu.

You can define a default presentation style for a particular paragraph type by
choosing a color and character attributes. In this way, all the paragraphs of this
type will have the same aspect (i.e. a specific color would improve the legibility
of the text on the screen).

You define a presentation style in the dialog box accessed via Style... in the
Preferences menu in the Section window.

The Style dialog box is described in subchapter “Auxiliary Dialog Boxes”.
In this dialog box, you choose the type of paragraph with which you want to

associate a presentation style. Then, you assign a color and character
attributes (bold, italic, underlined).
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Once the presentation style has been defined, the type characteristics will be
adopted by every paragraph to which you assign that particular type. For
example, if you defined a presentation style with the "bold" and "underlined"
attributes for the Title type, and if you wish to convert a paragraph from Word
Wrap type to Title type, this paragraph will automatically be assigned the "bold"
and "underlined"” attributes.

NOTE If you change the characteristics of an existing presentation style, the
paragraphs already using this style are not assigned the new characteristics.
Only the new paragraphs based on this style will take the new characteristics
into account.
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Text Editing in the Section Window

Cursor
The cursor is a blinking graphical element indicating the current position in the
text where the characters can be entered via the keyboard. In insert mode, the
cursor is represented by a vertical bar: in typeover mode, it is represented by a
highlighted rectangle covering a character.
NOTE The cursor is always present, but is not necessarily visible in the window: if you

have used the scroll bars, it can be located in a part of a text which is not
displayed in the window. If you move the cursor, enter characters via the
keyboard or select a command from the Edit menu, the display moves
automatically so that the cursor reappears.

The cursor must not be confused with the mouse pointer. The pointer is moved
by the mouse. Depending on its position in the window, it is displayed as an

arrow or as an insert pointer resembling an |. It can be used to position the
cursor in the text or to perform a selection.

Cursor positioning and moving

“@ Left button click Positions the cursor where you click

&SIV Moves cursor character by character (< / )
or
line by line (™ / V).

CTRL+—> (CTRL+<) Moves the cursor to the beginning of the next
(preceding) word.

TAB (SHIFT+TAB) Moves the cursor to the beginning of the next
(preceding) word.
In an empty paragraph, in no word wrap mode
(with a non-proportional font - “courier" or "system")
the tab key jumps to the position below the first
character of the  words in the previous line while
generating blanks.
R (END) Moves the cursor to the beginning (end) of the
line.
CTRL+K  (CTRL+END) Moves the cursor to the beginning (end) of the
paragraph.
PG-DN  (PG-UP) Moves the cursor to the beginning of the next

(preceding) display page.
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Selection

NOTE

How to Select

B

You can select a part of the text. The next Edit command will be performed on
this selected part. A selection can be restricted to several characters, one or
more words, or one or more paragraphs: it can also apply to the whole section.

The selected text is highlighted.

As for the cursor, a selection can exist in the text without being visible in the
displayed window. If you move the cursor, enter characters via the keyboard or
select a command from the Edit menu (concerning this selection), the display
will move, showing the selection.

To select a string of characters

Click (with the left mouse button) at one end of the string,
hold the mouse button down and move the pointer to the
other end of the string you want to select.

Release the button to end selection.

To select a word
Double-click on the word. If the word is followed by a
space, the space will be selected too.

To select a paragraph
Double-click on the left margin of the paragraph. The
paragraph mark will also be selected.

To extend or reduce a selected area (a selected string)
Press the sHIFT button, then click (with the left mouse
button) up to the point where you want the area to be
extended or reduced.
If necessary, move the pointer to adjust (extend or
reduce) the selection.
Release the sHIFT button to perform the selection.

SHIFT+& /> / N/ Selects the string of characters from the current cursor
position to the new position determined by the direction
arrow used.

SHIFT+CTRL+ > (SHIFT+CTRL+ &)
Selects the string of characters from the cursor position
to the beginning of the current word or the following
(preceding) word.

(SHIFT+END) Selects the string of characters from the cursor position
to the beginning (end) of the line.

(SHIFT+CTRL+END) Selects the string of characters from the cursor position
to the beginning (end) of the paragraph.

SHIFT+PG-DN (SHIFT+PG-UP)
Selects the string of characters from the cursor position
in the current display page to the same position in the
next (preceding) display page.
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How to Enter and Update Text

Text Organization in Paragraphs

To enter text.
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Position the cursor at the desired point and enter the text
via the keyboard. The text will be displayed and the
cursor will move automatically according to the input. In
insert mode, each character entered will be inserted at
the cursor position: in typeover mode, each character
will replace the character pointed by the cursor.

To delete one character.

Position the cursor at the desired point and press DELETE
to erase the character following the cursor, or BACKSPACE
to erase the character preceding the cursor.

To delete a string of characters:

Select the string to erase and press DELETE or
BACKSPACE.

To override (delete and replace) a string of characters:

Select the string to be replaced and enter the new text,
which automatically replaces the selection.

The word processor performs formatting of the text between print margins
according to the paragraph format defining these margins and the paragraph
style. The text is displayed with the selected font, font size, character attributes

(bold, italic,

underlined) and alignment (left, right, centered, justified).

Therefore, to change attributes (for example a different font) or to separate two
parts of a text with blank lines, create a new paragraph.

To create a new paragraph:

Position the cursor at the end of an existing paragraph
and press ENTER. The cursor is positioned at the
beginning of the new paragraph, which takes on the
characteristics of the preceding one.

To split an existing paragraph:

Position the cursor where you want the paragraph split
and press ENTER. The paragraph is divided into two
paragraphs with the same attributes, and the cursor is
positioned at the beginning of the second paragraph.

To merge (concatenate) two consecutive paragraphs:.

Position the cursor at the beginning of the second
paragraph and press BACKSPACE or position the cursor at
the end of the first paragraph and press DELETE. In both
cases, the paragraphs merge and the characteristics of
the second paragraph are automatically applied to the
first paragraph.
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Text editing via the clipboard

NOTE

NOTE

The clipboard is a communication zone between WorkStation windows which
allows you to export text from the Section window to other windows
(applications), or to import text from other applications. The clipboard contains
only the last selection copied to it. This information remains in the clipboard
until it is replaced. The basic manipulations are described below.

How to put a string of characters in the clipboard.
Select the string and select Cut (CTRL+X), Copy (CTRL+C)
or Concatenate (ctritsHirT+ins) from the Edit menu:

- Cut deletes the string from the Section window and
places it on the clipboard, replacing the contents of the
clipboard.

- Copy and Concatenate keep the string in the Section
window and copy it to the clipboard, either replacing the
contents of the clipboard (Copy) or adding the string to
the contents (Concatenate).

How to recover a string of characters from the clipboard:
Select Paste (CTRL+V) from the Edit menu. The text
contained in the clipboard will be inserted at the cursor
position, or will replace any selection.

If the clipboard contains information other than text (for example graphs), the
Paste and Concatenate commands are inactive. However, cut or copy
commands are active when a selection exists in the Section window. This
selection can be copied to the clipboard, whatever the type of information
contained in the clipboard.

In the Section window, the clipboard can be used to move text from one place
to another, or to duplicate text.

How to move text.
Select and Cut the text to be moved. Position the cursor
at the point where the duplicated text must appear, then
Paste the contents of the clipboard.

How to duplicate text.
Select and Copy the text to be duplicated. Position the
cursor at the point where the duplicated text is to appear,
then Paste the contents of the clipboard.

You can move or duplicate parts of text within a section or a Non-formatted
Description, from one section to another, from a section to a Non-formatted
Description, from a Non-formatted Description to a section, and from a Non-
formatted Description to another.

The text format attributes are memorized in the paragraph marks and apply to

all text in the paragraph. When you move or duplicate text containing

paragraph marks via the clipboard, remember the following points:

- each string in the clipboard which is not followed by a paragraph mark takes
the format attributes of the paragraph in which it is pasted

- when you paste text containing one or more paragraph mark(s) within a
paragraph, the beginning of the target paragraph takes the format attributes
of the first mark in the pasted paragraph.
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How to move (duplicate) text without format information:
Select the text only (without its paragraph mark) and cut
(or paste) it. When you paste it into a paragraph, the text
takes the format information of this paragraph.

How to move (duplicate) text with format information:
Select the text with its paragraph mark and cut (or paste)
it. When you paste it into a paragraph, the text keeps the
format information of its paragraph mark.

Information exchange with other applications via the clipboard

You can use the clipboard to import text into the Section window from another
word processor, running in the same environment as the WorkStation. You can
also export text from the Section window to this word processor.

If you paste text into the Section window from other word processors, the
tabulation characters are converted into ">' and other characters which can not
be interpreted by the WorkStation are converted into spaces.

When you copy text into the clipboard from other word processors, the text is
arbitrarily split into lines. When you paste it into the Section window, each line
is inserted in the form of a specific paragraph. To reassemble the text into one
paragraph, merge these paragraphs.
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Display, Print Preview and Printing a Section

Display the text in the Section window, pagination

The Section window displays only part of the contents of the section. The size
of the displayed part, called display page, depends on the current size of the
window.

The display page is not the same as the print page. The size of the print page
depends on the characteristics of the printer and on the current values of the
printing parameters (print margins, heading, etc.). Select Paginate in the File
menu to split the contents of the section into print pages.

This command determines the position of the beginning of the print pages,
called page breaks. A page break is always positioned before a paragraph, so
that a paragraph is never split between two different print pages. You can also
add manual page breaks (via Page Break in the Paragraph menu): these
page breaks will be taken into account by automatic pagination.

The page breaks are displayed as dotted lines: manual page breaks have more
densely dotted lines than automatic page breaks.

Move within the section

The Section window contains scroll bars allowing access to all of the contents of
the section. The scroll bars allow you to move line by line, display page by
display page, or directly to a given position.

You can access a particular page by selecting Go to in the Search menu. You
can also slide the scroll bar: when sliding the scroll bar, if the section has
already been paginated, the page numbers are displayed at the bottom right of
the window, indicating which page will be displayed.

Print preview and printing

The Print Preview command in the File menu opens a secondary window in
which you can display the section as it will be printed. Whole print pages are
displayed containing the presentation (margins, frame, title, context, page
number...) set by the current print options.

The Print section and Print pages... commands in the File menu allow you to
print part or all of the section contents. In the Print Preview window, you can
also use the Record page to print command of the System menu (or the F2
shortcut key) and repeat this command for several pages. When you close this
window, the list of recorded pages will be displayed for printing.
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The Menu Bar of the Section Window

File

Edit

Search

Characters

Paragraph

Options

Section

?=F1

This menu contains commands that allow you to save, save as, restore,
paginate, print preview, print section, print pages, set print options and printers
and validate the Section according to the host rules.

This menu contains commands that allow you to use text editing facilities.

This menu contains commands that allow you to search for characters strings,
replace characters strings, and to go to a specific page.

This menu contains commands that allow you to select character style and font.

This menu contains commands that allow you to format paragraphs
(with/without Word Wrap, define as a VisualAge Pacbase Line, label the
paragraph, use paragraph as Title), to insert page breaks and to align
paragraphs.

This menu contains commands that allow you to define paragraph formats,
display the Ruler and select the input mode (insert/typeover). You can also
install and use Spell Checkers.

This menu contains commands that allow you to display other sections in the
same section window.

This command calls the online help.
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The File Menu

File

Save

NOTE

Save As...

Restore

Paginate

NOTE

Print Preview
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Save
Save as...

Restore

Paginate

Print Preview
Print Section
Print pages...

Print Options...
Printer...

Host Validations

Saves the Text section. Host validations are then performed. If host validations
are not OK, the section is still saved locally. The message "Too many lines for
upload" is displayed, and you can split the section or copy part of it into
another section. This situation can be avoided by regularly checking your
Section with the Host Validations command.

You cannot save a text that contains incorrect VisualAge Pacbhase Lines. For
complete information, refer to subchapter “Upload/Download and Data Element
Cross-Reference”. A dialog box opens displaying the incorrect line types.

Opens the Save As... dialog box which enables you to duplicate the section into
another file. If, in the Print Options dialog box, you have selected the Absolute
command for Pagination and the Page Number command for the Header Style,
the Absolute Pagination dialog box will prompt you to input the number of the
first page of the Section.

All modifications carried out after the last save will be lost (a confirmation
message is displayed). Press YES to redisplay the last saved version of the
section.

Inserts and updates automatic page breaks after you have typed and edited the
text according to the print options and the printer orientation.

Automatic page breaks appear as thin dotted lines: manual page breaks
appear as dark gray lines.

Page numbers are displayed at the bottom right of the screen.

Opens the Print Preview window in which you can see your section as it will
look when printed. See subchapter “Auxiliary Dialog Boxes”.

If, in the Print Options dialog box, you have selected the Absolute command for
Pagination and the Page Number command for the Header Style, the Absolute
Pagination dialog box will prompt you to input the number of the first page of the
Section.

DSREF000254A



11-20

Print Section

Print pages...

Print Options...

Host Validations

NOTE
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Prints the Section.

If, in the Print Options dialog box, you have selected the Absolute command for
Pagination and the Page Number command for the Header Style, the Absolute
Pagination dialog box will prompt you to input the number of the first page of the
Section.

Prints the specified pages.

If, in the Print Options dialog box, you have selected the Absolute command for
Pagination and the Page Number command for the Header Style, the Absolute
Pagination dialog box will prompt you to input the number of the first page of the
Section.

The Print Pages... command opens the dialog box in which you specify the
order numbers of the pages within the Section (they may be different from the
page numbers).

For a description of this dialog box, refer to subchapter “Auxiliary Dialog Boxes”.
Opens the Print Options dialog box.
For a description of this dialog box, refer to subchapter “Auxiliary Dialog Boxes”.

These validations are relevant if the texts are to be uploaded and called in a
Document.

This command lets you know at any time the number of lines your section would
occupy when uploaded on the host. If the text has more than 950 lines, the
maximum authorized for a section on the host, this command displays a
warning message (the first 49 lines in the description are for saving any text
assigned on the host).

This command also checks the number of characters per word (word wrap
paragraph), and displays a message if:

= A word contains more than 30 characters

= The label of a paragraph contains more than 15 characters
You cannot save text containing invalid VisualAge Pacbase Lines. For

complete information, refer to subchapter “Upload/Download and Data Element
Cross-Reference”. A dialog box opens notifying you of the incorrect line.
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The Edit Menu

Edit

Undo Typing

Cut

Copy

Paste

Concatenate

Delete

The Search Menu

Search

Search

Replace

Go to...
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Undo Typing (Formatting, Type)
Redo Typing

Cut
Copy
Paste

Concatenate

Delete
The Undo command reverses your last editing action.

Deletes the selected character string from a text section and transfers it to the
Clipboard.

Copies a selected character string to the Clipboard.

Inserts the contents of the Clipboard into the text section where the cursor is
positioned, or replaces any selection.

Adds the selected character string to the current contents of the Clipboard
(same as copy without clearing the clipboard contents).

Deletes the character following the cursor or the string of characters selected.

Search > In the Section...
In all Sections...
Replace > In the Section...

In all Sections...

Go to...

> In the Section...

In all Sections...
Opens the Search dialog box. For complete details, refer to the subchapter
“Auxiliary Dialog Boxes”.

> In the Section...

In all Sections...
Opens the Replace dialog box. For complete details, refer to the subchapter
“Auxiliary Dialog Boxes”.

Opens the Go To dialog box. For complete details of the Replace dialog box,
refer to subchapter “Auxiliary Dialog Boxes”.
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The Characters Menu

Characters

Plain Text
Bold
Italic
Underline

List of Fonts

Inferior Size
Superior Size

Fonts...

All commands in this menu apply to the selected paragraph(s) only.

Plain Text
Bold
Italic
Underline

List of fonts

NOTE

Inferior Size
Superior Size

Fonts...

Removes all text enhancements (bold, italic, underline).
Makes characters bold, or removes the bold format.
Makes characters italic, or removes the italic format.
Underlines characters, or removes the underline format.
The list of fonts varies according to the fonts installed in the operating system
used. The current paragraph will be formatted according to the font selected in
the list.
When a new font is selected from this menu, its size will be the same as the
previous font where possible.
Reduces or enlarges the size of the character font, if a smaller or larger size is

available.

This command opens up a dialog box allowing you to select both the font and
size for the screen.
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The Paragraph Menu

Paragraph

Word Wrap
No Word Wrap
VisualAge Pacbase Line

Labeled Paragraph
Title

Page Break

Alignment...

All commands in this menu apply to the selected paragraph(s) only.

When a new paragraph is created, the system automatically applies the format of the preceding

paragraph.

The following three commands are mutually exclusive.

Word Wrap

No Word Wrap

NOTE

Continuous text input with automatic word-wrap.

In this type of paragraph, words exceeding 30 characters will be truncated when
the text is printed in a Document. You can verify that the text does not contain
such words by selecting Host Validations in the File menu.

However, local printing does not impose any limitation on word length.

WORD WRAP paragraphs may be indented. For complete information, refer to
subchapter “Auxiliary Dialog Boxes”, Define Formats dialog box.

The length of a No Word Wrap line can not exceed 254 characters. A "beep"
indicates when the end of the line is reached.

The paragraph will be printed as entered, i.e. without re-formatting. This may
be suitable for charts with columns, on condition that a non-proportional font is
used, in which all characters have the same width (for example Courier font).

If the chart is printed in a PDM, the TS edit option must be active.

VisualAge Pacbase Line

NOTE

This type of line is automatically assigned to lines of type Y, F and D, which
may form part of descriptions of text occurrences downloaded locally.

They are formatted as follows:
- 1-character line type
- 60-character line

If the character size used is to big, the line will exceed the page limits. Only
characters within page limits will be printed.

If you create a new paragraph following a VisualAge Pacbase Line type
paragraph, the new paragraph automatically has Word Wrap.

For further information, refer to the Specifications Database Reference Manual,
chapter “Texts”, subchapter “Section Description”.
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The following commands are optional. They can be used together and combined with the Word Wrap
and No Word Wrap commands.

Labeled Paragraph

NOTE

This is a label

Title

NOTE

Page Break

Alignment...

NOTE

A labeled paragraph has its first character string as a left negative indent. If you
activated Paragraph marks , the label will be symbolized by a left-oriented
arrow after the indent zone.

In the WorkStation, the label cannot exceed 30 characters. (The WorkStation
will "beep" if you go past this limit.) Warning: when this paragraph is validated
via Host Validations , a message will warn you that you have a label exceeding
15 characters.

The character string used for the paragraph label may be truncated when
printed if it is too long for the left margin of the format in use.

The Labeled Paragraph option is only valid for lines of VisualAge Pacbase
Line type.

The ampersand (&) can be used to associate several words in the label.

Example: The character strings “This&is&a&label and this is the text...”
will produce the following left negative indent:
and this is the text.

The purpose of this sentence is to create several lines of text for an example of
negative indent.

This command is used to insert titles within a text section.

If you want to underline a title which has a label, the label only will be
underlined.

This command allows you to position a page break or to cancel a positioned
page break (Undo Page Break) before the selected paragraph. This kind of
page break appears as a dark gray line: automatic page breaks appear as thin
dotted lines.

When you print a text locally, each section starts on a new page. However,
page breaks are not automatically placed at the beginning of a section when
you upload your text to the host. In order to upload texts with page breaks at
the beginning of sections , you need to insert page breaks . These will be
taken into account at host level only.

This command opens up a dialog box where you select alignment (Left,
Centered, Right, Justified) and format for the selected paragraph(s).

When the dialog box opens up, it shows the parameters of the selected
paragraph. If more than one paragraph is selected, the parameters of the
selected paragraphs are displayed if the parameters are the same in all
selected paragraphs (if not, no parameters are displayed). If several
paragraphs have been selected, you can select the alignment and the format for
all of the selected paragraphs.

To create tabs (alignments inside lines), you must use blank characters. To

ensure the alignments are correct, choose non-proportional screen font and
printer fonts.
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The Options Menu

Options Define Formats...

Ruler
Paragraph mark

Insert/Typeover

Spell Checker =>» Spell Checker names
Formats defined with the following two commands apply to all paragraphs in the current Section:

Define formats... Opens the Define formats... dialog box which allows you to specify default
formats. Refer to subchapter “Auxiliary Dialog Boxes”.

Ruler Displays the Ruler (command is checked when the Ruler is displayed). For
more information refer to subchapter “Auxiliary Dialog Boxes”.

Paragraph marks Select this command (command is checked) to display paragraph marks or re-
select the command (the check mark disappears) to hide the paragraph marks.
If you request paragraph marks in one section, they will be displayed in all other
open sections. This option is memorized for every user, and will be active when
you next connect.

Typeover/Insert mode
Toggles between typeover and insert modes.

Spell Checker This command opens a Cascaded menu that contains any of the installed Spell
Checkers. The names displayed are the names entered when the Spell
Checker was installed. For more information refer to subchapter “Auxiliary
Dialog Boxes”.

The Section Menu

Section First Section
Previous Section
Next Section
Last Section

These commands display the selected text section in the current section.
If a text section in which you have made updates is already displayed in another

window, a dialog box opens up and asks if updates should be saved before the
other section is displayed.

?=F1 Calls online help.
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Upload/Download and Data Element Cross-Reference

Upload
A text entered in the WorkStation and uploaded into the Specifications
Database has a specific structure and is ready to be printed in a Document
occurrence.
The uploaded text structure, seen via the emulator or a standard terminal, is as
follows:
The Table of Sections is displayed in the '++' section (CH: -D++). It is also
included in the Text occurrence summary screen (CH: -LT).
The code of each section is the 2-character code preceding the section title
in the Table of Sections window.
In each section, lines are allocated as follows:
* Line 000: section title
* Line 001: contains paragraph formats specific to the section. However,
the layout assigned to the Document occurrence will be taken into
account for Text occurrences uploaded from the WorkStation if you use
the "-TW" print option
* Lines 002 to 049 : assignment requests (I-type line)
= Lines 050 to 999 : text line contents entered locally
= Line numbers are incremented sequentially by one
= "$i" (WORD WRAP) or $$i (NO WORD WRAP) (i = 0, 1, ... , 9) marks the
beginning of a paragraph and its format
= Line breaks are indicated at the beginning of the following line
» The last line of a section that contains an I-type line will also contain an
assignment end request (J-type line)
NOTE: The L-type line (except for the 000 line) is not used with the current WorkStation

release.

If for some reason you need to modify a Textual description DIRECTLY in the
Specifications Database (not recommended), you should carefully follow the
instructions listed below.

The "++" section must not be modified
Lines 000 and 001 must not be modified nor moved

Do not enter text on lines 002 to 049. They are reserved for assignment
requests (I-type lines)

If there is a J-type line, it cannot be deleted

Renumber existing lines using an interval greater than 1 (from line number
050 or after, until the end of the section)

Enter your changes
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* Keep in mind that - within paragraphs - blanks between two lines must be
specified at the beginning of the second line

* If you create a new section, once downloaded, it will be positioned
automatically at the end of the list in the Table of Sections window, under its
2-character code. The title is the first title in the Section. If no title is found,
"Old Section: XX"is given as a title (where XX is the section code)

When a Textual description is downloaded, all Sections included in this
description are downloaded at the same time. The title given to a Section
comes from the first title found within the Section. If no title is found, "Old
Section: XX" is given as a title (where XX is the section code).

You can set Text downloading options via the WorkStation Manager Window
(via Download — Text... in the Preferences menu).

When you download text for the first time, a confirmation dialog box will allow
you to verify the downloading options.

After its first download on a PC, a text which had been created on the host can
take one of the following two presentations:

First case: the Text uses PDM codifications:

All codifications are used:

= The Table of Sections is automatically built. The sections are displayed
depending on the alphabetical order of their 2 character code, and their
title is built from the first title line, which you can modify

= A "$$n" paragraph becomes a No Word Wrap type of paragraph and a
"$n" becomes a Word Wrap type of paragraph.
The print windows ($n, etc.) take the attributes of the corresponding
formats: Format 1 for $1, Format 2 for $2, etc., and Format 10 for $0

N.B.
If you want to keep the original formats (defined from the host) when
the text is printed from PDM, use the "-TW" print option.
You can also model the formats on the print windows of the used
layout.

= Type L lines become type K lines

= Type F, D and Y lines appear as such in the text (VisualAge Pacbase
type lines)

= |f the section contains a type | line which is not followed by a type J line,
all the following sections will also be downloaded
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Second case: the Text does not use PDM codifications:

The characteristics are the same as in the previous case, except for the
paragraph definition:

= All the lines are integrated in the same paragraph, until there is:
— achange of line type
— an empty line

= In the texts defined from the host, $0 is the default print window
corresponding in the WorkStation to the Format 10 which will be
assigned by default to all downloaded paragraphs

Cross-References between a Text and a Data Element

To cross-reference a Text to a Data Element, enter $.E=DELCOD (where
DELCOD is the code of the Data Element) in the Text. When the text is
uploaded, the cross-reference between the Text and the Data Element is
created.

Codes with the form $.E=DELCOD (where DELCOD is the Data Element
occurrence code) are cross-references between the Text and the Data Element.
Such cross-references entered via the WorkStation have this form: the Data
Element is not displayed in the ELEM. column (on the host). However, the
ELEM. column may still be used via the Emulator. After a download the values
in the ELEM. column will be translated to $.E=DELCOD and will remain in this
form even after an upload.

Do not delete these codes unless you wish to delete the cross-reference.
These codes do not appear in the printed text or the simulation.
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Auxiliary Dialog Boxes

The Create From... Dialog Box

This dialog box is displayed via Create from... in the Section menu in the Table
of Sections window ( The Textual Description Window). It enables you to create
a section using an existing file:

‘=-| Create from

File Name ...

®_?7?

File in ... ci.\bas_dIme\9999hibib_mtf

congldl._ab |t Code Set
congldl._ad

gemlibdl._en — C ASCI ® ANSI
gemlibd1._gg
gerestdl._en
gerestdl._qgg -
test2d1._ad El OK Cancel Lib.

File Name

Enter the name of the file or select it in the list box.
File in

The file path.

Code Set
Select the format of the existing file: ASCII or ANSI.

OK

Selects the file chosen in the list box and opens the Create from... dialog
box, identical to the Create dialog box.

Cancel
Closes the dialog box.
Lib.
Enters the file path of the current WorkStation library and refreshes the
list box
NOTE For text from another word processor, tabulation characters are converted to >'
and other characters that the WorkStation cannot interpret are converted to
blanks.
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The Print Options Dialog Box

This dialog box is displayed when you choose:
+ Print options in the Print menu in the Table of Sections window
+ Print options in the File menu in the Section window
+ Print options in the Print menu in the Non-Formatted Description
window

NOTE The contents of this box will vary slightly according to the location where it
was opened.

i { ki i
.i_ E_
|l perian
lntigua 0% ] 12 %

Font correspondence

The screen font is not always available for printing and vice-versa. These
list boxes are thus used to ensure correspondence between screen and
printer fonts.

To ensure correspondence, click on a screen font and then on the printer
font which is to be associated with the screen font. By default, screen
fonts correspond to printer fonts: however exact correspondence is not
always possible.

Screen
Screen font.

Printer
Printer font.
Margins
Top, Bottom, Left, Right

Unit
Unit of measure for print margins: mm or inch/10.
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Pagination (not available for Non-Formatted Description window)

Relative Numbers the pages according to their Section, e.g. the third
page of the fourth Section is numbered 4.3.

Absolute Numbers the pages in sequence according to their position
within the Text occurrence as a whole.

Frame
Allows you to print each page within a frame.

Header Style
Header layout:

CONTEXT DATE
USER PAGE
TEXT CODE - TEXT NAME
SECTION CODE - SECTION TITLE

The check boxes of the Header Style group allow you to specify the
elements you want to print in the header. The bold/italic/underline styles
apply to the four lines of the header.

Font Header
The list boxes display the fonts and the corresponding sizes that are used for
the header. Click on a font, then select its size.

Table of Sections (available for the Table of Sections window only)
Prints the Table of Sections, i.e. the List of Sections, when you choose Print
Section(s) in the Print menu in the Table of Sections window.

Automatic Print
If Text sections are selected and absolute pagination is used, only these
sections are listed in the printed Table of Sections. If Text sections are selected
and relative pagination is used, all sections are listed in the printed Table of
Sections.

Indexed Table
Prints the page numbers of the sections.

OK
Modifications are saved, and the dialog box closes. If this dialog box was
accessed via:
— the Table of Sections or the Section window, print options are set for
all Textual descriptions
— the Non-Formatted Description window, print options are set for all
Non-Formatted descriptions

Cancel
Changes are not saved and the dialog box is closed.

NOTE The print parameters you define for the texts or the Non-Formatted
description are saved for the when you open the next session.

DSREF000254A



11-32 VisualAge Pacbase WorkStation Reference Manual

The Style Dialog Box

This dialog box is displayed for the following windows:
+— the Table of Sections window via Style... in the Preferences menu
+— the Non-Formatted Description window via Style... in the Preferences
sub-menu of the Options menu

Depending on which window you opened it from, this dialog box allows you to
define default styles for all the Sections of a Text or for all Non-formatted
Descriptions.

= Style
-Presentation

Word Wrap
Labeled Paragraph
No Word Wrap e [
Title « | 4]

PACBASE Line

" Bold [ ltalic " Underline
-Definition of default Formats——— [Default screen font
Left Margin: IE_ Courier b |t
Arial 8
Right Margin: W Modern 10
Roman 12
Indentation: IE— Script 13
System 15
‘ Apply these formats Times New Roman | |16 zl
‘Default alignment Default Format
C Left C Right 10 oK
C Center ® Justified Cancel

Presentation

You can assign a default display color and bold/italic/underline to each
paragraph type.

For complete information concerning paragraph types, refer to subchapter
“The Menu Bar of the Section Window”. (For the Non-Formatted Description,
refer to chapter “The Non-Formatted Description Window”, subchapter “The
Menu Bar of the Non-Formatted Description Window”.)

To change the color, select a paragraph type, then a color on the color bar.
The color applies to all existing, current and future Sections/Non-formatted
Descriptions. To improve the legibility of the text/description, all titles may
be for example displayed in red (WorkStation default option).
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Word Wrap

Labeled Paragraph

No Word Wrap

Title

VisualAge Pacbase Line (available for the Table of Sections window

only)

Bold/Italic/Underlined
These check boxes are available for all types of paragraph except
VisualAge Pacbase Lines. The bold/italic/lunderline applies to all
future Sections/Non-formatted Descriptions.

Definition of default formats

In this group you define or modify the default formats of the future
Sections/Non-formatted Descriptions. If you enter inconsistent or incorrect
values in these dialog boxes, they are highlighted and an error message is
displayed. You can define up to ten formats by setting parameters for the
margins and the indentation.

NOTE

If a Text or Non-Formatted description is downloaded, the formats defined in
these dialog boxes take priority over those defined in the Download Texts or
Download Non-Formatted Descriptions dialog boxes which are accessed via
the WorkStation Manager Window.

Select a format from 01 to 10.

Left Margin
Enter a number (position on the Ruler).

EXAMPLE:
If the left margin is set to 5, the first character on each line of the
corresponding paragraph will hold the sixth position, leaving 5 spaces on
the left, except the first line if a value different from the left margin one is
specified for the indentation.

Right Margin
Enter a number (position on the Ruler).

If the right margin is set to 75, the last character on each line of the
corresponding paragraph will hold the seventy-fifth position, leaving 3
spaces on the right.

Indentation
This parameter spaces the first line of a paragraph from the left margin.

EXAMPLE:
If the left margin is set to 5 and you require a left indent of 6 characters,
the Indentation value must be 11 (5 + 6).

For consistency with the host format management, the right margin value
cannot exceed 78 characters. The margins associated with the standard
default formats are as follows:
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format 1 6-78
format 2 8-78
format 3 10-78
format 4 12-78
format 5 14-78
format 6 16-78
format 7 18-78
format 8 20-78
format 9 22-78
format 10 4-78

Apply formats (available for the Table of Sections window only)
This button is used to apply the new formats immediately to existing Sections
(displayed in Table of Sections window).

Default font
The font used by default for future Sections/Non-Formatted Descriptions.

Default alignment
The alignment used by default for future Sections/Non-Formatted Descriptions.

Default format
The format used by default for future Sections/Non-Formatted Descriptions.

OK
Changes are saved and the dialog box is closed.

Cancel
Changes are not saved and the dialog box is closed.
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The Spell Checker Installation Dialog Box

This dialog box is displayed for the following windows:
— The Table of Sections window via Spell Checker Installation... in the
Preferences menu
— The Non-Formatted Description window via Spell Checker
Installation... in the Preferences menu

This dialog box allows you to install and set parameters for one or more spell
checkers (your own or commercial models).

Irrespective of which window the spell checkers were installed from, they can be
used in both the Section and the Non-Formatted Description windows.

‘=-| S5pell Checker Installation

Installed Spell Checkers :

spellchecker Add...
Wordspellchecker —

Configure...

Bemove

Quit

Add
This button opens the dialog box below in which you can specify the spell
checker and its parameters.

Configure
This button, which is active when you select an installed spell checker from
the list, opens the same dialog box as the Add button. In this case, the
dialog box displays the parameters of the selected spell checker. You can
modify these parameters.

Remove

This button, which is active when you select an installed spell checker,
removes it from the list.

Quit

This button closes the dialog box.
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cltexte.spl
rop———
. .

Spell Checker name
Enter the name of the spell checker (.EXE is not required). This name will
appear as a label in the menu displayed via Spell Checker in the Options
menu in the Section window.

Command line
Select the location of the spell checker.

Executable name
Enter the complete path, name and extension (not required) of the spell
checker executable file. You can type it or select a line from the list box.

NOTE For normal use, the executable file must actually be a spell checker.

Parameters
Enter parameters for the spell checker run-start command.

Spell Checker file

File name
The spell checker checks a copy of the text. When the check is
completed, the original text will be updated with modifications, if any.
Enter the file name and path to be used for this operation.

Code set
Specify the code set (ASCII or ANSI) in which the spell checker will work.

Processing

By paragraph
This command keeps the paragraph divisions of the original text in the
copied text. This feature enables you to use grammar checkers.

By line
This command turns each line of the copied text into a paragraph.
Use this command if the spell checker cannot work with long
paragraphs.

OK
This button saves the entered parameters and closes the dialog box.
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Message
If you have developed your own spell checker, use this button to open a
dialog box in which you specify parameters for communication between the
WorkStation and your spell checker.

Cancel
This button cancels the entered parameters and closes the dialog box.
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The Save As Dialog Box

This dialog box is displayed via Save as... in the File menu in the Section
window (and Save as... in the File menu in the Non-Formatted Description
window). It enables you to duplicate the section onto another file.

‘=-| Save as

File Name:

Code Set— ‘Type

C ANSI ® Text only
® ASCII O Text with formats

OK Cancel

File Name
Enter the name of the file.

Code Set
Select the format of the existing file: ASCII or ANSI.

Type
Select what you want to save.
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The Absolute Pagination Dialog Box

If, in the Print Options dialog box, you have selected the Absolute command for
Pagination and the Page Number command for the Header Style (or for the
Non-formatted Description window, only the Page Number), the following dialog
box will be displayed when you select:

* Print Section(s ) in the Edit menu in the Table of Contents window

* Print Preview , Print Section or Print Pages in the File menu in the
Section window

= Print Preview or Print Pages in the File menu in the Non-formatted
Description window

This dialog box will prompt you to input the number of the first page of the
Section ("1" will be entered by default):

‘=-| Absolute Pagination
First page number of
the Section:
o

oK Cancel

Press OK to continue the requested command.
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The Print Preview Window

This window is displayed via Print Preview in the File menu in the
Section/Non-Formatted Description window. It shows you what the
Section/Description will look like when it is printed.

= Print Preview

Print Preview displays an entire page at a reduced size: the page number is

shown in the bottom right corner. In order to browse the Print Preview, press
the PGDN or PGUP keys or use the vertical scroll bar.

In the Print Preview window there is a System menu which contains two
commands: Print Section/Description and Record page to print . If you
display a page in this window and select Record page to print and then display
another page and select Record page to print (etc.), the pages you recorded
to print will be printed when you select Print pages .

If pagination has not been performed or if pagination is not updated, the Print
Preview command repaginates automatically.
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The Print Pages Dialog Box

This dialog box is displayed via Print Pages... in the File menu in the Section
window/Non-Formatted Description window (if applicable after closing the
Absolute Pagination dialog box). In it you specify the order numbers of the
pages within the Section/Non-Formatted Description (these numbers may be
different from the page numbers).

‘=-| Absolute Pagination
First page number of
the Section:
on

oK ‘ Cancel

For example, if you want to print the first and second page of the second
section which begins on page 5, enter 1 and 2 and not 5 and 6. Using the " - "
character you can specify a page interval.

3-9 prints from page 3 to page 9
(inclusive)
-9 prints from the first page to page 9
4 - prints from page 4 to the last page in the
section

358-1214-2023- prints page 3, page 5, from page 8 to
page 12, from page 14 to page 20 and from page 23 to the last page

Press OK and the following dialog box will be displayed as the text is
printed.

‘=-| Printing

Sending Text
to printer

Page 1

Cancel
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The Search Dialog Box

NOTE

NOTE

This dialog box is displayed when you select:

= Search—In the Section... or Search—In all Sections... in the Search
menu in the Section window

= Search in the Search menu in the Non-Formatted Description window

If a Text consists of only one Section, Search —In all Sections... is disabled.

‘.=.| Search in the Section

Search for :

" Whole Word " Match UpperflLowercase

Start Search Quit

= enter the character string to Search for
= specify that the character string be searched for as a Whole Word

= choose Match Upper/Lowercase: if this command is selected, the
search is performed on the string as entered, i.e. uppercase characters
are differentiated from lowercase

= specify whether the character string be searched for From the
beginning of the Section . If this option is not checked, the search starts
in the current paragraph.

= Select Close to close the dialog box.

The search is activated by clicking on Search.
When you close the Search dialog box, the last character string searched
for in a Text or Non-Formatted Description as well as the search options are

memorized. All these elements are automatically displayed when the dialog
box is re-opened.
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The Replace Dialog Box

NOTE

This dialog box is displayed when you select:

* Replace —In the Section... or Replace —In all Sections... in the Search
menu in the Section window

* Replace in the Search menu in the Non-Formatted Description window

If a Text consists of only one Section, Replace—In all Sections... is
disabled.

‘=-| Replace
Search for: choice
Replace with : command

" Whole Word " Match UpperflLowercase

Start Search Search

Replace Selection Change All

Quit

The following is the full list of buttons available in this dialog box:

Search for
Enter the character string to be searched for.

Replace with
Enter the character string to replace the character string being searched for.

Whole Word
Check to specify that the character string be searched for as a whole word.

Match Upper/Lowercase
Check this command to search for the string as entered, i.e. uppercase
characters are differentiated from lowercase.

From beginning of Section
Check this command to search from the beginning of the Section.

Search (available when input is made in the "Search" field)
Press to start searching. When a character string is found it is highlighted.
From this moment, the button will be No Change.

No Change
Select in order not to replace the character string found and continue the
search.

Replace Selection
Select to replace the character string found.
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Replace and Continue
Select to replace and continue searching. When a character string is found
it is highlighted.

Change all the Section (available when starting the input in the "Search" field,
using Replace —In all Sections... )

Select to replace the character string found in the current Section of the
Text. Once the changes have been performed in the current Section, click
on Find Next. This opens a message box in which you must confirm the
replacement process in the next section.

Change All (available when starting the input in the "Search" field, using
Replace —In the Section... for a Section or Replace for a Non-Formatted
Description).

Select in order to change all occurrences of the character string found in the
Section/Description.

Quit

Select to close the dialog box.

* When you close the Replace Dialog Box, the last character string

searched and replaced in a text or a non formatted description, as well
as the replacement options, are memorized. All these elements will
be automatically displayed when reopening the box.

* You can type text in the section while the dialog box called by the Search or
Replace options remains open.
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The Go to... Dialog Box

This dialog box is displayed when you select:
*» Goto... inthe Search menu in the Section window

* Goto... inthe Search menu in the Non-Formatted Description window

‘=-| Go to
page number: I 1
OK | Cancel

This dialog box allows you to enter the actual number of the page in the
Section/Non-Formatted Description (it can be different from the printed page
number if the page numbering does not begin at 1).
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The Screen Fonts Dialog Box

This dialog box is displayed when you select Fonts in the Characters menu.

‘=-| Screen Fonts

Font:

Courier
Arial
Modern
Roman
Script

OK

Cancel

This dialog box enables you to select a font and its size for the current Section
or Non-Formatted Description.
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The Define Formats Dialog Box

This dialog box is displayed when you select:
*— Define Formats... in the Options menu in a Textual Description window
*— Define Formats... in the Options menu in a Non-Formatted Description

This dialog box allows you to modify the default formats defined in the Style
dialog box (displayed in the Table of Contents window via Style... in the
Preferences menu, or in the Non-Formatted Description window via
Preferences in the Options menu). The formats defined in the Define Formats
dialog box apply to the current Section/Non-Formatted Description, i.e. when
you modify a Paragraph Format, all paragraphs with that format will be modified
in your section.

This dialog box lists paragraph formats:

‘=-| Define Formats
‘Format ‘Margins
Left: 4_
Right: ?
Indentation: 4_

OK Cancel

Ten paragraph formats can be defined including the Left and Right margins
and Indentation parameters.

A margin is defined by a number, i.e. a position on the Ruler.

For example, if the left margin is set to 5, the first character of each line of
the corresponding paragraph will hold the sixth position, leaving 5 spaces
on the left, except the first line if a different value from the left margin
value is specified for the indentation

If the right margin is set to 75, the last character of each line of the
corresponding paragraph will hold the seventy-fifth position, leaving 3
spaces on the right

The Indent parameter spaces the first line of a paragraph from the left margin.

For example, if the left margin is set to 5 and you require a left indent of 6
characters, the Indent value must be 11 (5 + 6).

When a section is saved, its paragraph formats are also saved.

If you assign incorrect values, you cannot close the dialog box and an error
message appears.
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The Ruler

This ruler is displayed via Ruler in the Options menu in a Textual description
Section window or a Non-Formatted Description window.

=.| Text TESTLN: AB HE
EFile Edit Search Characters Paragraph Options Section ?=F1

T E=] [=] [ Rl &R E] [B[2]u] [«[=]=]T][=]4] Kl
10 (&| |Arial (12 & =| =

I I AR U N A it N N AN O N R O N AN RO N W O O SN A e O O =N A el NN A O L= AN A A et M A R A AN ol O

« ] -+

The Ruler is a horizontal scale which is displayed at the top of the Section
window. Re-select the Ruler command to hide the Ruler. If you request the
Ruler in one section, it will also be displayed in all other open sections. This
option is memorized for every user and will be active when you next connect.

This command allows you to perform the same operations as Define Formats
in the Options menu.

You may choose to:

= Apply another format to the paragraph(s): click on another format
number or press Ctrl+No. (No. = 0 to 9, O identifying Paragraph Format
No. 10)

= Modify the format:

+ The two black triangular markers control the left and right margins
+ The triangle points indicate the paragraph start and end positions
¢+ The indent marker appears as a white triangle in the left triangle if not
used. Otherwise it appears as a black triangle.
= Use the alignment icons to align the selected paragraph(s): flush left
(CTRL+L), centered (CTRL+Z), flush right (CTRL+R), or justified (CTRL+J),
between the indent markers

NOTE To create tabs (alignments inside lines), you must use blank characters. To

ensure the alignments are correct, choose non-proportional screen font and
printer fonts.
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This dialog box appears when you choose Spell Checker in the Options menu
in the Section window of a Textual Description or a Non-Formatted Description.

This dialog box displays the Spell Checker options:

‘=-| Spell Checker

‘Parameters
FAMS OFFICE\WINWORD.EXE
FAMSOFFICEATEXTE.SPL
ANSI

Cancel

Correct

These options are memorized for every user and will be active when you next

connect

The Start button triggers copying of the Section into the temporary file. (The
text is stripped of all control characters.) The Spell Checker is activated, and
you can correct the text. The corrected text is saved in the temporary file.

When using the Spell Checker, you can add, modify or delete characters or
words. However, you cannot add or delete paragraphs.

When correction is finished, you return to the dialog box. If you select Correct,
the text in the temporary file will be retrieved to update your section. You may
Cancel the process and abandon all corrections made by the Spell Checker.
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Getting to the Window

The Entity Menu

The File Menu

The Edit Menu

The Search Menu
The Characters Menu
The Paragraph Menu
The Options Menu
The Help command
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All the entities (except the standard VisualAge Pacbase entities) have a Non-
Formatted description. This description can be wused to enter free
documentation for a given occurrence.

For some specific entities, there may be several Non-Formatted descriptions
referring to a particular topic for the methodology being used. For example, the
Phase entity in the MERISE methodology has two Non-Formatted description
windows: “Non-Formatted description” and “Synchronization”.

The Non-Formatted descriptions are processed by the Non-Formatted
description window, which offers the same features as the Section window of
the Textual description. This is why, in this chapter, you will find frequent
references to chapter “The Textual Description Window” for all the dialog boxes
that are common to both.

Getting to the Window

Since a Non-Formatted Description is managed locally, this window can be
accessed whatever the connection type.

The occurrence must have been defined in the Specifications Database (except
for drafts which are created in local mode). Its description must be downloaded
onto the PC prior to working in local mode.

The background color of the Non-Formatted window can be changed in the
WINDOWS configuration panel.
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The Menu Bar of the Non-Formatted Description Window

Entity This Cascaded menu contains commands that allow you to access the
definition, lists, descriptions, cross-references of the current occurrence.

File This menu contains commands that allow you to save, restore, paginate, print,
set printing options and printer parameters and check the description according
to the host constraints.

Edit This menu contains text editing commands.

Search This menu contains commands that allow you to search for character strings,
change character strings, and go to a specified page.

Characters This menu contains commands that allow you to select character style and font.

Paragraph This menu contains commands that allow you to select paragraph types and
formats and insert page breaks.

Options This menu contains commands that allow you to define paragraph formats,
display the Ruler and select the input mode (insert/typeover). You can also
install and use Spell Checkers.

?=F1 This command calls the online help.

System Menu In addition to standard commands, this menu contains a command to consult
the current context.

For information concerning the context, refer to chapter “WorkStation
Connection”, subchapter “Context”.
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The Entity Menu

Entity Main Entity = Definition
Lists =>» Available lists
Descriptions => Available descriptions
X-References => Available X-references

Other Occurrence...
Related Entity...

For complete details about this menu, refer to chapter “Navigation in the
WorkStation”, subchapter “The Cascaded Entity Menu”.
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The File Menu

File

Save

Save as...

Restore

Paginate

NOTE

Print Preview

Print pages...

Print Options...

Save
Save as...

Restore

Paginate

Print Preview
Print Description
Print pages...

Print Options...
Printer...

Host Validations

Saves the description. If the description contains more than 998 lines, it cannot
be uploaded to the host. However, it is still saved locally. The message Too
many lines for upload is displayed, and you can split the description or copy
part of it in another description. This situation can be avoided by regularly
checking the description with the Host Validations command.

Opens the Save As dialog box. For details concerning this dialog box, refer to
chapter “The Textual Description Window” subchapter “Auxiliary Dialog Boxes”.

All the modifications carried out after the last save will be lost (a confirmation
message is displayed). Press YES to redisplay the last saved version of the
description.

Inserts and updates automatic page breaks after you have typed and edited the
description.

Automatic page breaks appear as thin dotted lines whereas manual page
breaks appear as dark gray lines.

Page numbers are shown in the bottom-right corner of the window as
pagination proceeds.

Opens the Print Preview dialog box in which you can see your description as it
will look when printed. See chapter “The Textual Description Window”,
subchapter “Auxiliary Dialog Boxes”.

If, in the Print Options dialog box, you have selected the Page Number
command for the Header Style, the Absolute Pagination dialog box will prompt
you to input the number of the first page of the Description.

Prints specific pages.

If, in the Print Options dialog box, you have selected the Page Number
command for the Header Style, the Absolute Pagination dialog box will prompt
you to input the number of the first page of the Description.

This command opens the Print Pages dialog box in which you specify the pages
to be printed. See chapter “The Textual Descriptions Window”, subchapter
“Auxiliary Dialog Boxes”.

Opens the Print Options dialog box.
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For complete information, refer to chapter “The Textual Description Window”,
subchapter “Auxiliary Dialog Boxes”.

Opens up a dialog box listing the printers connected to the PC. Select a printer
and click ok button.

The Configure... button opens another dialog box that contains all parameters
associated with the printer driver (i.e. paper format and orientation, specific
characteristics, etc.).

This command lets you know at any time the number of lines that your
description would occupy when uploaded on the host. If the text has more than
950 lines (the maximum authorized for a description on the host), this command
displays a message.

This command also checks the number of characters per word (word wrap
paragraph), and displays a message if:
= A word contains more than 30 characters

= The label of a paragraph contains more than 15 characters
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The Edit Menu

Edit

Undo Typing

Cut

Copy

Paste

Concatenate

Delete

Undo Typing (Formatting, Type)
Redo Typing

Cut
Copy
Paste

Concatenate

Delete
The Undo command reverses your last editing action.

Deletes the selected character string from the description and transfers it to the
Clipboard.

Copies the selected character string to the Clipboard.

Inserts the contents of the Clipboard into the description where the cursor is
positioned, or replaces the selection if any.

Adds the selected character string to the Clipboard contents.

Deletes the selected elements, without storing them in the Clipboard.

DSREF000254A



12-8

The Search Menu

Search

Search...

Replace...

Go to...
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Search...
Replace...

Go to...

Opens up the Search dialog box. For complete details concerning the Search
dialog box, refer to chapter “The Textual Description Window”, subchapter
“Auxiliary Dialog Boxes”.

Opens the Replace dialog box. For complete details concerning the Replace
dialog box, refer to chapter “The Textual Description Window”, subchapter
“Auxiliary Dialog Boxes”.

Opens the Go To dialog box. For complete details concerning the Go To dialog

box, refer to chapter “The Textual Description Window”, subchapter “Auxiliary
Dialog Boxes”.
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The Characters Menu

Characters

Plain Text
Bold
Italic
Underline

List of Fonts

Inferior Size
Superior Size

Fonts...

All commands in this menu apply to the selected paragraph(s) only.

Plain Text
Bold
Italic
Underline

List of fonts

NOTE

Inferior Size
Superior Size

Fonts...

Removes all text enhancements (bold, italic, underline).

Makes characters bold, or removes the bold format.

Makes characters italic, or removes the italic format.

Underlines characters, or removes the underline format.

The list of fonts varies according to the fonts installed in the operating system in
use. The current paragraph will be formatted according to the font selected in
the list.

When a new font is selected in this menu, the font size which is automatically
selected corresponds as closely as possible to the size of the previous font.
Reduces or enlarges the size of the character font, if a smaller or larger size is

available.

Opens up a dialog box allowing you to select both the font type and size.
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The Paragraph Menu

Paragraph

Word Wrap
No Word Wrap

Labeled Paragraph
Title

Page Break

Alignment...

All commands in this menu (except Page Break) apply to the selected paragraph(s).

When a new paragraph is created, the system automatically applies the format of the preceding

paragraph.

The following two commands are mutually exclusive.

Word Wrap

No Word Wrap

NOTE

Continuous text input with automatic word-wrap.

Words in this type of paragraph cannot exceed 30 characters. This will prevent
the truncation of words exceeding 30 characters when your text is printed in a
Document. You can verify that the text does not contain such words by
selecting Host Validations in the File menu.

However the WorkStation does not impose any limitation on word length.

WORD WRAP paragraphs may be indented. For complete information, refer to the
description in the "Define Formats" dialog box in chapter “The Textual
Description Window”, subchapter “Auxiliary Dialog Boxes”.

The length of a No Word Wrap line can not exceed 254 characters. A "beep"
will indicate when the end of the line is reached.

The paragraph will be printed as entered, i.e. without re-formatting. This may be
suitable for charts with columns, provided that you use a non proportional font,
in which all characters have the same width (the Courier font for example).

If, after pasting text into a paragraph in No Word Wrap mode, the line contains
more than 254 characters, the text will switch to Word Wrap mode. Simply
delete the excess characters to switch back to No Word Wrap mode.

The following commands are optional. They can be used together and combined with the Word Wrap
and No Word Wrap commands.

Labeled Paragraph

NOTE

A labeled paragraph has its first character string as a left negative indent. Its
use is symbolized by a left-oriented arrow sign after the indent. The label cannot
exceed 30 characters. (The WorkStation will "beep" if you exceed this limit.)
Warning: when this paragraph is validated via the Host Validations command,
a message warns you if the label exceeds 15 characters.

The character string used for the paragraph label may be truncated when
printed if it is too long for the left margin of the format used.

The ampersand (&) can be used to associate several words in the label.
Example: The character string “This&is&a&label and this is the text...” will

produce the following left negative indent:
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This is a label

Title

NOTE

Page Break

NOTE

and this is the text.

The purpose of this sentence is to create several lines of text for an example
of negative indent.

This command is used to insert titles within a Non-Formatted description. A title
can be set on several lines. If you create a new paragraph after a Title
paragraph, the new paragraph is automatically created without the title format.

If you want to underline a title which has a label, only the label will be
underlined.

Allows you to position a page break or to cancel a positioned page break (Undo
Page Break ) before the selected paragraph.

This kind of page break appears as a dark gray line (automatic page breaks
appear as thin dotted lines).

When the dialog box opens up, it shows the parameters of the selected
paragraph. If more than one paragraph is selected, the parameters of the
selected paragraphs are displayed if the parameters are the same in all
selected paragraphs (if not, no parameters are displayed). If several paragraphs
have been selected, you can select the alignment and the format for all of the
selected paragraphs.
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Define Formats...

Ruler
Paragraph Mark

Insert/Typeover
Spell Checker =» Spell Checker names
Preferences =>Style...

Spell Checker installation...

The formats defined by the following two commands apply to all paragraphs in this description:

Define formats...

Ruler

Paragraph marks

Typeover/Insert mode

Spell Checker

Preferences

Style...

Spell Checker installat

Opens the Define formats... dialog box which allows you to specify default
formats.

Refer to chapter “The Textual Description Window”, subchapter “Auxiliary
Dialog Boxes”.

Displays the Ruler (command is checked when the Ruler is displayed). This
option is memorized for every user, and will be active when you next connect.

For more information, refer to chapter “The Textual Description Window”,
subchapter “Auxiliary Dialog Boxes”.

Select this command (command is checked) to display paragraph marks or re-
select the command (the check mark disappears) to hide the paragraph marks.
If you request paragraph marks in one section, they will be displayed in all other
open sections.

Toggles between typeover and insert modes.

This command opens a Cascaded menu that contains any of the installed Spell
Checkers. The names displayed are the names entered when the Spell
Checker was installed. For more information, refer to chapter “The Textual

Description Window”, subchapter “Auxiliary Dialog Boxes”.

= Style...
Spell Checker installation...

Opens a dialog box in which you can specify a default presentation for all non-
formatted descriptions.

For complete information, refer to chapter “The Textual Description Window”
subchapter The Menu Bar of the Table of Sections Window”.

ion...
Opens a dialog box which allows you to install and parameterize one or more of

your own spell checkers or spell checkers which are currently available on the
market.

DSREF000254A



Non-Formatted Description Window 12-13

The Help command
?=F1 calls online help.
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Functionalities

Use the Formatted Description window to do the following:

* Consult and update occurrence descriptions in the Specifications Database
in real time.

This window displays various sets of formatted and numbered lines, each
set being specific to a description.

Input in certain fields creates automatic cross-references within the
Specifications Database. For example, the Data Element Calls description
of the Segment entity creates automatic cross-references between the Data
Elements and the Segment.

* Consult and update General Documentation of any occurrence (equivalent
to the -G screen for the VisualAge Pacbase standard entities).

* Consult online help for the Description.
The colors of all these fields can be modified using the Logical Screens dialog
box which can be accessed via the WorkStation Manager window. See the

chapter “The WorkStation Manager Window”, subchapter “Auxiliary Dialog
Boxes”.

Getting to the Window
A host connection is required.

Enter an occurrence in the Occurrence field of the Entity dialog box and select a
description in the Description part of the Entity dialog box.

For more details on the various ways to specify an occurrence code in the Entity
Dialog Box or on descriptions, see the chapter “Navigation in the WorkStation”.

Occurrence code input made easy

You can use the drag and drop technique to fill in the occurrence code in a
Definition window (target window) from a host list, a Formatted Description or
another Definition window (source window).

* Open simultaneously the Definition window and the Formatted Description,
the host list or another Definition window.

* Select an occurrence code in the source window by clicking the mouse's left
button and drag the mouse to the target window while keeping the button
pressed.

* Release the button above a field which accepts an occurrence code of the
same entity.
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The Formatted Description Window Menu Bar

Entity

Update+Display

Special choices

View...

Options

Screen

?=F1

System Menu

This Cascaded menu contains commands that allow you to access the
definition, lists, descriptions and cross-references of the selected occurrence.
This menu allows you to update the Formatted Description of the occurrence.

Allows you to find differences between sessions, search and replace character
strings and renumber lines.

Allows you to display and to change the Library sub-network and screen
presentation.

This menu allows you to set a branching mode once you have created or
modified a description by duplication, or deleted a description from the
Description window of another occurrence.

This menu allows you to copy and print the current window.

This command allows you to access online help. For a complete description,
see subchapter “The Auxiliary Window: The Help Window”.

In addition to standard commands, the system menu allows you to consult the
context of the current window.

Function keys and mouse

For the use of function keys and mouse in this screen, see the Appendix at the
end of this manual.
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The Entity Menu

Entity Main Entity = Definition
Lists =>» Available lists
Descriptions => Available descriptions
X-References => Available x-references

Other Occurrence...
Related Entity...

For full details of this menu, see the chapter “Navigation in the WorkStation”,
subchapter “The Cascaded Entity Menu”.
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The Update+Display Menu

Update+Display

Same page

Next page

Top

From...

Repositioning

NOTE

Same page
Next page
Top

From...

Repositioning > Type of memaorization

Updates and redisplays the current page.
This choice is displayed only if you have modified the contents of the window.
(Equivalent host choice cH: J1).

If you have not modified the contents of the window, this choice displays the
next page. If there is no next page, the same page is redisplayed.

If you have modified the contents of the window, this choice updates the current
page and displays the next page. If there is no next page, the same page is
redisplayed. if the update was unsuccessful, an error message and the current
page are displayed.

(Equivalent host choice CH: JF)

Displays the first page of the Formatted Description.
If you have modified the contents of the window and if the update was
unsuccessful, an error message and the current page are displayed.

Updates the current page and opens the From... dialog box in which you enter
the position from which the description is to be displayed.

if the update was unsuccessful, an error message and the current page are
displayed.

Each position you indicate in this dialog box will be memorized. These positions
can be requested again via the Repositioning choice.

For complete details of the From... dialog box, refer to chapter “Navigation in
the WorkStation”, subchapter “Auxiliary Dialog Boxes”.

= Type of memorization

Opens the Position Memorization dialog box. In this box, select the type of
memorization you want;

Explicit Memorization
This type of memaorization memorizes each display position specified via the
From command of the Display menu as a sub-choice of the Repositioning
choice.

Implicit Memorization
This type of memorization memorizes each current position you obtained
through a simple transmit as a sub-choice of the Repositioning choice.

You can select both types of memorization in the Position Memorization

dialog box. The Repositioning choice can store up to 20 positions while the
window remains open.
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The Special Choices Menu

Special choices
Differences between sessions...

Search string...

Replace string...

Renumber...
Differences between sessions...

This command is operational in the following descriptions:

= Programs (CH: P ------ B, -CP, -CD, -SC, -W, -P, -CP, -XP)
= Screens (CH:O------ B, -CP, -CS, -CE, -W, -P, -CP, -XP)
= Data Elements (CH: E ------ D)

= Segments (CH: S ---- SS, -SE, -CE)

= Database Blocks (CH: B ------ DH, -DC, DT, DR)
= Volume (CH:V------ D)
=  Comments (CH: - ------ G)

= Report (CH: R--- D, -L, -CE)

For full information, see the User Interface Guide, “Online Access Language”,
subchapter “Differences between Sessions”.

This command opens the Difference between Sessions dialog box in which you
request the session number (and version) you require instead of the session of
your current context.

For a detailed description of this dialog box, see the subchapter “Auxiliary
Dialog Boxes”.

Search string...
Replace string...

These commands are operational in the following descriptions:

= Screen Procedural Code (CH: O ------ P)
= Screen Work Areas (CH: O ------ w)
= Macro-structure calls in the Screen (CH: O ------ CP)
= Program Procedural Code (CH: P --—--- P)
=  Program Work Areas (CH: P --—--- w)
= Reverse Engineered Source Code (CH: P —-=--- SC)
= Procedural Code (Cobol) (CH: P === 9)
= Macro-structure calls in the Program (CH: P —----- CP)

and in the following cross-references:
= Used in the Screen (CH: O ------ XP)
= Used in the Program (CH: P ------ XP)

For full information, see the User Interface Guide, chapter “Text Editing
Facilities”, subchapter “Editing from the Choice field”.
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Search string...

Replace string...

Renumber...

Opens the Search dialog box in which you enter the character string to be
searched for.

For a detailed description of this dialog box, see subchapter “Auxiliary Dialog
Boxes”.
Opens up the Replace dialog box in which you enter the character string to be

replaced and the new character string.

For a detailed description of this dialog box, see the subchapter “Auxiliary
Dialog Boxes”.

The Renumber facility is operational in the following screens:

= Screen Procedural Code (CH: O ------ P)
= Screen Work Areas (CH: O ------ w)
= Screen Call of Elements (CH: O ------ CE)
=  Segment Call of Elements (CH: S ------ CE)
= Program Procedural Code (CH: P ------ P)
=  Program Work Areas (CH: P ------ w)
= Reverse Engineered Source Code (CH: P ------ SC)
= Procedural Code (Cobol) (CH: P --—--- 9)

For full information, see the User Interface Guide, chapter “Text Editing
Facilities”, subchapter “Editing from the Choice field".

This command opens the Renumber dialog box in which you may specify a line
renumbering increment (default value: 20).

For a description of this dialog box, see subchapter “Auxiliary Dialog Boxes”.
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The View... Command

View... Opens the View dialog box.

This command is available with the following Formatted Description windows:

=  General Documentation of occurrences of any entity (C1, C2):
General Documentation

= Screen and Program entities (C1, C2):
Beginning Insertions
Work Areas
Procedural Code
Procedure Titles & Conditions
Procedural Code (coBoL)
Procedural Code (8)

= Screen entity (C1, C2):
Call of Elements

= Program Entity (C1, C2)
Procedures generated

= Segment entity (C1, C2, C3):
Call of Elements

= Report entity (C1, C2):
Structures

= Document (C1, C2):
Table of Contents

For information on the C1, C2, and C3 views, refer to the Host Reference
Documentation which corresponds to the specific entity.

This command allows you to display Formatted Description windows according
to different views (C1, C2, C3), as available when working in Emulation mode.
Select icons to change the Database sub-network and the display option.

You may open a Formatted Description window several times so as to visualize
simultaneously the various "views" available for one occurrence.

For a complete description of the View dialog box, see the chapter “The Host
Occurrence List Window”, subchapter “Auxiliary Dialog Boxes”.
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The Options Menu

Options

Stay on Source

Go to Target

Stay on Source
Go to Target

This menu allows you to set a branching mode once you have created or
modified a description by duplication or deleted a description from the
Description window of another occurrence. A check mark next to a command
indicates the current mode.

Duplication operating mode
Type over the source occurrence code with the target occurrence code.
Attention should be paid to the correspondence of description line identifiers.

For complete details on duplication of descriptions, see the User Interface
Guide:

= subchapter “Online Updating” in chapter “Online Access Language”

= subchapter “Editing from the Action Code” in chapter “Text Editing
Facilities”.

Special case: Program and Screen Entities

The lines of the Formatted description entitled Procedural Code for an
occurrence of a Program can be copied into the Formatted description entitled
Procedural Code for an occurrence of a Screen and vice-versa. Replace the
entity and occurrence codes in the heading of the source screen with the target
entity and occurrences codes. (The same can be done for the Formatted
description entitled Work Areas.)

Displays the description of the source occurrence, after update.

Displays the description of the target occurrence, after update.
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The Screen Menu

Screen Menu Copy Host Screen
Print Host Screen...

Copy Host Screen
Copies the current Host Screen in the SPAC\BASE\SPAC.PRT. When you
select this command, a dialog box offers you either to reinitialize the file, or to
add the screen at the end of the existing file.

Print Host Screen...

Prints the current Host Screen.

The Help Command

?=F1 This command allows you to access the host online help.

For full details see subchapter “The Auxiliary Window: the Help Window.”

The System Menu

System Menu  Context...
Context... Displays the current context.

For more information about the context, refer to the subchapter “Context”,
chapter “WorkStation Connection”.
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The Auxiliary Window: The Help Window

Input help

NOTE

Two types of help are available on Formatted Description windows:
¢ Input help to load unprotected fields with authorized values

¢ General help on the open Description window

To access the input help window corresponding to help on an input field,
position the cursor on the field, select ?=F1 on the menu bar or press F1. A
help page corresponding to the field in question appears.

Cclewr  Edion  [Gigret 7
bredvw  |Blecherche | 00000 | Hisleriges | @ | e

TYPE O LIME

If values have been defined for the field, the help page displays the various
authorized values with explanations. If you select a value (underlined and
located on the left of the screen), the value is input directly and the help page
closes.

The values entered in a field are referenced against the list of authorized values
for the field. This verification is performed each time the cursor leaves a field. If
the value entered is not one of the authorized values, an error message
appears requesting confirmation of the entry. If you confirm the entry, the
incorrect value is accepted (it may subsequently be refused by the host) and the
cursor is positioned in the next field. If you do not confirm the entry, the cursor
is repositioned in the field for a new entry.

If you request online help on the occurrence code of a Formatted Description

window, general screen help appears as there is no specific help on the
occurrence code of a description.

DSREF000254A



13-12

General Help
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Exhas Edvmm Bgrad T

To access the general help window on a Formatted Description window,
position the cursor outside an input field and select ?=F1 on the menu bar or
press F1.
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GENERALIZED DOCUMENTATION
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atkructures,

Refer to the "3.L.3.0.% and "Cli=ncsdervsc™ Reference Mamosls,

“hapTer  "EXTor  Messdgss Help Funcrion®, and ©a che *"Bacch
LIRS S DevElopmant® Pafers=cy Manaal . Chaptac "Erpng
MHeppage=",

. To apecify Dasr R=laticm=hips.

Rafer ©woa tha “Dlerticnary Estanmlbliity® Eefecancs Hanoel,
Chaptsr “The Ussc-Def:nsd R=lationehip®.

» To customlze S0L sccegmes,
Rafut co Tha "Relarional ODacabass DEEcelption® DEOEEEHEG
Manual, Chaptsr “50L RAocEpasmT Aub—tasptes "CuskEcm ized S0

hCceamss",

The use of the Mavasepszelzed Input Rid entity (B_I A.) may
Fasllitate and standasdite davea sstcy cn this sccesn.

GEHEFAL CHRAACTERIETICH

Bk b Qifes

|

T}

A list of data elements constituting the Formatted Description window appears
at the end of the page. These are hypertext links you can use to navigate
through the different data elements.
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Auxiliary Dialog Boxes

The Differences between Sessions Dialog Box

This dialog box is displayed via the Formatted Description window (via
Differences between Sessions... in the Special Choices menu).

In the Difference between Sessions dialog box you request the session humber
(and version) you require instead of the session of your current context.
(Equivalent host choice: CH: .D......).

‘=-| Diff. between sessions
Number: Ii
Yersion; ® Frozen

C Test
" Upgrade
OK Cancel

If you want to actually upgrade the session of your current context with the
differences found in the session indicated in this dialog box, select the Upgrade
check box. (Equivalent host choice: CH: .M......)

When you request the differences between sessions, a check mark appears by
this command. This indicates that the WorkStation is in Differences between
Sessions mode: when you press ENTER to display the next page, the
WorkStation will continue to calculate the difference between sessions. To exit
this mode, choose Differences between sessions in the menu or choose
another command.
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The Search Dialog Box

This dialog box is displayed via the Formatted Description window (via Search
String... in the Special Choices menu).

In this dialog box, you enter the character string to be searched for. The default
delimiter is the blank character.

If the string contains one or more blank characters, specify a unique character
as delimiter (not included in the string).

The radio buttons allow you to choose between:

Equivalent host choice  CH: .S/CHARACTER STRING/
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The Replace Dialog Box

This dialog box is displayed via the Formatted Description window (via Replace
String... in the Special Choices menu).

In this dialog box you enter the character string to be replaced and the new
character string. The default delimiter is the blank character.

‘=-| Replace

Search: Delimiter |_

Replace with:

{begin |>Curr. Line end| > CQccurrence )

@® Step by step O GlobaliDescription C GloballOccurrence

OK Cancel

If the string contains one or more blank characters, specify a unique character
as delimiter (not included in the string).

You may also use beginning and ending keys to define the scope of the search.
The radio buttons allow you to choose between:

A step-by-step replacement (default)
(Equivalent host choice: CH: .C1/STRING1/STRING2/)

A global replacement for a description
(Equivalent host choice: CH: .C2/STRING1/STRING2/)

A global replacement for an occurrence
(Equivalent host choice: CH: .C3/STRING1/STRING2/)
The global replacement (the last two commands) is performed in one go, and
you are notified on completion of the number of replacements and the number
of lines changed. When the new string is longer than the old one, the global
replacement stops at the first replacement where truncation occurs and
continues step-by-step.
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The Renumber Dialog Box

This dialog box is displayed via the Formatted Description window (via
Renumber... in the Special Choices menu).

In it you specify a line renumbering increment (default value: 20).

‘=-| Renumber

BRenumbering increment 20

(from | to )

oK ‘ Cancel

You may also use beginning and ending keys to define the scope of the
renumbering. Renumbering begins by default on the first line displayed and
continues until the end of the entity (limit is one hundred lines). Press ENTER to
renumber the next one hundred lines.

(Equivalent host choice CH: .Rnn)

For full information, see the User Interface Guide, chapter “Text Editing
Facilities”, subchapter “Editing from the Choice field".
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Chapter 14

The Chart Facility Window

FUNCHIONANHES. ...

Getting to the Window
The Menu Bar of the Chart Facility Window
The Entity Menu
The File Menu
The Edit Menu
The Format Menu
The Options Menu

Auxiliary Dialog BOXES............cccceiveeeiiiiiiiiisciieecsie

The Size Dialog Box
The Tab Input Dialog Box

14-1
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Functionalities

NOTE

Input

Cursor

UPLOAD NOTES
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The Chart Facility window is available for the Free Entity only.
For a complete description of the Free Entity, refer to chapter “The Free Entity”.
This window allows you to draw all tables, reports, etc.

When the description created with Chart Facility is called into a Document, it is
printed exactly as it was entered, without any kind of formatting.

The standard format for the Chart Facility window is 80 characters by 24 lines.
The maximum format is 264 characters by 100 lines.

The Default Input mode in this window is TYPEOVER. The INSERT key toggles to
INSERT mode.

Moves the cursor by mouse or keyboard commands:

= Standard direction keys
" TAB: next tab position
" SHIFT-TAB: preceding tab position
= CTRL-[2]: next word
* CTRL-[€]: preceding word
= [R] beginning of the line
= CTRL-[R]: first word on the line
" END: end of the line
= CTRL-END: last word on the line
" ENTER: beginning of the next line
(for the last line: beginning of the line)
"  PAGE UP: preceding page
"  CTRL-PAGE UP: first page
" PAGE DOWN: next page
" CTRL-PAGE DOWN: last page
=  ESCAPE: cancel changes on current line only

The ' ' character (used by itself) is translated by a blank space when the chart
facility is uploaded (and also when downloaded).

The first lines of a chart facility, uploaded on the host, contain tabulations. To
identify these lines, there is a "T" in the fourth position of the "Line" column.
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Getting to the Window

Select a Chart Facility description from the Description List in the Entity dialog
box of the Free Entity.

For details about lists and descriptions in the Entity dialog box, refer to chapter
“Navigation in the WorkStation”.
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The Menu Bar of the Chart Facility Window

Entity

File
Edit
Format
Options

System Menu

This Cascaded menu contains commands that allow you to access the
definition, lists, descriptions and cross-references of the current occurrence of
the Free Entity.

Local saving, restoring and printing.

This menu features standard edit functions.

This menu is used to set the chart size and tab positions.

This menu is used to set the ruler and line number display options.

Allows you to consult the current context.

For complete information, refer to chapter “WorkStation”, subchapter “Context”.
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The Entity Menu

Entity Main Entity = Definition
Lists =>» Available lists
Descriptions => Available descriptions
X-References => Available x-references

Other Occurrence...
Related Entity...

For complete details of this menu, refer to chapter “Navigation in the
WorkStation”, subchapter “The Cascaded Entity Menu”.

The File Menu
File Save
Restore
Print
Printer...
Save Saves the description locally.
Restore Restores the last saved description. All changes made since the last save will
be lost. A message box appears: click OK to restore the last saved description.
Print Allows you to print the description.
Printer... Opens a dialog box that lists the printers connected to the PC. Select a printer

from this list and click oK.
When you click on the Configure... button, another dialog box opens which

contains the parameters associated with the printer driver (paper format and
orientation, specific characteristics, etc.)
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The Edit Menu

Edit
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Add Line

Select Line
Select Block
UnSelect

Copy
Copy + Keep Selection
Paste

Move

Delete

Delete Current Line
Retrieve

If no line or block is selected, the following commands are active: Add Line , Select Line , Select
Block , Delete Current Line and Retrieve . The other commands become active once a line or a block

has been selected.

Add Line

Select Line

Select Block

UnSelect

Copy

Adds a line below the line on which the cursor is positioned. The addition of
lines is limited to the number of lines defined via Size in the Format menu.

The F2 key is a short-cut key.
Selects the line on which the cursor is positioned.

In order to select several consecutive lines, place the cursor on the first line and
select this command. Then place the cursor on the last line and select this
command again. The first and last lines and all lines in between will be
highlighted.

When line numbers are displayed in the left margin, lines can be selected by
clicking on these numbers.

In order to select a block (rectangle section), position the cursor on the upper
left corner of the section, activate Select Block . Then position the cursor on the
lower right corner of the section and select this command again.

De-selects the selected line(s) or block.
Duplicates the selected line(s) or block.
If you select one or more lines, they will be copied below the selected line (or
lines) on which the cursor is placed. If a block is selected, it is copied to where

the cursor is placed. To copy the selection into another chart, position the
cursor in the target field and use Paste.

Copy + Keep Selection

Paste

Duplicates the selected line(s) or block. Once duplicated, elements remain
selected.

Inserts the contents of the Clipboard into another chart, to where the cursor is
placed.

If the length of the description defined in the Size dialog box is likely to be

exceeded, a message is displayed to asks you whether you want to paste or
not.
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Move

Delete
Delete Current Line

Retrieve

The Format Menu

Format

Dimensions...

Tabs...

The Options Menu

Options

Show ruler

Display line numbers

14-7
If necessary, the format of the target description is modified in order to take the
inserted text into account.

Moves the selected line(s) or block to where the cursor is positioned. Once
moved, elements are de-selected.

If a line (or lines) is selected, it is moved below the selected line (or lines) on
which the cursor is placed. If a block is selected, it is moved to where the cursor
is placed.

Deletes the selected line(s) or block.

Deletes the line on which the cursor is positioned.

Use this command to retrieve, one by one, up to ten deleted lines (a deleted
block cannot be retrieved).

Size...
Tabs...

Opens a dialog box in which you can define the dimensions of the chart facility.
For a description of this dialog box, refer to subchapter “Auxiliary Dialog Boxes”.

Opens a dialog box in which you can view and/or update tab stops. For a
description of this dialog box, refer to subchapter “Auxiliary Dialog Boxes”.

Show Ruler
Display line numbers

When a command in this menu is active, it is checked.

Displays a graduated ruler and tab stops identified by ">" marks.

Displays 3-digit line numbers in the left margin.
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Auxiliary Dialog Boxes

The Size Dialog Box
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This dialog box is displayed via the Chart Facility window (via Size... in the
Format menu). It allows you to define the size of the chart.

‘=-| Size
Number of Lines 24
Number of Columns 80

OK Cancel

¢ Number of Lines: default value 24, maximum 100

*  Number of Columns: default value 80, maximum 264

Once the size is set, the Chart Facility window is adjusted accordingly. If you
reduce the size of the Chart Facility window, the lines that are not contained in
the reduced Chart Facility window will be erased.

You can create a description smaller than the standard format. If you do, this
description will have standard format. If the description is larger than the
standard format, this description will have the same format, when it is next
opened, as when it was created.
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The Tab Input Dialog Box

This dialog box is displayed via the Chart Facility window (via Tabs... in the
Format window). It allows you to consult and/or update tab positions.

A tab position is defined by a nhumber which corresponds to a place on a ruler
(see Show Ruler in the Options menu).

‘=-| Tab Input

Number of columns : g0 0K

-Tabs
; hd Create Cancel
o

Value : I 15 Modify

20
25
30 El Delete

The dialog box contains:

An area displaying the number of columns specified in the Size dialog box
A list box that lists the tab positions (by default 1, 5, 10, etc.)

An input area for you to specify tab positions

Three buttons (Create, Modify and Delete) for update operations

oK and Cancel buttons

To create a tab position, enter the appropriate number and click on Create.

To modify a tab position, select the number in the list box, type over the value in
the input field and click on Modify .

To delete a tab position, select the number in the list box and click on Delete.

When you change tab positions, text in the Chart Facility window created with
the old tab positions remains the same.
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Local Screen Mapping, described in the next chapter “The Local Mapping and
Simulation Windows”, requires the local presence of an extract from the
Specifications Database. This extract (called the Local Repository) consists of
definitions and descriptions of selected Attributes/Data Elements. This chapter
describes the extraction process of the Local Repository.

In order to obtain a Local Repository, you must extract the relevant Attributes /
Data Elements from the Specifications Database. This is the purpose of the
Data Extraction windows.

One of the Data Extraction windows, called the Data Element Extraction
window, contains the extraction diagram. Most of the entities displayed in this
extraction diagram directly or indirectly call Attribute or Data Elements.

When you select an occurrence for extraction, only the Attributes / Data
Elements called (directly or indirectly) in this occurrence are extracted for
consultation only. The occurrence itself is not extracted.

Getting to the Windows

NOTE

A host connection is required.

Access the Data Extraction windows from the WorkStation Manager window
using Data Extraction in the Host-Access menu.

The Data Extraction feature includes the following windows:

1. The first window displayed (access described above) is the Data Element
Extraction window. It displays an Entity-Relationship Extraction diagram.

2. Access the Host Occurrence List window by clicking an entity Host-Access
button in this extraction diagram.

3. The Extraction Requests window opens automatically when you select
occurrences for extraction, or when you select Show List in the Requests
menu in the Data Element Extraction window.

4. Access the Local Repository window by selecting Local Repository! in the
Data Element Extraction window.

The Data Element Extraction window can also be accessed from the
Launch menu in the Local Mapping window.
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Functionalities of the Data Element Extraction Window

The Data Element Extraction window displays an extraction diagram.

This extraction diagram displays all the entities from which it is possible to
extract Attributes / Data Elements occurrences:

The extraction diagram displayed on your WorkStation corresponds to the
methodology installed.

All examples given in this chapter, including the previous extraction diagram,
correspond to the Merise methodology. For information concerning your
methodology, refer to the on-line help in the WorkStation.

| Dats Llement Exraction [
Respaesis  Locsl Hotionargd

e s Gystem

| Gorsnplual Durla Mode Logical Dila Mo

| Citslngrie | | Soreen Havigation {ha |

There are two ways to select occurrences of these entities: (1) access their
Host Occurrence List or (2) access a given occurrence directly if you know its
code beforehand.

1. Click on an entity button. This opens a From... dialog box in which you enter
a Start Key (i.e. an occurrence code). The list of host occurrences for the
specified entity is displayed.

See subchapter “Introduction to the Host Occurrence List Window”.

2. Press the sHIFT key and click on an entity button. The New Extraction
Request dialog box opens up in which you enter an occurrence code for a
new extraction request. Enter the occurrence code to be added to the
Extraction Requests window.

See subchapter “The Extraction Requests Window”.
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The Menu Bar of the Data Element Extraction Window

The Requests Menu

Requests

Show List

Save

Restore

Show List/Hide List

Save
Restore

Opens up the Extraction Requests window, which lists occurrences already
selected for extraction. If the list is already displayed the command label is
Hide List . Select it to hide the list.

See subchapter “The Extraction Requests Window”.

Saves Extraction Requests.

Restores the Extraction Requests: all changes made in the extraction requests
since the last save will be lost.

The Local Repository! Command

Local Repository!

Opens up the Local Repository window which lists all the Attribute / Data
Element occurrences already extracted from the Specifications Database. This
local Repository is for consultation only. The descriptions of the Data Elements
contained cannot be modified. This list is updated after each extraction or after
deletion of data elements considered as useless locally.

See subchapter “The Local Repository Window”.
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Functionalities of the Host Occurrence List Window

The Host Occurrence List window allows you to:

Consult online the Specifications Database contents in the form of
occurrence lists sorted by occurrence code

Select occurrences in order to extract their Attributes / Data Elements from
the Specifications Database

=| Segment

Display Selection!

Code Name Libr.
AB MLD LOCATION *APR
ABIT ABONNEMENT *APR
AR AR 0625
ARDD ARDD 0625
BB TEST EXTRACTION 0385
BBOO TEST EXTRACTION 0770
BBO& TEST EXTRACTION 0473
BB10 TEST EXTRACTION 0770
BBZ0 TEST EXTRACTION 0385
BC DBD RELATIONMNEL *CEN
BC10 SEGMENT DBD 0368
BC20 TEST DEDR *CEN
BC30 Test date oracle 0273
BC40 test 0067
BCh0 test 0067
BCI0 SEGMENT DBD *CEN
BC99 BC99 0250

The window displays:

The occurrence code
The occurrence name

An asterisk (*) in the Libr. column if the occurrence is a child Attribute/ Data
Element or (a child) Object

A plus (+) (only in the Attribute/Data Element list) if the occurrence has a
defined internal format (only these types of occurrences can be extracted)

The code of the Library where the occurrence is defined, or the session
number if the occurrence is defined in the connection Library
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The Menu Bar of the Host Occurrence List Window

The Entity Menu

Entity Main entity = Definition...
Lists => Available lists
Descriptions => Available descriptions
X-references => Available X-references

Different occurrence...
Related entity...

For full details of this menu, see the chapter “Navigation in the WorkStation”,
subchapter “The Cascaded Entity Menu”.
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The Display Menu

Display Next Page
Same Page
Top
From...
Next Page Displays the next page of the Host Occurrence List.
NOTE Pressing the ENTER key has the same effect.
Same Page Re-displays the same page. This command is used to display an updated

version of the Host Occurrence List. For example, use this command to view
new occurrences which may have been defined after the opening of this

window.
Top Re-displays the list from the beginning.
From... Opens the From... dialog box in which you enter the position from which the list

is to be displayed.

For a complete description of the From... dialog box, refer to chapter
“Navigation in the WorkStation”, subchapter “Auxiliary Dialog Boxes”.
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The Selection Menu

Selection

Selection!

Selection!
Elementary Components

Adds the selected occurrence(s) to the Extraction Requests window.

Automatically opens the Extraction Requests window.

Elementary Components

NOTE

The elementary components (shown next to their corresponding entity below)
are available for the following entities:

» Business System: Conceptual Data Model
= Conceptual Data Model (CDM):  Objects, Relationships

= Logical Data Model (LDM): Segments
= Screen Flow Chart: Screens
= Dialog Screens

These elementary components are displayed in the Extraction Diagram.

When the Host Occurrence List window is open for any one of these entities,
their corresponding elementary components appear as a command in the
Selection menu.

These commands are used to add the elementary component of the selected
occurrence to the Extraction Requests window. They automatically open the
Extraction Requests window.

For details regarding extraction, see subchapter “The Extraction Requests
Window”.
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The Extraction Requests window allows you to consult and modify your
extraction requests.

=-| Extraction Hequests
Edit Extraction
Entity Code Mame Libr.
DOM DOM ptil 0825
DOM DOMP ptil *APR
DOM FADOM Domaine créé par FA Modif FB 0287
RUB .BANS2 Contenu du Graphe *APR
H|{RUB .LIBG3 Description Non Formaté *APR |H

The list contains:

The entity local code
The occurrence code
The occurrence name

The Library code
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The Menu Bar of the Extraction Requests Window

The Edit Menu

Edit Delete
Delete All Lines

Add *PASWD (IMS only)
Delete Deletes the selected Extraction Request line.
Delete All Lines Deletes all Extraction Request lines.
Add *PASWD (IMS only)
Adds the special Data Element PASWD to the list of extraction requests (for

IMS host only).

NOTE The special Data Element ERMSG is always automatically extracted.
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The Extraction Menu

Extraction Extraction only
File deletion + Extraction

The Data Element extraction process is a "Cascaded process" which follows the
structure of the extraction diagram. For example:

If you click on Business System , the Business System Host Occurrence List
window opens. Select an occurrence and Selection! in the Selection menu:
the occurrence is stored in the Extraction Requests window.

When you select Extraction only in the Extraction menu of the Extraction
Requests window, the following is performed automatically:

* The occurrence is selected and disappears

* The CDMs included in the previous occurrence are displayed one-by-one in
the Extraction Requests window

(each CDM is selected, one-by-one, and all the Objects and Relationships
included in each CDM are added to the Extraction Requests window)

* Each Object/Relationship included in the previous CDMs is selected, one-
by-one, and added to the Extraction Requests window

(each Attribute / Data Element is extracted and added to the Local
Repository)

If the extracted Data Element is already present in the Local Repository, it is
refreshed.

Data pertaining to Parent Data Elements are also extracted.

The extraction process may be stopped at any time via the dialog box displayed
during the extraction, however all Attributes / Data Elements of the occurrence
currently being processed will be fully extracted.

Extraction only Triggers the extraction of the Attributes/ Data Elements for the occurrences
listed in the window. The extracted Attributes / Data Elements are added to, or
refresh, the Local Repository.

File deletion + Extraction
Deletes the existing Local Repository file and triggers the extraction process for
the occurrences listed in the window. The Local Repository then contains the
result of the extraction. This allows you to renew the entities of the existing
Local Repository.

DSREF000254A



15-12

VisualAge Pacbase WorkStation Reference Manual

Functionalities of the Local Repository Window

NOTES

The Local Repository window allows you to consult and modify the list of

extracted Data Elements.

= Local Dictionary

Contents... Delete!

.BANS? Contenu du Graphe

.LoDoc CodOcc

.DOMP Domaine Pére

.EVRP test ptil

.LIBEG3 Description Non Formaté

BCC DATE C

BCG DATE g

ERMSG *** Error Message ™
MBCODD HUBRIQUE FILLE : APPEL DANS
MBRUBA RUBRIQUE ELEMENTAIRE apr
MBRUBB RUBRIQUE ELEMENTAIRE

Mouse functionalities:

* right click: branch to the definition and description of the selected

occurrence

* |eft click: selection or shift selection

* Citrl + left click: multiple selection / de- selection line-by-line

* Shift + left click: multiple selection by block

If a local map is open during an extraction, its Local Repository window is
updated with the result of the extraction.

If you delete Data Elements (present in the open map) from the Local
Repository window, they will be deleted from the map if you save the map. (If
you want to keep the Data Elements in the map do not save the map.)

DSREF000254A



Data Extraction Windows 15-13

The Menu Bar of the Local Repository Window

The Contents... Command

Contents... Select a line in the Local Repository window and this command to open up the
Data Elements Contents dialog box. This dialog box contains the formats,
labels and values of the selected Data Element.

To open the Contents dialog box for the selected Data Element, you can also
click on a line in the Local Repository window with the right mouse button.

Selecting a new occurrence with the right mouse button in the Local Repository
window will change the contents in this dialog box for the selected occurrence.

The Delete! Command

Delete! Deletes the selected line from the list: the Attribute / Data Element occurrence
selected will be removed from the Local Repository. (This does not delete the
occurrence itself.) You can remove several Attributes / Data Elements at the
same time if you select several lines.
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Chapter 16 The Local Mapping and Simulation Windows
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The Local Mapping and Simulation features are only operational for the Screen
and C/S Screen (Pacbench module only) entities. These features use the Local
Repository which is extracted from the Specifications Database. (See chapter
The Data Extraction Windows”.)

The Local Mapping feature allows the same operations as the Host Mapping
screen (CH: 0.....M). In addition, Local Mapping benefits from all the user-
friendliness offered by the graphical user interface and the mouse.

When a local map is loaded or when the map size is modified, scroll bars
appear and make it possible to visualize the non-visible parts if the display area
is not big enough to contain it totally.

Once the screen map is built with the Local Mapping feature, field positioning
and characteristics can be checked by using Local Simulation. With Local
Simulation you see the Screen map as it will be displayed during actual
execution.

The Screen Description (Call of Elements) is implicitly updated once the Screen
map is uploaded to the Specifications Database.

For complete information (including information concerning screen branching),
refer to the Online Systems Development Reference Manual, chapter “Definition
and Description of a Dialog or Screen”, subchapter “Screen Mapping, and
chapter “Dialog Simulation”.

Screen Download

Specifications Dictionary Data Extraction

HOST
PC
Screenl
Local
Screen2 Dictionary
Screen3

Local Mapping & Simulation
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Functionalities of Local Mapping

Before proceeding to mapping operations, make sure of the following:

The Screen is defined as well as the Dialog to which it belongs

All Screens called in the map are downloaded and all Data Elements used in
the Screen map are extracted from the Specifications Database

If the WorkStation finds that some called Screens or Data Elements used in
the map are missing (RUB = Data Element in the MERISE methodology), it
displays their list and offers to download or extract them.

For complete details on Data Extraction, refer to chapter “The Data
Extraction Windows”.

Downloading a map will download the called Screens and prompts you to
download the branched Screens. The download of the associated Screens is
parameterized by the option chosen via Screen in the Download sub-menu
of the Preferences menu in the WorkStation Manager window. The
confirmation dialog box (in the case of a calling Screen) includes a “Cancel”
button to stop the download of the calling Screen. If an associated Screen
has itself associated Screens, the download of these Screens is also
parameterized by the same option.

Use the mouse for mapping operations:

For selecting, positioning or moving one or several elements in the map

For changing the characteristics of a selected element

For creating or modifying a Repetitive category

For scrolling down, up, right and left with the scroll bars. The presence of
these bars depends on the number of lines and columns of the screen to be

mapped (General characteristics... in the Presentation menu)

The location of the mouse pointer in the window is indicated (line and
column position) in the upper-right hand corner of the window.
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Getting to the Local Mapping Window
Access the Local Mapping feature:
* From the Description list (Local Mapping) of the Screen Entity dialog box
* From the Local Maps list of the Screen Entity dialog box
* From the Local Simulation window, via Local Mapping in the Actions menu

This access - being local - does not require a connection to the host.

Category Management

Triangular marks in the left margin of the Local Mapping window define the
Repetitive category. The area between the marks is the Repetitive category.
The area above the marks is the Heading. The area below the marks is the
Screen Bottom.

These marks may be moved up and down so as to exclude or include fields
from or in the Repetitive category, respectively. In such cases, the number of
lines per occurrence and the number of occurrences in the Repetitive are
updated. When the upper triangle mark is moved the space separating the
items in the repetitive category is increased/decreased. When you move the
lower triangle mark you increase or decrease the number of repetitions of the
items in the repetitive category.

Screen elements may belong to a category without being physically present in
the corresponding area. For complete information, refer to the Update dialog
boxes in subchapter “Auxiliary Dialog Boxes”.

Adding Elements to the Map

* To add a Data Element to the Screen map:
= Select the Data Element... command of the Elements menu
= Double-click the desired Data Element in the displayed Local Repository

= Position the cursor on the desired location on the Screen map (the form
of the cursor indicates that a Data Element is being added)

= Click to position the Data Element on the map. Press ESCAPE or click on
the right mouse button to stop the operation

= The category to which the element belongs is automatically deduced from
its location on the map. To change -categories, see "Category
Management"
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NOTE

* To add a Label to the Screen map:

Select Label in the Elements menu, click on the map and key in the label
(maximum length: 30 characters) directly on the map

Press ENTER, click mouse or select a menu to end the label input mode
(and validate it). To erase the label entered, press ESC

A label may be one character repeated n times. In this case, enter "nnn*".
"*" stands for the character to be repeated and "nnn" is a three digit
number (number of repetitions)

The category to which the label belongs is automatically deduced from its
location on the map. To change categories, see "Category Management"

* To add a Dialog Title or Screen (contents or title) to the Screen map:

Select Screen... in the Elements menu

Select a Screen or Dialog from the displayed list
Click on the Title or Contents radio buttons
Double-click on the desired Screen/Dialog

NOTE:
For a Dialog, only the title can be added.

Position the cursor on the desired location on the Screen map (the form
of the cursor indicates that a Screen map is being added)

Click to position the title or contents on the map. Press ESCAPE or click on
the right mouse button to stop the operation

The category to which the title or contents belong is automatically
deduced from its location on the map. To change categories, see
"Category Management"”

(when adding a Dialog Title to the Screen map): When the Screen map that
you are working on belongs to a certain Dialog, e.g. PT, the following will
occur:

If a different Dialog, e.g. DF, is selected to be placed on the screen, the
title of this Dialog will appear where you place this Dialog on the Screen
map.

However, if you select the same Dialog (in this case, PT), the title of the
current Screen will appear where you place this Dialog on the Screen
map. For complete information, refer to the Online Systems Development
Reference Manual.
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Updating Elements in the Map

Selections

To update an element on the map, double-click on it. A dialog box will open. For
details concerning these dialog boxes, refer to the corresponding Update Dialog
Box in subchapter “Auxiliary Dialog Boxes”.

To select an element (field, label, or screen), click on it with the left mouse
button: the selected element is framed by a dotted line.To de-select, use the
right mouse button.

When several elements of a map are superimposed and you want to select one
of them, press ALT and click to select each element in turn.

To select a group of elements, point to the upper-left corner of the area which
contains the desired group and drag the mouse without releasing the button
until the rectangle outlines all the elements of the group. Release the mouse
button: each selected element is framed by a dotted line.

You can move, cut, copy, paste and delete a selection. See the Edit menu.
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The Menu Bar of the Local Mapping Window

Entity

File
Elements
Edit

Presentation

Launch Menu

System Menu

This Cascaded menu contains commands that allow you to access the
definition, lists, descriptions and cross-references of the current occurrence of
the Screen entity.

This menu allows you to save, restore, print and change printer parameters.
This menu allows you to add a Data Element, a Label, or a Screen to the map.
This menu allows you to copy, cut, paste, delete or repaint.

This menu allows you to modify the general characteristics of the Screen and
field attributes and to modify Data Element presentation in the Repetitive and
Screen Bottom categories.

This menu allows you to open the Local Simulation and the Data Element
Extraction windows.

In addition to the standard commands, this menu contains a command that
displays the current context.

For information concerning the context, refer to chapter “WorkStation
Connection”, subchapter “Context”.
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The Entity Menu

Entity Main Entity = Definition
Lists =>» Available lists
Descriptions => Available descriptions
X-References => Available x-references

Other Occurrence...
Related Entity...

For complete details about this menu, refer to chapter “Navigation in the
WorkStation”, subchapter “The Cascaded Entity Menu”.
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The File Menu

File

Save

Restore

Print

Printer...

Restore

Save

Print
Printer...

Saves the current screen map. If the downloaded map includes relative
positions, they will be automatically changed to absolute positions.

You should save the map before requesting the screen simulation. See the
Simulation! command.

If your map contains overlapping elements, a dialog box opens to inform you of
overlapping elements. It displays a list of the codes of the overlapping elements,
their location and their type: for the Merise methodology R = Data Element, and
for all other methodologies D = Data Element. When you finish consulting this
list, click OK to close the window and to save the map.

Restores the last saved map.
Prints the Screen map. A dialog box allows you to cancel printing.

Opens a dialog box listing the printers connected to your PC. Select a printer
from this list and click oK.

If you click on the Configure... button, another dialog box opens which contains

the parameters associated with the printer driver (paper format and orientation,
specific characteristics, etc.).
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The Elements Menu

Elements

Data Element...
Label
Screen...

When you add an element to the Screen map, the position of the element must be consistent with the
size of the map. The first character of the element will be inserted where you click the cursor. If the
element is too long and cannot be inserted in this particular place, a message offers to shift it to the
left or upward, if possible. This may also happen when you try to move an element or group of

elements.

Data Element...

Label

Screen...

Opens the Local Repository window which lists extracted Data Elements.

For details concerning how to add Data Elements in this list to the map, refer to
subchapter “Functionalities” under Adding Elements to the Map.

For complete details concerning how to add Data Elements to this window, refer
to chapter “The Data Extraction Windows”, subchapter “The Local Repository
Window”.

Select this command, click on the map and key in the label (maximum length:
30 characters) directly on the map.

For complete details concerning how to add Labels to the map, refer to
subchapter “Functionalities” under “Adding Elements to the Map”.

Opens the list of downloaded Screens and Dialogs.

For complete details concerning how to add Screens and Dialogs to the map,
refer to subchapter “Functionalities” under Adding Elements to the Map.
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The Edit Menu

Edit Cut
Copy
Paste
Delete
Repaint
Cut Erases the selected group from the map and transfers it to the Clipboard.
Copy Copies the selected group from the map to the Clipboard.
Paste Calls the group from the Clipboard and places it on the map where you position

the cursor after activation of this command.
This command is active only when the Clipboard contains a group compatible
with a Screen map.

Delete Deletes the selection without modifying the Clipboard contents.

Repaint Repaints the Screen map.
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The Presentation Menu

Presentation

General characteristics...
Display Attributes...

Repetitive...
Screen Bottom...

Preferences...

This menu allows you to set the Screen and the Data Element general characteristics and display
attributes, as well as those of the Repetitive and Screen Bottom categories.

Some of the options in the dialog boxes opened by the following two commands are also set via the
Screen Definition window (Pacbench only).

General characteristics...

Display Attributes...

Repetitive...

Screen Bottom...

Preferences ...

Launch Menu

Launch

Simulation

Opens the General Characteristics dialog box in which you set the Screen
general characteristics (default values are set in the Definition screen of the
Dialog).

For a description of this dialog box, refer to subchapter “Auxiliary Dialog Boxes”.

Opens the Display Attributes dialog box in which you set the Screen field, label,
and error message display attributes (default values are set in the Definition
screen of the Dialog). Color attributes are only visualized on the local mapping
window. The other attributes are visualized during simulation.

For a description of this dialog box, refer to subchapter “Auxiliary Dialog Boxes”.
Available if the repetitive category exists. Opens the Repetitive Category dialog
box in which you set the label type of the repetitive category. The default option

is set in the dialog box (in its Data Element Label Type section) obtained via
General Characteristics... in the Presentation menu.

For a description of this dialog box, refer to subchapter “Auxiliary Dialog Boxes”.
Available if the screen bottom category exists. Opens the Screen Bottom
category dialog box in which you set the label type of the screen bottom
category. The default option is set in the dialog box (in its Data Element Label

Type section) obtained via General Characteristics... in the Presentation
menu.

For a description of this dialog box, refer to subchapter “Auxiliary Dialog Boxes”.

This command leads you to the Preferences dialog box common to both local
mapping and simulation.

For a description of this dialog box, refer to subchapter “Auxiliary Dialog Boxes”.

Simulation
Data Extraction

Displays the Local Simulation window. If a Local Simulation Window is already
open for this map, this command opens a new Simulation window.
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Save your local map before to request its simulation. You can request an
automatic backup before the simulation (with or without any confirmation
message) from the Preferences... command from the Presentation menu in
the Local Mapping window.

If you haven't saved your map while you've carried out modifications, your
simulation will be obsolete. If the Simulation window is already open, save the
map in the Local Mapping window and use the Repaint command from the
Actions menu to simulate the current map.

The screen branching is possible during the local simulation. For more
information, refer to the Online Systems Developement Reference Manual.

Data Extraction Displays the Data Element Extraction window. For a description of this window,
refer to chapter “Data Extraction”.
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Functionalities of Local Simulation

A screen simulation may be requested if a map of the Screen exists locally. For
complete details on Local Mapping, refer to the Local Mapping subchapters.

Input fields on the simulation screen are identified by the cursor shape (an
underscore). Protected fields are identified by a highlighted cursor. You can
display field attributes via Attributes in the Preferences menu.

Colors set through the Display Attributes dialog box or in Definition screen of
the Dialog are effective in the Local Simulation if the Host Colors mode is
selected via Colors... in the Preferences Menu in the Local Simulation window.

Since you can modify the size of the simulation window, and since the
simulated screen might be bigger than the display space in the window, vertical
and horizontal scroll bars are available to help you move in the window.

Save your local map before requesting its simulation. You can request an
automatic save before simulation (with or without confirmation message) via
Preferences... in the Presentation menu in the Local Mapping window.

If you do not save the map and if you have made modifications, you will obtain
an obsolete map simulation. However, if the simulation window is already
opened, save the map in the local mapping window and use Repaint in the
Action menu in the Local Simulation window to simulate the current state of the
map.

Screen branching is possible during Local Simulation. For complete information,
refer to the Online Systems Development Reference Manual.

Getting to the Local Simulation Window
Access the Local Simulation:

* From the Screen Local Mapping window, via the Simulation! command

* From the Screen Entity dialog box or the Cascaded menu of a window of the
same occurrence of the entity

This access - being local - does not require a host connection.
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The Menu Bar of the Local Simulation Window

Entity This Cascaded menu contains commands that allow you to access the
definition, lists, descriptions and cross-references of the current occurrence of
the Screen entity.

Actions This menu features the following facilities: print, printer parameters, access to
local mapping, and repaint.

Preferences This menu allows you to specify the colors of the simulation and to display the
attributes of the input fields.

System Menu In addition to the standard commands, this menu contains a command that
displays the current context.

For more information, refer to chapter “WorkStation Connection”, subchapter
“Context”.
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The Entity Menu

Entity

The Actions Menu

Actions

Print

Printer...

Local Mapping

Repaint

VisualAge Pacbase WorkStation Reference Manual

Main Entity =>» Definition
Lists =>» Available lists
Descriptions => Available descriptions
X-References => Available x-references

Other Occurrence...
Related Entity...

For complete details about this menu, refer to chapter “Navigation in the
WorkStation”, subchapter “The Cascaded Entity Menu”.

Print
Printer...

Local Mapping

Repaint
Prints the simulated screen. A dialog box allows you to cancel printing.
Opens a dialog box listing the printers connected to the PC.

Another dialog box opens containing the parameters associated with the printer
driver (paper format and orientation, specific characteristics, etc.).

Opens the Local Mapping window for the current Screen map. If the Local
Mapping window is already open, it is reactivated.

Incorporates changes saved during Local Mapping into the Local Simulation of
the Screen.
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The Preferences Menu

Preferences Menu
Print mode...
Colors...
Attributes

Print mode... Displays a dialog box in which you indicate which colors the simulation will be
printed in (black and white or color).

Colors... Displays the Colors dialog box in which you change the colors of this window.
For more information refer to subchapter “Auxiliary Dialog Boxes”.

Attributes Allows you to display the attributes of the input fields. A check mark indicates
that this display is active.
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Auxiliary Dialog Boxes

The Data Element Update Dialog Box

This dialog box is displayed when you double-click on a Data Element in the
Local Mapping window.
—| Data Element Update: ERMSG
Hature of the Data Elament Labe|
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Default Detault Datault *
Mormal Mormmal Marmmal |
Bright Blinking Re] | Contents_ I
Dark Renverse viden Yedlnw
Uricleriimaead Grown
oK Default Restora | | Gancel

Nature of the Data Element
Select the nature of the Data Element. Set the default Data Element nature
via Preferences... in the Presentation menu.

Label type
Select the type of label. If you select a column heading in this list box and it
does not exist for the Data Element, the long label will be used. In order to
see the column label and long label, select the Contents... button to open
the Contents dialog box.

Cursor positioning
Use this option to place the cursor on the Data Element during simulation.
(This option is available only if the Data Element field is updatable.) If no
Data Element has been specified as cursor bearer, the cursor will
automatically be positioned on the first screen input field when simulated.

Position
Indicate the position of the Data Element, i.e. the Line and Column .

Category
Select the category of the Data Element.

You can transfer a Data Element from the Heading to the Screen Bottom
category (and vice-versa) or from the Repetitive category to the Heading
or Screen Bottom categories without changing its physical position on the
map. To do so, change its category in this Data Element Update dialog
box.
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Transferring a Data Element to the Repetitive category is possible only by
physically locating the Data Element in the Repetitive category. See
"Category Management" in subchapter “Functionalities”.

Repetitions
Indicate the number of times the Data Element is repeated horizontally and
vertically.

Literal

In the edit box, enter the value to be loaded into the Data Element. Select
No value and the value in the edit box is not taken into account. Select
Initial value and the value in the edit box is used as the initial value for the
Data Element. Select Presentation value (simulation) and the value in the
edit box is used only during the simulation. Select Indicator number (IBM
36 and 38) and the value in the edit box is used as a indicator number for
IBM 36 and 38.

For a description of these values, refer to the OLSD Reference Manual
chapter “Definition and Description of a Dialogue or Screen”, subchapter
“Screen Call of Elements (-CE)” under Type of Literal.

Intensity
Select the intensity display attribute of the Data Element.

Presentation
Select the presentation display attribute of the Data Element.

Color
Select the color display attribute of the Data Element.

Contents...
Opens the Contents dialog box of the selected Data Element. This dialog
box contains the name, format, length, label, and presentation value.

OK
Select this button to save the changes made and close this dialog box.

Default
Select this button to update this dialog box with the default values of the
Data Element in the local repository.

Restore
Select this button to cancel all modifications made in this dialog box since
the last save and to restore the last saved values in this dialog box.

Cancel

Select this button to cancel all modifications made in this dialog box since
the last save and to close the dialog box.

The Label Update Dialog Box

This dialog box is displayed when you double-click on a Label in the Local
Mapping window.

DSREF000254A



16-20

VisualAge Pacbase WorkStation Reference Manual

=] Label Update

Line I?
Ilabel Column IT

Intensity
Default
Normal Color OK
Bright =

Default 1

Default

Presentation Normal L

Red
Default Yellow Restore
Normal Green
Blinking Turquoise -
Reverse video Blue Cancel

Enter the label itself.

Line
Enter the line position of the label.

Column
Enter the column position of the label.

Intensity
Select the intensity of the label.

Presentation
Select the presentation of the label.

Color
Select the color of the label.

OK
Select this button to save the changes made in this dialog box and to close
this dialog box.

Default
Select this button to update this dialog box with the default values (values
defined in the Definition screen of the Screen).

Restore
Select this button to cancel all modifications made in this dialog box since
the last save and to restore the last saved values in this dialog box.

Cancel

Select this button to cancel all modifications made in this dialog box since
the last save and to close the dialog box.
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The Called Screen/Dialog Update Box

This dialog box is displayed when you double-click on a called Screen/Dialog in
the Local Mapping window.

Called Dialog Update: PT X |

Call Type Line
S

O Contents

PR

Column

-Category

@ Heading Restore

) Screen Bottom

i

C Repetitive Cancel

Call Type
Select what will be called in the map, the title or contents of the
Screen/Dialog.

Line
Indicate the location (the line) of the called Screen/Dialog.

Column
Indicate the location (the column) of the called Screen/Dialog.

Category
Select the category of the called Screen/Dialog.

You can transfer a Screen/Dialog from the Heading to the Screen Bottom
category (and vice-versa) or from the Repetitive category to the Heading
or Screen Bottom categories without changing its physical position on the
map. To do so, change its category in this Screen/Dialog Update dialog
box.

Transferring a Data Element to the Repetitive category is possible only by
physically locating the Data Element in the Repetitive category. See
Category Management in subchapter “Functionalities”.

OK
Select this button to save the changes made in this dialog box and to close
this dialog box.

Restore
Select this button to cancel all modifications made in this dialog box since
the last save and to restore the last saved values in this dialog box.

Cancel

Select this button to cancel all modifications made in this dialog box since
the last save and to close the dialog box.
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The General Characteristics Dialog Box

This dialog box is displayed via General characteristics... in the Presentation
menu in the Local Mapping window. In this dialog box you set the Screen
general characteristics (default values are set in the Definition screen of the
Dialog):

‘~=-| General Characteristics

‘Dimensions

Number of lines I 24 Number of columns I 80

Number of tabs | 1

-Call characters

Field help I Screen help I

Data Element Label type

Default {upper level value)
Column heading on 1 line
Column heading on 2 lines
Column heading on 3 lines
Field only

Left-justified long label
Right-justified long label
Abbreviated long label

i

Leftjustified relational label E‘
oK Default Bestore | Cancel
Dimensions

Number of lines/Number of columns

Indicate the number of lines and columns for the screen. When you reduce
the size of a screen which already contains elements, a check is performed.
The screen must have enough lines and columns to display all the existing
elements. If you change the size of a screen a message will notify you if it is
too small. This message will also propose to change the size of the screen
to the smallest size possible (the minimum size that contains all elements of
the screen).

Number of tabs
This value is used for host mapping only. This value is also set in the
Definition screen of the Screen. See the OLSD Reference Manual.

Call characters

Call characters are used to call the help function. Indicate the character (i.e.
?) to be used to call the Data Element help (when the character is placed in
a Data Element) and the Screen help (when the character is placed in the
choice field).

Data Element Label type

Set the Data Element Label Type of the header category.
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The Display Attributes Dialog Box

This dialog box is displayed via Display Attributes... in the Presentation menu
in the Local Mapping window:

In this dialog box you set the screen field, label, and error message display
attributes (i.e. intensity, presentation, color). Default values are set in the
Definition screen of the Dialog. Color attributes are only visualized on the local
mapping window. The other attributes are visualized during simulation.

‘='| Display Attributes
Field Type
Label Label
Protected Data Element Protected Data Element
Variable Data Element Variable Data Element
Error message Error message
Erroneous field Erroneous field
Intensity sample
Default
Normal
Bright Color it
Dark Default
Presentation Normal Default
_ Red :
Default Yellow -
Normal Green nestore |
Blinking Turquoise
Re\.rers.e video B_Iue \E
Underlined Pink |
Field Type

When you select a field type, its current intensity, color and presentation will
be highlighted in the corresponding lists. An example of the field type with its
current intensity, color and presentation is shown in the sample part of the
dialog box.

To change the intensity, color and presentation of a field type, select a non-

highlighted Intensity , Color and Presentation . The result is shown in the
Sample part of the dialog box.
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The Repetitive Category Dialog Box

This dialog box is displayed via Repetitive... (available if the repetitive category
exists) in the Presentation menu in the Local Mapping window:

‘~=-| Repetitive category

Data Element Label type

Default [uppe.r level ‘JE.llue] e oK
Column heading on 1 line

Column heading on 2 lines
Column heading on 3 lines Default
Field only

Leftjustified long label
Rightjustified long label
Abbreviated long label —
Leftjustified relational label 4] Cancel

Restore

In this dialog box you set the Data Element Label Type of the repetitive
category. The default option is set in the dialog box (in its Data Element Label

Type section) obtained via General Characteristics... in the Presentation
menu.

The Screen Bottom Category Dialog Box

This dialog box is displayed via Screen Bottom... (available if the screen

bottom category exists) in the Presentation menu in the Local Mapping
window:

‘=.| Screen Bottom category

Data Element Label type

Default (upper level value)
Column heading on 1 line
Column heading on 2 lines —————
Column heading on 3 lines Default
Field only

Leftjustified long label
Rightjustified long label
Abbreviated long label ————
Left-justified relational label 4] LCancel

[+

OK

Bestore

In this dialog box you set the Data Element Label Type of the screen bottom
category. The default option is set in the dialog box (in its Data Element Label

Type section) obtained via General Characteristics... in the Presentation
menu.
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The Preferences Dialog Box

This dialog box is displayed via the Local Mapping window (via Preferences...
in the Presentation menu). In this dialog box you set the default options for the
Data Elements used during mapping:

= Preferences

-Data Element creation

Nature of the Data Element

Displayed and received

Displayed and not updatable
Displayed. received and updatable
Label only

Save

@ In the jnitial order

C In the order on the Screen
& Confirmation message

B Sawve before Simulation

Print

O Black and white
@® Color

OK Cancel

Data Element creation

Nature of the Data Element
Select the nature (default) of Data Elements placed in the map.

Save
With the following options you indicate how elements in the map will be
saved (In the initial order/In the order on the Screen ) and if confirmation
messages will be displayed (Confirmation message ) and if the map will be
automatically saved before simulation (Save before Simulation ).

Print

With this option you indicate which colors the map will be printed in (black
and white or color).
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The Colors Dialog Box

This dialog box is displayed via the Local Simulation window (via Colors... in
the Preferences menu) and via the Host Simulation window (via the System

menu). In this dialog box you can change the colors of the window:

‘=-| Colors

C Host Colors

C Preset Colors

N

‘Background

O WINDOWS

comer NN [

- +

OK Cancel

Mode

Host Color
The character colors will be the colors defined for the Host screen.

Preset Color
The character colors (by field) will be the colors predefined for the

WorkStation.
Monochrome
The character color will be the color selected on the scroll bar

Background

WINDOWS
The background color will be the background color defined in WINDOWS.

Other
The background color will be the color selected on the scroll bar.
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Host mapping is used to build a screen map using Data Elements in the
Specifications Database.

Host mapping is performed in two stages:

* The first step, corresponding to the Host Screen Mapping (Field Positions)
window, consists of positioning fields in the window with special characters

* The second step, corresponding to the Host Screen Mapping (Contents)
window, consists of entering the codes of the Data Elements, as defined in
the Specifications Database. This causes the characteristics of each
element to appear automatically on the screen map

Once the screen map is built, field positioning and characteristics can be
checked with the Host Simulation feature which allows you to see the screen
map as it would be displayed during actual execution. This Simulation displays
the Map as it will appear during execution.

Host mapping and simulation operations are implemented in the same way
as they are on the standard host system.

Therefore, for complete information, refer to the Online Systems Development

Reference Manual. chapter “Definition” and “Description of a Dialog or Screen”,
subchapter “Screen Mapping”, and chapter “Dialog Simulation”.
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Functionalities of Host Mapping

System Limit

A screen map is built in two steps: first using the Host Screen Mapping (Field
Positions) window. Using special characters (described below), position the
Screen fields onto the blank workspace, or delimit the modification field and
press the ENTER key.

Function Special Character
(Default Value)

field beginning delimiter (bg:)
field end delimiter (end:)
relative positioning (rel:)
absolute positioning (abs:)
modification request (mod:)

A Hh VA

Second using the Host Screen Mapping (Contents) window. The system
assigns an order number to previously positioned fields. It then prompts you to
enter the element code for the first field (Position 1) on the command line at the
bottom of the screen. Once the ENTER key is pressed, the first field is displayed
and the system prompts you to enter the second field code.

You cannot open another window which requires host access during this
second host mapping step as communication is held by this window (the Entity
menu is grayed).

The actual update of the Specifications Database takes place when you close
the Host Mapping window.

Function Keys and Mouse Control

See the Appendix at the end of this manual.

Getting to the Host Mapping Window

Host Mapping requires a host connection and is specific to the Screen entity.

You can access this window from the Entity dialog box or the Cascaded menu
of a window of the same occurrence.
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The Menu Bar of the Host Mapping Window

The Entity Menu

Entity Screen = Definition
Lists => Available lists
Descriptions => Available descriptions
X-References => Available x-references

Other Occurrence...
Data Element...

For complete details about this menu, refer to chapter "Navigation in the
WorkStation", subchapter "The Cascaded Entity Menu".

The Update+Display Menu

Update+Display
Update
Top
From...

Field Positioning

Update This command is equivalent to pressing the ENTER key.

Top Available for Mapping (Field Positions) only. It allows you to position the cursor
at the beginning of the Screen map. This is particularly useful when the map is
larger than the Mapping window.

From... Available for Mapping (Field Positions) only. It opens the From... dialog box in
which you enter a Start key. Enter the Line Number from which you wish to
display the Screen map. If you wish the display to start from a given column,
check Column Positioning and enter the desired Column Number.

For a complete description of the From... dialog box, refer to chapter
"Navigation in the WorkStation".
Field Positioning Returns from Mapping (Contents) to Screen Mapping (Field Positions). This

command is not available for Screen Mapping (Field Positions).
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The Screen Menu

Screen Menu Copy Host Screen
Print Host Screen...

Copy Host Screen
Copies the current Host Screen in the SPAC\BASE\SPAC.PRT. When you
select this command, a dialog box offers you either to reinitialize the file, or to
add the screen at the end of the existing file.

Print Host Screen...

Prints the current Host Screen.

DSREF000254A



17-6 VisualAge Pacbase WorkStation Reference Manual

Functionalities of Host Simulation

This window is specific to the Screen entity.

If screen branching has been defined (by using a Data Element or Function
Key), the Host Simulation window allows you to simulate it, provided that a
screen map has been described for each screen branching.

When you open the Host Simulation window via the Entity dialog box, select the
From... button. A dialog box will open in which you specify a function key to use
in order to exit the window (I1BM hosts only).

Another dialog box opens in which you select the type of screen to simulate:

‘=-| Screen to be simulated

@ 1 - 24xB0 Monochrome:

C 2 -24xB0 Colors
IBM Host only

O 3-43xB0 ! 27x132 Monochrome

C 4-43=xB0 ¢t 27x132 Colors

OK Cancel

1 - 24x80 Monochrome
Allows you to simulate a 24x80 map without color attributes. The
equivalent host operation code is C1.

2 - 24x80 Colors
Allows you to simulate a 24x80 map with color attributes. The equivalent
host operation code is C3.

3 -43x80/ 27x132 Monochrome
Allows you to simulate a 24x80 or a 27x132 map without color attributes.
The equivalent host operation code is C4.

4 - 43x80 / 27x132 Colors

Allows you to simulate a 24x80 or a 27x132 map with color attributes.
The equivalent host operation code is C5.
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After selecting a screen type and clicking ok, one of two things will occur:

1. If there are no overlapping fields, the system will simulate the screen or
dialog.

2. If field overlaps/overflows are detected, the system will display a message
indicating so.

SIMULATION EXIT
There are several ways to exit from the Host Simulation window:

** Pressing the function key that you defined in the dialog box just before
opening the Host Simulation window

e+ |f the Conversation End has been specified (in the Called Data Elements
screen), entering the corresponding command or press the appropriate key

** Pressing the F2 key (if no other key has been specified in the dialog box
before opening the Host Simulation window)

*¢ Selecting Close in the System Menu

KEYBOARD The ENTER key is interpreted as a simple transmit. The function keys are:
ALT-1tO ALT - + = PF1 to PF12
CTRL-1toCTRL+ = PF13 to PF24

Getting to the Host Simulation Window
Host Simulation requires a host connection and is specific to the Screen entity.

You can access the window from the Entity dialog box or the Cascaded menu in
a window of the same occurrence.
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The Menu Bar of the Host Simulation Window

The Colors... Menu

Colors... Displays the Colors dialog box. Refer to chapter "The Local Mapping and
Simulation Windows", subchapter "Auxiliary Dialog Boxes".

The Screen Menu

Screen Menu Copy Host Screen
Print Host Screen...

Copy Host Screen
Copies the current Host Screen in the SPAC\BASE\SPAC.PRT. When you
select this command, a dialog box offers you either to reinitialize the file, or to
add the screen at the end of the existing file.

Print Host Screen...

Prints the current Host Screen.

The System Menu

System Menu  Context...
Context... Displays the current context.

For more information about the context, refer to the subchapter “Context”,
chapter “WorkStation Connection”.
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The Local Specific Code Window is a local word processor window for the
different Program, Screen, Screen C/S and Business component specific
processing lines.

* Work Areas (-W)

* Procedural codes (-P)

* Procedural codes (-8)

* COBOL procedural codes (-9)

* Reverse Program Structure (-SC)

Getting to the Window

You can access the Local Specific Code Window either with a local or a host
connection.

In the Entity Dialog Box, select "Local Specific Code". A dialog box asks you to
select which description you want to edit. (If no description already exists, the
dialog box will display two choices: Work Areas (-W) and Procedural Code (-
P).

If you select a description and click OK, the Local Specific Code opens and
displays the description in a screen with the same functionalities as a PC word
processor.

In addition to the menu bar, a right click on one of the description lines displays
a pop-up menu which displays the actions which can be carried out (the Entity
menu if you click an occurrence code, the Edit menu with the Go To function (+
function code) if you click a function code, or the Edit menu if you click on any
other line).

When your work is finished, you must upload the Program or Screen
descriptions in order to take your updates into account (refer to chapter "Local
List Window").

The Different Description Lines

Specific lines

The Local Specific Code Window manages three types of lines: specific lines,
external lines and tags. In order to differentiate them, the lines are displayed
with different colors (refer to subchapter "Auxiliary Dialog Boxes”, Colors dialog
box).

Specific lines are lines specific to the description, stored in the work library.
These lines can be directly manipulated, created, modified, or deleted in the
Local Specific Code Window.
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External lines

Tags

Overwriting lines

The external lines are lines from a higher library, macro-structure calls and
VisualAge Pacbase generated lines. These lines are fixed: their position is set
by the sub-function number and the line number given in their own context.
Their contents cannot be modified.

The external lines appear in the description being edited. You must give the
specific lines free line numbers to display the specific and the external lines at
the same time.

Nevertheless, you can choose not to display an external line by creating an
internal line in the same position but in the foreground (enter it by overwriting).
The external line is then overwritten (but still exists) and its contents is no longer
displayed.

You cannot modify external lines because they are from other contexts: they
appear in the current description but can be modified in their own context only.
In your description, they are displayed in the background and internal lines are
displayed in the foreground.

These lines are displayed at the beginning of each group. A group is a set of
lines hierarchically linked. In most cases (except old programs), a group
corresponds to a sub-function (for the -P) or to the beginning of the line number
(for the -W).

The beginning of group tag is displayed on a gray-green background, whereas
other tags are displayed on a gray background.

The tags display the main group information of the: function code, sub-function
code, level, beginning of line number (for the -W), etc.

For the -P, -8, -9 and -SC, a specific line necessarily belongs to a group.
Therefore, when the description is empty, you must create a group before
entering a specific line.

When an internal line overwrites an external line, it is displayed in black with a
small rectangle whose color corresponds to that of the overwritten line. In order
to display the external line which was overwritten, click on the colored rectangle.

This rule also applies when external lines overwrite each other (for example, a -
W line of a program overwriting a -W line of a macro-structure). If two macro-
structures called in the current library overwrite each other (neither one causing
generation), they are represented by an empty line preceded by a green
rectangle.

If a line existing during download is deleted in the edit phase, it is removed from
the screen but it is stored in the memory for host updating.
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Information on Selection

If you press the SHIFT key, the current selection is extended to the new cursor
position.

You can also carry out a selection by pressing the SHIFT key and clicking with
the mouse, or by pressing the left mouse button and moving the cursor, keeping
the button pressed.

You can then copy, delete or mask the selection.
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Menu Bar of the Local Specific Code Window

Entity

File

Edit

Search

Options

?=F1

System Menu

This Cascaded menu contains commands that allow you to access the
definition, lists, descriptions and cross-references of the selected occurrence.

This menu contains commands that allow you to record, restore, close and print
the description or access another specific code description.

This menu contains commands that allow you to add a line or a group, delete a
line, copy or cut into the clipboard, paste from the clipboard, and mask the
selected lines.

This menu contains commands that allow you to search for and replace
character strings, to position and to reach a specific mark.

This menu contains commands that allow you to display the line nhumbers, the
action codes corresponding to the updates performed, the extended operators,
the sub-function levels and the source areas. It also allows you to take into
account external lines, to enter lower case letters, to increment the line numbers
and to choose the display colors or the character font.

This command allows you to access the host online help.

This menu contains, in addition to its standard commands, a command allowing
you to consult the window context.

For more information about the context, refer to chapter "WorkStation
Connection", subchapter "Context".
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The Entity Menu

Entity

The File Menu

File

Open

Close

Save

Restore

Print

Printer...

VisualAge Pacbase WorkStation Reference Manual

Main Entity =>» Definition
Lists =>» Available lists
Descriptions => Available descriptions
X-References => Available x-references

Other Occurrence...
Related Entity...

For complete details about this menu, refer to chapter "Navigation in the
WorkStation", subchapter "The Cascaded Entity Menu".

Open =» Available Specific code descriptions
Close

Save

Restore

Displays a sub-menu which allows you to choose branching to one of the
specific code descriptions already available locally for this occurrence.

Command represented by the icons in the toolbar.
Closes the current description.
If you have not saved your updates, a dialog box asks you if you want to do so.

Saves the current description.

The command is represented by the icon in the toolbar.

All the modifications carried out after the last save will be lost (a confirmation
message is displayed). Press YES to redisplay the last saved version of the
description.

The command is represented by the IE icon in the toolbar.

Print the current description, the current group or groups spaces.

Command represented by the @ icon in the toolbar.

Configures the printing.
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The Edit Menu

Edit

Add a line

Add a group

Delete line

Cut

Add a line
Add a group

Cut
Copy
Paste

Delete line / group

Mask
Creates a line after the current line.

The number of the new line is calculated according to the standard numbering
increment step.

If the numbering increment step is too large to insert a line between two existing
lines, a line number is automatically created and/or the previous lines and/or the
following lines are renumbered.

If renumbering is not possible (no more free numbers), a message is displayed
to warn you that creation is not possible.

Opens the Add a group dialog box in which you can enter the parameters of
the function and/or sub-function which will be created after the current line. For
a detailed description of this dialog box, refer to subchapter "Auxiliary Dialog
Boxes".

Deletes the current line.

The deletion of a group line automatically implies the deletion of all group lines.
The deletion of the only specific line in a group also implies deletion of the

group.
If you delete several selected lines and the selection contains one or more title
lines (or tags), the following simple lines will be attached to the group
immediately preceding them. A message box opens for you to confirm this
concatenation.

The first simple line of a function must have an operator with parameter ($x) or

SUP or N value. Therefore you cannot delete the first simple line if the second
line, which will become the first, does not have one of these three values.

The command is represented by the icon in the toolbar.

Copies the selection into the clipboard and deletes the selection (the external
lines are not deleted).

The command is represented by the icon in the toolbar.

DSREF000254A



18-8

Copy

Paste

Mask

The Search Menu

Search

Search...
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Copies the selection onto the clipboard, without deleting the selection.

If you copy function tags onto the clipboard, these lines will be considered as
sub-function tags when pasting (it is not possible to paste functions).

. Bl . .

The command is represented by the icon in the toolbar.

Copies the contents of the clipboard into the description.

If a selection exists for a field, this selection is overwritten by the contents of the
clipboard. If no selection exists, the clipboard is added to the contents of the

description, at the cursor position.

For a line (or a group of lines), the contents of the clipboard is inserted after the
current line.

If you paste a function, it automatically becomes a sub-function and its
hierarchical level switches to 6.

The command is represented by the EI icon in the toolbar.
Allows you to mask the current selection.

The masked lines are replaced by a single line when displayed, indicating the
number of masked lines.

If the current line is a masking line, this command becomes Unmask as does
the icon on the tool bar. To unmask lines, click with the right mouse button on a
masked line. A contextual pop-up menu opens and asks you if you want to
unmask any or all of the lines.

The command is represented by the icon in the toolbar.

Search...
Replace...

Go to...

Set Mark...
Go to Mark =>» Positions memorized

Return

Opens the Search... dialog box in which you specify the character string to
search for in the function. For a detailed description of this dialog box, refer to
subchapter "Auxiliary Dialog Boxes".

The command is represented by the icon in the toolbar.
The Search Next command in the dialog box is represented by the icon in

the toolbar.
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Replace...

Go to...

Set Mark...

Go to Mark

Return

The Options Menu

Options

Line numbers

Opens the Replace... dialog box in which you specify the character string to be
replaced. For a detailed description of this dialog box, refer to subchapter
"Auxiliary Dialog Boxes".

The command is represented by the @ icon in the toolbar.

Opens the Go to... dialog box in which you specify the function, the sub-
function or the number you wish to go to. For a detailed description of this
dialog box, refer to subchapter "Auxiliary Dialog Boxes".

The command is represented by the icon in the toolbar.

Opens the Set Mark... dialog box in which you can memorize positions (3 main
positions and 17 secondary positions). For a detailed description of this dialog
box, refer to subchapter "Auxiliary Dialog Boxes".

The command is represented by the icon in the toolbar.

Allows you to position the cursor directly on one of the main or secondary
memorized positions.

Access to the 3 main positions represented by the MLEILEI icons in the
toolbar.

Memorizes the initial line of the screen when you used the "Go to..." function.
This command allows you to return to this initial line.

The command is represented by the icon in the toolbar.

Line Numbers
Action codes
Extended columns
Processing level
Source

Use external lines
Use lower case
Confirm Save
Default Increment...

Colors...
Fonts ...

Toggles the line number display.

The line numbers are displayed in increasing order. They are automatically
managed by the system which generates them according to the position of the
line in the screen.

If you choose to display the line numbers, you can modify them or create new
ones, but the automatic numbering remains active in order to avoid
disorganization of all the other lines and make sure that each existing number is
higher than that of the previous line and lower than that of the following line.
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Action codes

Extended columns

Processing level

Source

Use external lines

Use lower case

Confirm Save

Default Increment...

Colors...

Fonts...
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The command is represented by the icon in the toolbar.

Displays the action codes which indicate the modifications carried out on the
description since the last download or upload on the host.

When this mode is activated, updates are prohibited.

The command is represented by the icon in the toolbar.
Allows you to display the right part of the "Operands" and "Conditions" fields.

Allows you to display the processing levels for the simple lines.

Allows you to display the origin of the external lines (library/session, macro-
structure code).

Creates a specific line when you modify an external line.
As soon as you enter the first character on an external line:

* If the option is positioned, an image of the line is created on the foreground
and its content appears in the input fields. You can then insert your updates

* If the option is not positioned, the line is no longer displayed (the fields are
initialized as blank)

Allows you to enter letters in lower case. However, even if the command is
enabled, upper case letters are systematically used for some fields such as
operator code, line type and condition type.

Displays a confirmation message during the save.

Opens the Default Increment... dialog box in which you can indicate the default
increment step for the sub-functions and line numbers. For a detailed
description of this dialog box, refer to subchapter "Auxiliary Dialog Boxes".

Opens the Colors... dialog box in which you can modify the default display

colors of the screen lines. For a detailed description of this dialog box, refer to
subchapter "Auxiliary Dialog Boxes".

The command is represented by the icon in the toolbar.

Opens the Available Screen Fonts
and the size of the characters.

dialog box in which you can select a font

The command is represented by the icon in the toolbar.
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The Help Command

?=F1 Calls on-line help.
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Auxiliary Dialog Boxes

The Data Structure Input Help Dialog Box

This dialog box is displayed when the letter F is entered in column S (Type of
Line or Data Element Format) of a -W line.

The "DS Code in the Program" and "Selection of segments in DS" fields can be
filled in with a $n value parameter.

Data Structure Input Help [ %]

DS Code in the program
DS Code in the library

Selection of segments in DS

Data Structure Format

Internal format j

Record type f use within DS

II_
Level number of the record - Lewvel 1 for DS and Segments ﬂ
Organization l— ﬂ

Sub-schema

For more details on the F-Type of Line or Data Element Format, see the
Structured Code Reference manual, Chapter "Modifying the Working-
Storage/Linkage Section", subchapter "Work Areas Screen (-W).
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The Add a Group Dialog Box
This dialog box is displayed when you select Add a group in the Edit menu.
By default, it always displays the group identifier of your current edit position.
You can modify this default identifier, making sure that you do not assign an

identifier which already exists.

This dialog box varies according to the type of description in which you want to
add a group, but:

* If you want to add a group in the -W lines, the dialog box is as follows:

‘-=-| Add Group

Code for Placement AB

Line nhumber 000

oK Cancel

This dialog box displays the two values according to the already existing
values.

* If you want to add a group in the -P, -SC and -8 lines, the dialog box is as
follows:

‘=-| Add Group

Function ¥

Subfunction

Line humber 000
Level 05
OK Cancel

All these values are default values, according to already existing values.
The level is required for functions.

IMPORTANT: Group identifiers can be modified directly on the tags.
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The Search Dialog Box

This dialog box is displayed when you select Search... in the Search menu,
press PF9 or activate the corresponding icon.

* Enter the character string to be searched for or select it in the help list (the
last 10 strings searched for are memorized)

* Indicate if you want to search for the character string in the operation codes
or in the operands and conditions by selecting one of the radio buttons in the
Search in group

* Indicate the search direction by selecting one of the radio buttons or the
Search to group

The search begins when you press Next.
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The Replace Dialog Box

This dialog box is displayed when you select the Replace... in the Edit menu,
when you press PF10 or when you activate the corresponding icon.

‘=-| Replace

Search for: Next

+
| Replace and search next

Replace with: Replace all
Cancel
Replace Search to
I" Operation codes C Top
I" Operands, conditions... ® Bottom

* Enter the character string to be searched for and the replacement string or
select them in the help lists (the last 10 strings searched for are memorized
in the first help list: the replacement strings memorized in the second help
list are the last 10 which have been entered in the program, not the last 10
entered in the dialog box)

* Indicate whether you want to replace the character string in the operation
codes or in the operands and conditions by selecting one of the radio
buttons in the Replace group

* Indicate the direction of the replace operation by selecting one of the radio
buttons in the Search to group

The dialog box contains the following buttons:

Next
Select to ignore the character string found and continue the search.

Replace and find next
Select to replace and continue the search. When a character string is found,
it is highlighted.

Replace all
Select to replace all occurrences of the character string specified.

Caution: You can replace character strings in the specific lines only.

NOTE Unless the Use lower case command is enabled, replacement character
strings is with letters in upper case.
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The Go to... Dialog Box

This dialog box appears when you select Go to... in the Search menu, press
PF4 or activate the corresponding icon.

‘=-| Reach

Code for Placement

Line number

oK Cancel

If you want to go to a sub-function, you must specify its function code, otherwise
the Go to... dialog box will position the cursor on the first occurrence of this sub-
function.

Similarly, if you want to go to a line number, you must specify the function and
sub-function codes which include this line number.
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The Set Mark Dialog Box

This dialog box appears when you select Set mark in the Search menu or
when you activate the corresponding icon.

=] Set Mark
Assign a mark to the current position:
C Main mark 1
C Main mark 2

O Main mark 3

® iSecondary mark

OK Cancel

The position memorized is the first line of the screen displayed when you select
this command. The function and sub-function codes and the line number are
displayed in brackets.

In order to set a mark to an initial position in the description, just select one of
the radio buttons in the dialog box.

The three main marks are those indicating regular positions.

A secondary mark is a less-used position. You can select up to 17 secondary
marks.

The Default Increment Dialog Box
This dialog box is displayed when you select the Default Increment in the
Options menu. It is varies according to the description in which you are
positioned:

e |If you are in a -P, -8 or -SC description, the following dialog box is

displayed:
‘-=.| Default increment
Subfunction 02
Line nhumber 010

oK Cancel

This dialog box displays the default increment step for the sub-functions and
line numbers.
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These increment steps will apply during creation of a group or of a line.

* If you are in a -W description, the following dialog box is displayed:

‘=-| Default increment
Code for Placement 01
Line nhumber 010
oK Cancel

This dialog box displays the default increment step for the beginnings of line
numbers and the line numbers.

* If you are in a -9 description, the following dialog box is displayed:

|=-‘ Default increment
Line number IUUUUH]
oK | Cancel

The Colors Dialog Box

This dialog box is displayed when you select the Colors in the Options menu.

“='| Colors
-Line colors
B ANy
Upper Library
BEERCERN
‘ Standard 0K Cancel

The default colors are:

Macro-structure lines green
Higher library lines blue

Internal lines black
Group header lines gray

Group header text lines black
Function header lines green
Function header text lines black
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In order to change these colors, click on the line corresponding to the line
category then click on Modify . A standard Windows colors dialog box appears.
You can choose standard colors or define your own customized colors.

If you change the colors, you can restore the default colors by pressing the
Standard button.

The Available Screen Fonts Dialog Box

This dialog box is displayed when you select Fonts in the Options menu.

— Available fonts

Fonts: Size:

85140em oK
Courier ORI
IBM3270 Cancel

The Print Dialog Box

This dialog box is displayed when you select the command Print ... in the File

menu.
= Print
Printer: HP LaserJet 4 Plusi4M Plus on LPT1.0S2 Setup!
Font:
Letter Gothic (W1) OK
LinePrinter
‘ Cancel
Range
@ All
=

C From: Type in the whole codes
. (functiontsubfunction) for the
To: groups to be printed
Header
[ User code

[ Date
I Page
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The Printer's Setup box

A standard Windows dialog box is displayed when you select the command
Printer... in the File menu.

This dialog box allows you to select a printer and to define the printing’s
orientation and the paper’s orientation.
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Moving in the Window

This subchapter describes the moves that can be performed with the keyboard.

* Move in a field:

= Home ==> Beginning of the current field

* End ==> End of the current field

= Right arrow ==> Next character in the Edit field

= Left arrow ==> Previous character in the Edit field

= CTRL+Right arrow ==> Next word in the Edit field

= CTRL+Left arrow ==> Previous word in the Edit field

e Movein aline:

= TAB ==> Next field (first field in the next line for the
last field in the line)

= SHIFT+TAB ==> Previous field (last field in the previous line
for the first field in the line)

= ALT+Home ==> First field in the line

= ALT+End ==> Last field in the line

* Move between the lines:

= Up arrow ==> Previous line

= Down arrow ==> Next line

= PgUp ==> Previous page
= PgDn ==> Next page

* Move in a group:

= CTRL-PgUp => First field in the first line of the previous
group
= CTRL-PgDn => First field in the first line of the next group

* Move in a function for the -P, -SC and -8 :

= CTRL-Alt-PgUp ==> First field in the first line of the previous
function
= CTRL-Alt-PgDn  ==> First field in the first line of the next function

* Move in a description:
= CTRL-Alt-Home ==> First field of the description
= CTRL-Alt-End ==>  Last field of the description

The groups are sorted by hierarchical level: elementary fields with level 99 are
not considered as groups in move operations.

You can also use the vertical scroll bar to move in the description.
When moving via the keyboard, the current line remains displayed and lines are

scrolled if necessary, whereas when moving via the scroll bar the current line
may not be visible.
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Chapter 19 The call of segments (semi-local) Window
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The List of Unused Segments Dialog Box

The Upload Errors Dialog Box
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Functionalities

NOTE
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The Call of Segments (semi-local) Window enables you to describe the
segments called by the occurrences of the Screen Entity (On-line Systems
Development Function) or the Character-mode Client Component and Business
Component Entities (Pacbench C/S).

The Call of Segments (semi-local) Window requires a host connection. The data
displayed in the window is read by the host, processed locally and updated
during save. Only the processes are performed locally. Unlike the graphic and
textual descriptions, the segment description is not stored locally. In the event of
an interruption during the process (for instance a power failure) however, a
recovery mechanism allows you to restore the description to its previous status.

The save can be performed during a work session (Upload command) or at the
end of a session.

The contents of the window is similar to the O...... CS screen.

This screen is documented in the Reference Manuals:

» Online Systems Development, chapter "Description of a transaction",
subchapter "Screen Call of Segments"

= or Pacbench C/S Business Logic and TUI Clients Reference Manual,
chapter "Call of Segments", for the Business Component and TUI Client.

When developing a host for a VisualAge Pacbase application, consult the
Pacbench C/S User's Guide Vol. Ill: Business Logic, chapter "Business
Component".

You can open only one Call of Segments (semi-local) Window at the same
time.

Getting to the Window

The Call of Segments (semi-local) Window is only available with the Pacbench
module.

In the Screen Dialog Box, enter an occurrence in the Occurrence Code field and
choose Call of Segments (semi-local) in the Description list.

For more details on the various ways to specify an occurrence code in the Entity
Dialog Box or on descriptions, refer to chapter "Navigation in the WorkStation".
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Segment Presentation by Use/Category

The Call of Segments (semi-local) Window is split into 6 sub-windows, called
"panels". Each panel corresponds to one use and one category of segment
process: in a column, you will find the panels dedicated to the same use mode
(Receive or Send), and in a column those dedicated to the same process
category (Initialization, Body (iterative) or Termination).

NOTE Initialization corresponds to Header, Body (iterative) to Repetitive and
Termination to Bottom of the Screen in the terminology used in VisualAge
Pacbase documentation.

1l SEND-: INITRALIZATHON
=
By
RECEIVE . BOLY [Ioratke) SEND | B4 [Rarative)
= =]
S v —EiyLm
3 CHID [ore abondmoc icainnidel stion) —3 £
FALCEIVE - TEHMIKATIGHN SEHD - TERRIMETHRN
=) =
LR WL Ziviao

The symbol in the upper left corner of each panel stands for the root which
is the starting point of the graphic tree but takes no real part in the description.

Each panel comprises two parts:
* The title, reminding the use mode and the process category

* The list box, where the called segments are displayed
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NOTES
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* The panel titles are also buttons. You can click them to open an info-box
summarizing the mode of use and the process category for the pane

* You can resize the column width and the line height of the panels by clicking
and dragging the mouse pointer to the size you wish

* If the list box is too small to display all segments, use the vertical scroll bar
to visualize the parts which were previously not visible

Each called segment code is preceded by an icon representing its organization
and, in the “Reception” column only, is followed by a label summarizing its use.
In the “Emission” column, when there is no label (most frequent case), use may
be "Used for display". However, Client Component use, provided the Segment
organization is X, can be "Host call for selection" or "Host call for customized
procedures”. In the second case, the label is explicitly specified.

In a list, the dependence of the segments is represented by a tree structure.
The left-to-right order for displaying the segments corresponds to the process
order. The segments which depend on the same segment are displayed with
the same indentation.

Example :
In the panel entited RECEPTION: INITIALIZATION, the precedence /
dependence relationships between segments are represented as follows:

* Segments AAOL1 and FF12 are free segments because they have neither
preceding nor depending segments

* AZ15 has two depending segments, AZ1B and AZ1C, but no preceding
segment. AZ1B and AZ1C are on the same hierarchical level because they
have the same preceding segment

* Segment AZ1B has both a preceding segment (AZ15) and a depending
segment (AZ2B)

For more details on the functionalities that allow you to create or modify

segment calls, refer to subchapters "The Menu Bar of the Calls of Segment
(semi-local) Window" and "Auxiliary Dialog Boxes".
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The Menu Bar of the Call of Segments (semi-local) Window

Entity

Description

Edit

View

About...

System Menu

This Cascaded menu contains commands that allow you to access the
definition, lists, description and cross-references of the current occurrence.

This menu allows you to reset, upload, restore and quit the current description,
and configure the printer.

This menu allows you to copy, cut, paste, add, delete or rename a segment.

This menu allows you to display or hide the toolbar and the status bar, to
display the errors that occurred during the last upload, display the information
about the current segment and the list of unused segments, and to move the
focus from one panel to the other.

This menu allows you to display information relating to the window.

In addition to the standard commands, this menu contains a command for
consulting the context of the window.

For information about the context, refer to chapter "WorkStation Connection”,
subchapter "Context".

In addition to the menu bar and the toolbar in the Call of Segments (semi-local)
Window, described later in this chapter, a pop-up menu appears when you
right-click on a segment or a logical view. The commands available in this menu
allow you to access the definition, lists, description and cross-references of this
segment or logical view.
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The Entity Menu

Entity Definition
Lists =>» Available Lists
Descriptions = Available Descriptions
X-references = Available X-references

Other Occurrence...

For complete details about this menu, refer to chapter "Navigation in the
WorkStation", subchapter "The Cascaded Entity Menu".
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The Description Menu

Description

Reset

Upload

Restore

Printer...

Exit

Reset
Upload
Restore

Printer...

Quit

Displays an empty multi-panel window, by removing the specified segment
calls, to enable you to write the current description again.

The command is represented by the E icon on the toolbar.

Updates the current description on the host.

The command is represented by the icon on the toolbar.

Restores the description as it was in the last saved version.

The command is represented by the icon on the toolbar.
Configures the printer.
The command is represented by the icon on the toolbar.

Closes the window (application) and displays a message box asking you to
confirm that you wish to save any modifications (i.e. host update).

DSREF000254A



19-8

The Edit Menu

Edit

Cut

NOTE

Copy

NOTE

Paste

Add segment

Delete segment
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Cut

Copy
Paste

Add segment
Delete segment
Rename segment

Transfers the selection from the current description onto the Clipboard.

When you transfer a segment, all depending segments are also transferred.

The command is represented by the &% icon on the toolbar.
To move a segment, instead of using Cut/Copy, left-click on the segment
with the mouse to select and drag it to the required pane. Once in the pane,
hold the mouse button down until the preceding segment (or the root) of the

segment to be moved is highlighted, then release the button. The segment is
removed from the original pane.

Duplicates the selection and places it onto the Clipboard.

When you copy a segment, all depending segments are also copied.
i

E
The command is represented by the icon on the toolbar.

To copy a segment, instead of using Copy/Paste , left-click on the segment
with your mouse to select it and drag it to the required pane. Once you are in
the pane, hold the mouse button down until the preceding segment (or the
root) of the segment to be moved is highlighted. Press the CTRL key, then
release the mouse button.

Places the contents of the Clipboard at the cursor position.

The command is represented by the . icon on the toolbar.

Opens the Add segment dialog box which allows you to enter a new segment
code, or the Characteristics of the new logical view dialog box, which allows you
to enter the code and base code of the logical view.

The command is represented by the icon on the toolbar.

For more details about those two dialog boxes, refer to subchapter "Auxiliary
Dialog Boxes".

Deletes the selected segment.

When you delete a segment, all depending segments are also deleted. A
message box opens requesting confirmation.

The command is represented by the icon on the toolbar.
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Rename segment Opens the Renaming Segment dialog box which allows you to enter a new code
for the selected segment.

The command is represented by the @ icon on the toolbar.

For more details about those two dialog boxes, refer to subchapter "Auxiliary
Dialog Boxes".
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The View Menu

View

Toolbar

Status bar

ToolTips

Upload status

Segment Information

Unused segments

VisualAge Pacbase WorkStation Reference Manual

Toolbar
Status bar
ToolTips
Upload status

Segment Information
Unused segments

Previous pane
Next pane

Displays or hides the toolbar.
The icons on the toolbar are documented as they occur in this subchapter.
Displays or hides the status bar.

When the command is active, the status bar appears at the bottom of the
window.

The status bar displays:
* The action performed by a menu command or by the current icon

* The code, organization and external name of the segment where the mouse
pointer is located

Shows or hides ToolTips.

7
The command is represented by the icon on the toolbar.

Opens the Upload errors dialog box which displays any errors which occurred
during the last upload. For more details about this dialog box, refer to
subchapter "Auxiliary Dialog Boxes".

The command is represented by the icon on the toolbar.

Allows you to access the following dialog boxes:

* Characteristics of the segment, which allows you to define the physical/use
and logical characteristics of the segment to be added and to consult/modify
the characteristics of the current segment

* Characteristics of the logical view (Business Component only), which allows
you to consult or modify the code or base code of the selected logical view

For more details about those two dialog boxes, refer to subchapter "Auxiliary
Dialog Boxes".

The command is represented by the icon on the toolbar.
Displays the List of unused segments dialog Box. This dialog box allows you to

consult, create, modify and cancel a segment which is called but not displayed
because it is unused.
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For more details about this dialog box, refer to subchapter "Auxiliary Dialog
Boxes".

The command is represented by the icon on the toolbar.
Previous pane Moves the focus from the current to the previous pane.
Equivalent to the key combination SHIFT+F6.
Next pane Moves the focus from the current to the next pane.
Equivalent to the F6 key.

When a panel is focused, you can use the keyboard arrow keys to move from
one segment to another within the pane.

The About... Menu

About... Opens the About... dialog box

The command is represented by the icon on the toolbar.
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Auxiliary Dialog Boxes

The Add Segment Dialog Box

This dialog box is displayed when you choose Add segment... in the Edit menu
or click the corresponding icon on the toolbar.

= Add Segment
Enter the code: I

To specify a segment, select its preceding segment or, in the case of a segment
under the root, select the root. Choose Add segment... or click the
corresponding icon, enter a code for the new segment, then click OK. The
Characteristics of the Segment dialog box opens up. You can specify the
physical and/or use characteristics of the segment as well as its logical
characteristics. The code of the new segment appears in the tree structure one
level lower than that of the selected segment.

DSREF000254A



Call of Segments (semi-local) Window 19-13

The Characteristics of the New Logical View Dialog Box

This dialog box is displayed when you choose Add segment... in the Edit menu
or click the corresponding icon on the toolbar.

= Characleristics of the new logical view
Enter the code of the logical view: I | 1] 4 I
Enter the baze cnde:l Annuler I

To specify a logical view, select the root in one of the six panes. Choose Add
segment... in the Edit menu or click the corresponding icon on the toolbar.
Enter the code and base code of the logical view in the input fields. If you do not
complete the Base code field, this code is by default the same as that of the
logical view. Click OK: the code of the logical view is displayed simultaneously
in the six panes, just under the root.

NOTE The segment directly under the root is a logical view when called in a
business component which is one of the following types:

e S Business Component

* E Business Component (with access to error labels)
e MS Host Monitor

e Si Initialization Host

e ST Termination Host

* FM Communications monitor

* MV Communications monitor (simple mode)
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The Renaming Dialog Box

This dialog box is displayed when you choose Rename segment... in the Edit
menu or click the corresponding command on the toolbar.

= Henaming BBU]
Enter the code: ||

To rename a segment, select it, then choose Rename segment... in the Edit
menu or click the corresponding icon on the toolbar. Enter the new segment
code in the dialog box that opens up, then click OK.

A renamed segment keeps its precedence and dependence relationships with
other segments. When you rename a segment displayed in several panes, the
change is passed on all the occurrences of the segment.

DSREF000254A



Call of Segments (semi-local) Window 19-15

The Characteristics of the Segment Dialog Box
There are several ways to access this dialog box.

* To getinformation about an existing segment, follow these steps:

- Select a segment, then choose the Segment information command in
the View menu or click the corresponding icon on the toolbar, or

- Double-click on a segment in any pane.

* The Characteristics of the segment Dialog Box also appears when you add a
segment, allowing you to define its general characteristics

There are five variants of this dialog box. Only the framed part, in the following
figure, changes according to the organization type. The following figure displays
one of the variants (V and W organizations), along with partial screen captures
that illustrate the other possible graphical aspects of this variable part. The
different fields constituting the variable part are detailed at the end of this
section.

RECEPTION : INITIALIZATION:Characteristics of segment CD10

Organization: Base code:|CD10
Use: IX creation/modification |i| Genanmn Ienrel:l e :I
Access key source: -
i Sub-schema numher:l v :I

BG10-NUCOM MUCOM ittt i o
Organization-

; E xternal game:l[;[) i | topandent
:Data element cnde:IHUCDH i variable part
i - i

)

|

|

[ILJL

! \ Example:
1 i Indexed (V) and
BG10-NUCOM [[nucom | [ ereak ; : orkine ()
'.-.-1 ................................ ! organizations
Description type: I ' " Whole segment IEI
~Segment generation: |
% ipti |
= Deserbton X Access |
J
< L b A
DBD 50L :
DED DLA :I[:[) External namez CD 0l |co Server Comp. I
Object type
{8 Code dependent
() Table
O View
DL/1 organization (D) PACTABLE organization (G) Relational organization (H) Server call organization (X)

For details about the values of the various fields in this dialog box, refer to:

- Online Systems Development Reference Manual, chapter "Description of
a Transaction”, subchapter "Screen call of Segments (-CS)"

- Pacbench C/S Business Logic and TUI Clients Reference Manual,
chapter "Call of Segments", for the Business Component and TUI Client.
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You will find below the exact label for each field (bold type ) in the dialog box in
subchapters in the Manuals mentioned above.

For the Organization field, refer to ORGANIZATION.

To select a value, click on the arrow on the right of the edit box and choose
a value in the drop-down list. Each value is followed by its explicit label.

The selected value in the list changes the graphical aspect of the dialog box
(see above). For more details about the various contextual fields, refer to the
end of this section.

For the Use field, refer to USE IN DISPLAY or USE IN RECEPTION, or, if it is a
Business Component, USE IN VALIDATION/UPDATE OrF USE IN SELECTION

Select a value in the drop-down list. Each value is followed by its explicit
label.

The value list in the Use field varies according to the selected organization
type and the use mode (Reception or Display).

For the Access key source field, refer to ACCESS KEY SOURCE and ACCESS
KEY (DATA ELEMENT CODE).

For the check box Break (in the Access key source area), refer to CONTROL
BREAK INDICATOR FOR DISPLAY, or, if it is a Server Component, CONTROL BREAK
INDICATOR FOR SELECT.

The Access key source field comprises a list box and buttons for modifying
it. The list box is divided into three columns:

The left column displays the access key source to the segment

The central column displays the data element codes for segment access

The right column displays the break (if any)

To specify an access key source and a data element code for a segment
access, follow these steps:

= Enter the data element code for segment access in the right input field
and, if necessary, the key source in the left input field (fields below the list
box), or

= Enter the data element code, then, if necessary, click [<]. This button
automatically fills the key source field, comprising the screen code (in a
C/S Screen) or the logical view code (in a Business component) and the
data element code.

To add, delete or modify a line in this Access key source field, use the
buttons on the right.

» The button adds the input data under the current line.

+ To add a line, specify the access key source and the data element
code, activate as necessary the Break check box, then click the
button

+ Torepeat a line, select the line in the list and click the button. The line
is duplicated under the current line

= The \: button deletes the current line.

To do so, select the line in the list and click on the button.
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NOTE

= The E button modifies the current line.

To do so, select a line in the list, modify the concerned input field(s),
activate or de-activate the Break check box, then click the button.

The line containing the new values replaces the current line in the list.

The first line in the list is a dummy line. When you select it, you can insert an
item at the top of the list.

It is not possible to upload more than 99 loading lines for a given category.
For the Description type field, refer to DESCRIPTION TYPE.
To select a value, click on the arrow on the right of the edit box and choose
a value in the drop-down list. Each value is followed by its explicit label

For the Generation field, refer to GENERATION  LIMITATION.
You need to activate at least one of the two check boxes: Description
and/or Access

For the Base code field, refer to SEGMENT CODE

For the Gen. subfun. level field, refer to LEVEL OF GENERATED SUBFUNCTIONS

To select a value, click on the arrow on the right of the edit box and choose
a value in the drop-down list.

For the Sub-schema number field, refer to SUB-SCHEMA NUMBER

To select a value, click on the arrow on the right of the edit box and choose
a value in the drop-down list.

For the fields varying according to the selected organization type:

= Refer to EXTERNAL NAME OF THE FILE for the following fields:

(Label) (Organization)
- DBDDL/1 G,Vand W
- DBD SQL and Object type H
- Server Comp. Code X

= Refer to ACCESS KEY SOURCE (DATA ELEMENT CODE) for the following field:
(Label) (Organization)

- Data element V and W

Once the values in the fields are set, click OK to validate the information
entered or modified. Click Cancel if you do not wish to save the modifications.
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The Characteristics of the Logical View Dialog Box

To access this dialog box, used to consult/modify the code or the code in a
logical view database, you must:

= Select a logical view, then choose Segment Information in the View menu
or click the corresponding icon on the toolbar, or

= Double-click on the logical view

Characteristics of logical view BB

Enter the code of the logical view: IBB[" | (1] I

Enter the base -::ude:lBBm Annuler I

For more details about the two fields in this box, refer to the Pacbench C/S
Business Logic and TUI Clients Reference Manual, chapter "Call of Segments”,

for the Business Component and TUI Client, section SEGMENT CODE IN THE
SCREEN.
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The List of Unused Segments Dialog Box

This box is available by selecting Unused Segments
clicking the corresponding icon on the toolbar.

in the View menu

19-19

or by

List of 'out of use' segments

o

~Modify the list

-]

Add the segment in
the list

B

Delete the current
segment

=

Modify the
current zegment

Code : |BH20

External name:IHBI]I]I]1
Segment IiQ:IBH2I]
Subzchema numher:l ' .i
Gen. subfun. Ievel:l e .

Generation :——
[X Description
X Access

D ata element gude:l

Organization :[Y indexed

Deszscnption type:| *

segment complet

B
B

Fermer

For more details on how to complete the various fields in this dialog box, refer to
section "The Characteristics of the Segment Dialog Box", described above.
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The Upload Errors Dialog Box

* This dialog box is displayed when errors occur during upload (Upload in the
Description menu or Exit with confirmation of upload).

= Upload errors

This dialog box first displays the error message corresponding to the first
error that occurred. If you continue to upload and a second error is detected,
the dialog box opens up again displaying two messages, and so on, until the
last error is detected. The dialog box then closes without the invalid
elements being uploaded.

By clicking No, the madifications are not saved, i.e. no host update.
The Print button allows you to print the list.
* This dialog box opens up when you choose Upload status in the View

menu or click the corresponding icon on the toolbar. It displays errors which
occurred during the last upload.
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= Uplaad errors
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Chapter 20 Call of Data Structures Window

FUNCHIONANES ...

Getting to the Window
Presentation of the Window
External View

Internal View

Menu Bar of the Call of Data Structures Window

The Entity Menu

The Description Menu
The Edit Menu

The View Menu

The About... Menu

General Tab
Cinematic Tab
Physical Tab
Working/Linkage Tab
Expert Tab

Auxiliary Dialog BOX..............cccoeeeeeeeseiesesesisisesesesesnns

The Upload Errors Dialog Box

20-1
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The Call of Data Structures window enables you to insert and describe the
internal and external resources of Programs.

The data displayed in this window is read by the host, processed locally by the
WorkStation, and updated during save operations. Only the processing takes
place locally. Like the Call of Segments (semi-local) and Local Specific Code
descriptions, the Call of Data Structures description is not stored locally.
However, in the event of an interruption during the process (such as a power
failure), a recovery mechanism allows you to restore the description to its
previous state.

The save can be performed during a work session or at the end of a session.

The functionalities of this window are the same as those of the character-mode
P...... CD screen.

The authorized values for its various areas are therefore described in the Batch
Systems Development Reference Manual, chapter “Programs”, subchapter
“Call of Data Structures (-CD)".

Getting to the Window

NOTE

The Call of Data Structures window can be accessed via the Pacbench module
with a host connection.

You can open only one Call of Data Structures window at a time.

In the Program dialog box, enter an occurrence in the Occurrence Code field,
and choose the Data Structure description in the Descriptions list.

For further details on the various ways to specify an occurrence code in the
Entity dialog box or on descriptions, refer to chapter "Navigation in the
WorkStation".

Presentation of the Window

The Call of Data Structures window contains three main areas:

= A vertical area on the left, containing the icons representing the various
Data Structure types. To see those icons’ labels, move to the right the
vertical bar separating this area from the right-hand side area, using the
mouse’s left button.

= The main area is a view of all the resources used by the Program. There
are two types of views:

- the External View, which is a Program flow-chart showing the
Program’s external resources (indexed and sequential files, tables,
databases...)

- the Internal View, which lists all the internal resources of the Program
(working areas, linkage areas, sort files).

DSREF000254A



Call of Data Structures Window

20-3

Tabs appear in the window’s lower area when you double-click on a Data
Structure in the view, or when you insert a new Data Structure in the
view. These tabs vary according to the type of Data Structure.

For further details on these tabs, refer to subchapter “Tabs”.
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The External View provides management facilities for the following Data
Structures:

Sequential files
Indexed files
Databases
Reports

Tables
Pactables

Comments (See paragraph "Support of Data Structures in the
WorkStation”).
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The External View contains four areas:

The upper area shows the Data Structures used as input by the Program.

The lower area shows the Data Structures produced as output by the
Program.

The left-hand side area shows the permanent Data Structures.

The right-hand side area shows the temporary Data Structures.
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Insertion of Data Structures in the External View

You can insert Data Structures in authorized areas only, namely:
= Databases in the permanent or temporary input area
= Reports in the temporary output area
= Tables and Pactables in the temporary input area
= Comments in the temporary input and output areas
= Indexed and sequential files in any area.
To insert a Data Structure, just select a type of Data Structure in the vertical left

area, drag it to the view using the mouse, and complete the Data Structure’'s
description in the appropriate tabs.

Once inserted, a Data Structure cannot be moved to another area. If you
want to move a Data Structure, delete it in the first area, then re-create it in
the desired area.

Display of Data Structures in the External View

Three categories of information are displayed around the icon representing the
Data Structure in the view:

= Two codes, located above the icon for an input Data Structure or below
the icon for an output Data Structure:
- code of the Data Structure in the Program, in bold characters,
- code of the Data Structure in the Library, in italic characters.

= The Data Structure’s external name, located below the icon for an input
Data Structure or above the icon for an output Data Structure.

The arrow direction indicates the way in which the Data Structure is used. A bi-
directional arrow indicates an input/output Data Structure.

The Program icon

The Program is represented by the central rectangle. Its exact representation
depends on its internal resources:

Program with no sort, no working area, no linkage area

Program with at least one working area

Program with at least one linkage area

Program with at least one sort file

These representations can be further combined when the Program uses more
than one type of internal resources.

Double-clicking on the Program’s icon brings you to the Internal View.

DSREF000254A



20-6

VisualAge Pacbase WorkStation Reference Manual

Support of Data Structures in the WorkStation

The WorkStation’s Call of Data Structures window supports the most common
cases of uses of Data Structures. Non-typical cases of use are not recognized
by the WorkStation and are therefore integrally managed by the host.

For example, when you download a Data Structure which already exists on the
host, it may not be recognized in the Call of Data Structures window. This does
not mean that your Data Structure’s contents is incorrect, only that it is not
supported by the WorkStation. In this case, the Data Structure is represented

—————
'

by the ¥ icon, and the Expert tab, reflecting the layout of the areas in the
host screen (CH: P...... CD), is displayed.

After an Upload or a Download, if the type of the Data Structure corresponds to

icon will be transformed and its

a type defined in the WorkStation, the =
place might move in the window.

It is not advised to use the Comments Data Structure — which is also
described via the Expert tab — to create a Structure that the WorkStation
does not recognize because no validation check is performed locally. So it is
highly recommended to create this Structure type directly on the host.
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Internal View
The Internal View provides functionalities for creating the following Data
Structures:
= Sort files
= Working areas

= Linkage areas.
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The list of Data Structures used by the Program displays
= the code of the Data Structure in the Program, in bold characters
= the code of the Data Structure in the Library, in italic characters

= the Data Structure’s external name

next to each icon.
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Menu Bar of the Call of Data Structures Window

Entity

Description
Edit

View

About...

System Menu

The Entity Menu

Entity

This Cascaded menu contains commands that enable you to access the
definition, lists, descriptions, and cross-references of the current entity
occurrence.

This menu allows you to reset, upload, restore and quit the current description,
as well as to configure the printer.

This menu allows you to delete a Data Structure in the view.

This menu allows you to display or hide the toolbar, the status bar, the ToolTips,
or the errors that occurred during the last upload, and to toggle from the
External View to the Internal View and vice-versa.

This menu allows you to display information about the current window.

In addition to the standard commands, this menu contains a command for
displaying the window’s context.

For information about window contexts, refer to chapter "WorkStation
Connection", subchapter “Context”.

Definition

Lists = Available Lists
Descriptions = Available Descriptions
X-references = Available X-references

Other Occurrence...

For complete details about this menu, refer to chapter "Navigation in the
WorkStation", subchapter “The Cascaded Entity Menu”.
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The Description Menu

Description

Reset

Upload

Restore

Printer...

Exit

The Edit Menu

Edit

Delete

Reset
Upload
Restore

Printer...

Quit

Displays a window containing only the Program’s icon. Calls already specified
are deleted to enable you to rewrite the current description.

This command is represented by the icon in the toolbar.

Updates the current description on the host.

This command is represented by the icon in the toolbar.

Restores the description to its state at the time of the last upload, by canceling
the latest changes.

This command is represented by the icon in the toolbar.
Configures the printer for printing the upload errors.

Closes the window (application) and displays a message box prompting you to
confirm that you wish to save your changes (i.e. perform a host update).

This command is represented by the icon in the toolbar.

Delete

Deletes the selected Data Structure from the view.
This command is represented by the icon in the toolbar.
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The View Menu

View

Toolbar

Status bar

ToolTips

Upload status

Internal view

The About... Menu

About...

VisualAge Pacbase WorkStation Reference Manual

Toolbar
Status bar
ToolTips

Upload status
Internal view

Displays or hides the toolbar.

The icons in the toolbar are documented as they are presented in this
subchapter.

Displays or hides the status bar.

When this command is active, the status bar appears at the bottom of the
window.

The status bar describes the menu commands and indicates the operations to
be performed.

Shows or hides the ToolTips.

This command is represented by the icon in the toolbar.

Opens the Upload errors dialog box, which displays any errors that may have
occurred during the last upload. For further details about this dialog box, refer
to subchapter “The Auxiliary Dialog Box”.

This command is represented by the icon in the toolbar.

Allows you to toggle from the Internal View to the External View and vice-versa.
When this command is selected, the Internal View is displayed. When it is
deselected, the External View is displayed.

This command is represented by the icon in the toolbar.

Opens the About... dialog box, which shows information on the product’s current
release.

This command is represented by the icon in the toolbar.
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Tabs

Tabs appear in the lower part of the window when you insert a new Data
Structure in the view or when you double-click on a Data Structure existing in
the view.

The number and contents of the tabs vary according to the type of Data
Structure.

Authorized values for the various areas of a tab are described in the Batch
Systems Development Reference Manual, chapter “Programs”, subchapter
“Call of Data Structures (-CD)".

For each field in a tab (bold characters ), the following paragraphs provide the
tittes of the corresponding field descriptions in the Batch Language Reference
Manual (small capitals).
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This is the only tab which is common to all types of Data Structures, except
Commments and Other Structures.

DS code in program

IEE Selections

External name IDGVR Prog. Segment DS Library Library Segmer=
10 AV 10
QOrganization II Indexed jJ 20 AY 20
10 DE 30
A d R Random i
Access mode I J 10 AV 10
File type |0 Output jJ 40 AV 40
2n AV 1] b
Usage D Direct =l ‘ Ll_l

N General ICinemaﬁc Physical I

For the DS Code in program field, refer to the description of the DATA
STRUCTURE CODE IN THE PROGRAM field. This code must be alphabetic and
different from the source/target DS code in the program (in the « Cinematic »
tab) except for a DS used as ‘P’.

A right click of the mouse on the field opens a popup menu which enables
hypernavigation.

For the External name field, refer to the description of the EXTERNAL NAME
OF THE FILE field.

For the Organization field, refer to the description of the ORGANIZATION field.

To select a value, click the arrow to the right of the edit box, and choose a
value in the scrolling list. Each value is followed by an explicit label.

For the Access mode field, refer to the description of the ACCESS MODE field.

To select a value, click the arrow to the right of the edit box, and choose a
value in the scrolling list. Each value is followed by an explicit label.

For the File type field, refer to the description of the FILE TYPE - INPUT /
OUTPUT field.

To select a value, click the arrow to the right of the edit box, and choose a
value in the scrolling list. Each value is followed by an explicit label.

For the Usage field, refer to the description of the USAGE OF DATA STRUCTURE
field.

To select a value, click the arrow to the right of the edit box, and choose a
value in the scrolling list. Each value is followed by an explicit label.

The Selections area is divided into several columns.

- For the DS Library column, refer to the description of the DATA
STRUCTURE CODE field.

A right click of the mouse on the field opens a popup menu which
enables hypernavigation.
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- For the Prog. Segment and Library Segment columns:
To perform no selection, enter an asterisk in both columns (default
value).
To select one Segment in a file, specify a unique, two-character code,
in both columns.
To select a Report on a medium, specify a unique, one-character
code in both columns.
To modify a Segment or Report code in the Program, specify the code
modified in the Program in the Prog. Segment column, and the library
use code in the Library Segment column.
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Cinematic Tab

This tab is displayed for sequential and indexed files, and for sort files.

Sourceftarget DS code in the program I

Number of control breaks Il] 3: Sort key (group of Data elements) I
File matching level Number II] 3

General  Cinematic IPhysicaI |

Ready | [HUM |

* For the Number of control breaks field, refer to the description of the
NUMBER OF CONTROL BREAKS field.

(For an indexed file, this field is grayed out.)
To select a value, click the arrows to the right of the edit box until you see
the desired value.

* For the File matching level Number field, refer to the description of the FILE
MATCHING LEVEL NUMBER field.

(For an indexed file, this field is grayed out.)
To select a value, click the arrows to the right of the edit box until you see
the desired value.

* For the Sort key (group of Data Elements) field, refer to the description of
the SORT KEY / SEG SELECT / REPORT CODES field, paragraph COMPOSITION OF
THE SORT KEY.

* For the DS code in the source/target program field, refer to the

descriptions of the RESULTING FILE DATA STRUCTURE CODE and SOURCE OR
ERROR DATA STRUCTURE CODE fields.
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Physical Tab
This tab is displayed for sequential and indexed files, for Reports, Tables and
Pactables.
Mode j Structure Code I
File status I I Key ICOVIL
Unit type ID Selective access jJ Physical unit type I I—
Block size II] ® Records O Characters Format II Internal format jJ

‘ General | Cinematic  Physical I

For the Mode field, refer to the description of the RECORDING MODE field.

To select a value, click the arrow to the right of the edit box, and choose a
value in the scrolling list. Each value is followed by an explicit label.

For the File status fields, refer to the description of the STATUS FIELD - FILE
INDICATION field.

(For a Report, these fields are grayed out.)
You must specify the Data Structure — Segment code in the first field, and
the Data Element code in the second field.

For the Unit type field, refer to the description of the UNIT TYPE field.

To select a value, click the arrow to the right of the edit box, and choose a
value in the scrolling list. Each value is followed by an explicit label.

For the Block size field, refer to the description of the BLOCK SIZE field.

For the Records — Characters area, refer to the description of the BLOCK
SIZE UNIT TYPE field.

Click on either one of the radio buttons to activate the corresponding block
size unit type.

For the Structure code field, refer to the description of the CODE OF RECORD
TYPE ELEMENT field.

(This field is always grayed out for a Report. For other Data Structures, it is
sometimes grayed out, depending on the recording modes and uses).

For the Key field, refer to the description of the INDEXED DATA STRUCTURE
ACCESS KEY field.

A right click of the mouse on a Key Data Element input field displays a
popup menu enabling hypernavigation.

(This field is always grayed out for a Report or a sequential file).
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For the Physical unit type field, refer to the description of the PHYSICAL UNIT
TYPE and COMPLEMENTARY PHYSICAL UNIT TYPE fields.

For the Format field, refer to the description of the NON-PRINTING DATA
STRUCTURE FORMAT field.

To select a value, click the arrow to the right of the edit box, and choose a
value in the scrolling list. Each value is followed by an explicit label.
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Working/Linkage Tab

This tab is displayed for working and linkage areas.

* For the Description field, refer to the description of the RECORD TYPE / USE
WITHIN D.S. field.

To select a value, click the arrows to the right of the edit box until you see
the desired value.

* For the Level field, refer to the description of the LEVEL NUMBER (COBOL) OF
THE RECORD field.

To select a value, click the arrows to the right of the edit box until you see
the desired value.

* For the Placement field, refer to the description of the CODE FOR COBOL
PLACEMENT field.
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Expert Tab
This tab is displayed for Other Data Structures and for Comments Data
Structures.
DF DL EXTERN OARFU BLOCK T B M U

DS Librarny Selection =

[Rv | [pGvRrRs | [vsFID | o IR_ |_ |_ IM_

RE SE L UNIT C SELECTON F E R L PL
] 1] | o : N
STAT.FLD |— ACC. KEY W RECTYPEL |—

[ Expert I

This tab reflects the layout of the fields in the host screen (CH: P...... CD).

When a Data Structure with a type 'Other' is saved, the server assigns default
values to the Structure. A download of the Data Structure is then automatically
performed, so the default values are retrieved.

Authorized values for the various fields of this tab are detailed in the Batch
Systems Development Reference Manual, chapter “Programs”, subchapter
“Call of Data Structures (-CD)".
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Auxiliary Dialog Box

The Upload Errors Dialog Box

Upload errors

The following dialog box is displayed when at least one error occurred during
an upload operation (Upload command in the Description menu, or Exit with
confirmation of upload).

UPDATE NOT PERMITTED
RS BYDGYRRSYSFIDD R C |

Do you wish to go on with the upload?

This dialog box first displays the error message corresponding to the first
error that occurred. If you continue to upload and a second error is
detected, the dialog box opens up again displaying two messages, and so
on, until the last error is detected. The dialog box then closes without the
invalid elements being uploaded.

If you click No, the changes are not saved, i.e. there is no host update.
The Print button allows you to print the error list.
The following dialog box opens up when you choose Upload status in the

View menu or click the corresponding icon in the toolbar. It displays errors
which occurred during the last upload.
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Upload errors E3

[UPDATE NOT PERMITTED
RS RV DGVRRSVSFIDD R C |
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Functionalities

The Library/Session window allows you to change Libraries, Sessions, DSMS
Product code and bsms Change number during the same work session.

NOTE The context of your current connection may be different from the context of
other windows which are already open. See chapter "WorkStation
Connection", subchapter "Context".

Getting to the Window

You can access the Library/Session window either with a local or a host
connection.

Access this window from the WorkStation Manager window, via Library-
Session in the Host-Access menu or by clicking on the corresponding icon in
the toolbar.
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Library/Session Window Menu Bar

When the window opens, it displays the library list as registered locally during
the first connection to the current database. See chapter "WorkStation
Connection”, subchapter “"Library and Session List Loading". This list is
displayed as a library tree containing buttons. You can switch the display to the
locally registered sessions list.

CURRENT CONTEXT

When the window opens, it displays your current connection context below the
menu bar: the Library, the Session, the bsMs Product Code and the DsSms
Change Number.

TO CHANGE THE CONTEXT
The current context can be modified in one of two ways:

1. Directly enter the desired values into the input fields.
For the Library field do not enter blanks, asterisks or periods.

The Inter-Library mode (***), used to visualize the entire library network,
cannot be used in the WorkStation. To use this mode, use the Emulator.
Before exiting the Emulator, it is necessary to change the context to an
existing library.

The session numbers must be numeric. Enter "9999" to return to the
current session.

The psms information is optional, but the bsms Change number must be
numeric.

2. Click a button on the List of Libraries tree or on the List of Sessions tree.

NOTE The actual change of context occurs when you select Update in the menu
bar, press ENTER, or double-click the button corresponding to the desired
context.

Update! Modifies the context of your connection to the WorkStation.
List This menu allows you to display the other list (List of Libraries or List of

Sessions, depending on which list you are using), and to refresh the lists of
libraries and/or sessions.

System Menu This menu contains, in addition to its standard commands, a command allowing
you to consult the window context.

For more information about the context, refer to chapter "WorkStation
Connection", subchapter "Context".

The Update! Command

Update! Performs the requested change in the WorkStation Manager window context.
(This can also be done by pressing ENTER or double-clicking the button which
corresponds to the desired context.)
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The List Menu

List Libraries
Sessions

Refresh...

A check mark appears next to the list displayed.

Libraries Displays the locally registered library list of the database to which you are
connected.
Sessions Displays the locally registered list of frozen sessions of the database to which

you are connected.

Refresh... Active only with host connection. Opens the following dialog box in which you
indicate whether you want to refresh the local (Library and/or Session) lists with
lists from the host:

‘=-| Lists to be refreshed:

X Sessions

oK Cancel
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All updates entered in the Specifications Database (except Generation-Print
requests) are recorded in the Journal File.

The List of Journalized Transactions window allows you to consult the contents
of the Journal. The transactions are listed in descending chronological order.

Transactions displayed in this window include all users and all Libraries in the
current Database. It is possible to select what you consult by entering criteria on
the first line of the Journal window. For example, input a user code and press
ENTER. The window will display all Journalized Transactions for the specified
user.

Getting to the Window

Since the List of Journalized Transactions window interrogates the
Specifications Database directly, it can only be accessed if you are connected
to the host. A host connection is required.

This dialog box is displayed when you choose List of Journalized

Transactions in the Search menu in the WorkStation Manager window or click
the corresponding button on the toolbar.
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The Menu Bar in the List of Journalized Transactions Window

Search This menu contains commands which allow you to indicate search criteria,
continue your search or reinitialize your search criteria.

Screen This menu allows you to copy and print the current window.

System Menu In addition to standard commands, the system menu allows you to consult the
context of the current window.

Function Keys and Mouse Control

For the use of function keys and mouse in this screen, see the Appendix at the
end of this manual.
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The Search Menu

Search Guided Search...
Continue Search
Reinitialize
Guided Search... Opens up the Selection dialog box. For complete details, refer to subchapter

"Auxiliary Dialog Boxes".

Continue Search Performs the selection requested in the Selection dialog box or displays the
next page if no other selection is specified.

Reinitialize Clears the Selection dialog box and redisplays the first page of the Journal.

The Screen Menu

Screen Menu Copy Host Screen
Print Host Screen...

Copy Host Screen
Copies the current Host Screen in the SPAC\BASE\SPAC.PRT. When you
select this command, a dialog box offers you either to reinitialize the file, or to
add the screen at the end of the existing file.

Print Host Screen...

Prints the current Host Screen.

The System Menu

System Menu  Context...
Context... Displays the current context.

For more information about the context, refer to the subchapter “Context”,
chapter “WorkStation Connection”.
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Auxiliary Dialog Box

The Selection Dialog Box

The Selection dialog box can be accessed via Guided search... in the Search
menu. It prompts you to enter search criteria.

NOTE If search criteria have already been entered in the Journal window, they are
automatically displayed here. They can be modified.

‘=-‘ Selection

From Transaction humber: I

User |

Library | Session | [ Frozen

Change Number | I

C Before[<) @ After(>) hhmmss I

~Transaction

we [ | B

® All(+) O Creation C Modification C Deletion

-Context

Time

‘Key
Part 1 Part 2 Part 3 Part 4

| |
Send Cancel

In this dialog box you can enter the following criteria:

From Transaction Number

This is the order number of the transaction from which the list is to begin.
Only numeric input is permitted. Displayed transactions, if any, will be less
than or equal to this number.

Context

User
To select transactions entered by a particular user, enter the user code
here.

Library
To select transactions in a particular library, enter the library code here.

Session
To select transactions during a specific session (humeric field), enter the
session here.

Frozen or Current/test
The label "frozen" is displayed when the check box is not selected and
the label "Current/test” is displayed when the check box is selected.
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Change Number
To select transactions by the DsMs Product code in the first field (3
characters) and the bsms Change number in the second field (numeric).

Time

To select transactions entered Before (<) or After (>) a given time, enter the
time in the hhmmss format ('260000' for 4:00 pm).

Transaction

Type
To select a specific type of transaction, indicate the batch access code of
the transaction line in the edit box to the left, or click in the edit box to the
right, and select the desired type.

Creation/Modification/Deletion
To select transactions by their action code, select the action code with
one of these three buttons. To select all types of transactions (default
option), select the All (+) radio button.

Key

Part 1 to Part 4
Selection key with 4 parts: the first field is the occurrence code, the other
fields vary according to the entity and the type of line (definition,
description, etc.).

Examples:

§ for a Program occurrence procedural code

Part 1 Part 2 Part 3 Part 4
PGMO001 30 BB 123
occurrence function sub-function line number
code code code

§ for a Text occurrence description

Part 1 Part 2 Part 3
TEXTO1 PP 321
occurrence paragraph line number
code code
Send

Once all relevant criteria have been entered, click on the Send button to
transmit the request.

Cancel
The Cancel button closes the dialog box without saving the modified values.
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Functionalities

The Keyword Search window allows you to search for occurrences by using
keywords as search criteria. These keywords can be implicit (part of the
occurrence name), explicit or synonyms. Keywords can be combined with the
logical operators AND and OR.

The Keyword Search is open to all entities (depending on the methodology)
available with the selected module, or may be limited to a given entity.

For a complete description, see the Specifications Dictionary Reference
Manual, chapter “Keywords”.
Getting to the Window

Since the Keyword Search window interrogates the Specifications Database
directly, it can only be accessed with a host connection.

This window is accessed via Keyword Search in the Search menu or by the
corresponding icon on the toolbar in the WorkStation Manager window.
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The Menu Bar of the Keyword Search Window

The Keyword Search window is empty when opened. Specify the keyword(s) in
the field where the cursor is located.

Several keywords may be used in a search since they can be combined with
the logical operators AND and OR.
* AND is represented by a blank space.
EXAMPLE: Entering BRANCH AREA will list all occurrences
containing both keywords BRANCH and AREA.
* ORis represented by an = sign.

EXAMPLE: Entering BRANCH=AREA=SUBSIDIARYwill list all
occurrences containing at least one of these three
keywords.

* AND and OR are represented by a blank space and an = sign.

EXAMPLE: Entering BRANCH AREA=SUBSIDIARY will list all

occurrences containing the keywords BRANCH and AREA
and all occurrences containing the keywords BRANCH and
SUBSIDIARY.

* If the character string used as the search argument ends with an asterisk (*),
the search function looks for keywords beginning with that character string.

EXAMPLE: Entering PURCHAS* will list all occurrences whose
keyword(s) begin with this character string, e.g.
purchasing, purchase, purchased, etc.

Entity... Enables you to access the Entity dialog box for the selected occurrence. If all
entities are to be scanned (no individual entity chosen), this command is
grayed.

Search Allows you to formulate a Keyword Search and request its execution.

View... Allows you to select the Library sub-network and screen presentation.

Screen This menu allows you to copy and print the current window.

System Menu In addition to standard commands, the system menu allows you to consult the

context of the current window.

Function Keys and Mouse Control

For the use of function keys and mouse in this screen, see the Appendix at the
end of this manual.
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The Entity... command

The Search Menu

Search

Guided Search...

Continue Search

This command is available when an entity has been selected via Guided
Search... in the Search menu and an occurrence is selected in the Search
output list. This command opens the Entity dialog box of the selected
occurrence which allows you to access windows related to this occurrence.

For a complete description of the Entity dialog box, refer to chapter "Navigation
in the WorkStation".

Guided Search...
Continue Search

Opens the Guided Search dialog box in which you indicate search criteria. For a
complete description of this dialog box, refer to subchapter "Auxiliary Dialog
Boxes".

Performs the search requested via the Guided Search.. command and
displays the results.

The results are displayed as follows:
* If the search is not restricted to one entity, the type (ITEM, STRUCT,
SEGMT, PROG, etc.) is displayed, followed by the occurrence code,

occurrence name and explicit keywords

* If the search is restricted to one entity, the type is displayed, followed by the
occurrence code, the occurrence hame and the explicit keywords

The View... Command

View...

This menu opens the View dialog box. For a complete description of the View
dialog box, refer to chapter "The Host Occurrence List Window", subchapter
"Auxiliary Dialog Boxes".
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The Screen Menu

Screen Menu Copy Host Screen
Print Host Screen...

Copy Host Screen
Copies the current Host Screen in the SPAC\BASE\SPAC.PRT. When you
select this command, a dialog box offers you either to reinitialize the file, or to
add the screen at the end of the existing file.

Print Host Screen...

Prints the current Host Screen.

The System Menu

System Menu  Context...
Context... Displays the current context.

For more information about the context, refer to the subchapter “Context”,
chapter “WorkStation Connection”.
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Auxiliary Dialog Box

Guided Search Dialog Box

Copy VisualAge Pacbase Screen

Copies the current host screen into the file SPAC\BASE\SPAC.PRT. When you
select this command, a message will ask you if you want to reinitialize the file
before copying the screen.

‘=-| Search

Available Entities

CHA Batch Flow Chart
CLI Client Component
DBD LDMIDataBase Block
Dl1A Dialogue

ECR Screen

‘Search

C Implicit Keywords only

O Explicit Keywords only

@® Both

Keywords (79 char. max.)

Send Cancel

Accessible entities

This is a list of available entities (local codes & names). Select an entity to
limit the keyword search to the selected entity. If no line is selected, the
search is performed on all entities.

Search

Implicit or Explicit Keywords only
Select Implicit Keywords only , Explicit Keywords only or Both
(default option) to limit the keyword search to one of these two types of
keywords or both.

Keywords (79 char. max.)

This input area displays the keyword(s) entered in the Keyword Search
window. Keyword changes or new keywords entered here will appear in the
Keyword Search window. At least one keyword must be entered.
The Send button accepts the selections indicated and performs the requested search. The Cancel
button ignores them.
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The Generation-Print window allows you to consult and update Generation-Print
commands as well as the JCL lines used by the Generation-Print (GPRT)
procedure. This window includes a Command Input Guide Facility.

When JCL lines and GPRT command(s) are validated, you can submit the
corresponding job from this window.

For complete information on the Generation-Print Procedure, refer to the User
Interface Guide, chapter "Generation and/or Printing".

Getting to the Window

Since Generation-Print commands update (or interrogate) the Specifications
Database directly, the window can only be accessed if you are connected to the
host.

This window is accessed via Generation-Print in the Host-Access menu in the
WorkStation Manager window.

Note on Color Setting

Set the colors of this window via Logical screens... in the Preferences menu
in the WorkStation Manager window. For complete details, see chapter "The
WorkStation Manager Window".

Update mode:
The color of non-validated lines is the color defined for “Updatable fields”.

Consultation/Validation mode:
The color of non-validated lines is the color defined for “Protected fields”.

All modes:
The color of validated lines is the color defined for “Error”.
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The Menu Bar of the Generation-Print Window

Update+Display
Updates and displays the requested page.
View Selects the Screen Display Option.
Host-Access Submits job built by the validated lines or copies JCL lines to another user.
Options Selects the window usage mode: update or validate.
Screen This menu allows you to copy and print the current window.
?..=F1 Command Input Guide Facility.
System Menu In addition to standard commands, the system menu allows you to consult the

context of the current window.

Function Keys and Mouse Control

See the Appendix at the end of this manual.
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The Update+Display Menu

If you have not modified the contents of the window, the menu is as follows:

Update+Display

Next page

Top

From...

Next page
Top
From...

Displays the next page. If there is no next page, the same page is redisplayed.
(Equivalent host choice: cH: JF)

Displays the first page.
Opens a From dialog box in which you indicate the page to be displayed.

For more information concerning the From dialog box, refer to chapter
"Navigation in the WorkStation", subchapter "Auxiliary Dialog Boxes".

If you have modified the contents of the window, the menu is as follows:

Update+Display

Same page

Next page

Top

From...

Same page

Next page

Top

From...

Updates and redisplays the current page.

Updates the current page and displays the next page. If there is no next page,
the same page is redisplayed. (Equivalent host choice:  CH: JF)

Updates the current page and displays the first page.

Updates the current page and opens a From dialog box in which you indicate
the page to display.

For more information concerning the From... dialog box, refer to chapter
"Navigation in the WorkStation", subchapter "Auxiliary Dialog Boxes".
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The View Menu

View
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Generation-Print Requests (C1)

Job to Submit (C2)

Inter-Library Generation-Print Requests (C3)
JCL (C4)

This menu lists all display options available with this window. These commands correspond to the
values (C1, C2, C3, AND C4) of the Operation Code field in the standard Generation-Print (CH: GP)
screen. The initial screen display is in display option C1.

Generation-Print Requests

Job to Submit

Allows you to consult and update (Update mode) all Generation-Print requests,
by user and Library, or to select requests to be submitted (Validation mode).

Allows you to consult all validated lines (requests and JCL), for a given user and
for all Libraries. This is the image of the job to be submitted.

Inter-Library Generation-Print Requests

JCL

Allows you to consult all Generation-Print requests for a given user and for all
Libraries.

Allows you to consult and update (Update mode) JCL lines, by user and for all
Libraries, or to select lines to be submitted (Validation mode).

The C4 display is optional for users with an 0s/2, Windows NT or UNIX host. For
complete information, refer to the corresponding VisualAge Pacbase Reference
Manual.

The Host-Access Menu

Host-Access

Submit Job

NOTE

Copy to.. .

Submit Job

Copy to...

Allows you to submit the job that is composed of all validated lines. A dialog box
opens requesting confirmation or cancellation of the submission.

It is not mandatory to input the password in the message box.

Available for users with level 4 Access Authorization. Allows you to copy the
JCL lines of the connected user to another user.
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Update mode

Validation mode

This menu is active with the C1 and C4 display options only.

The mode in use is displayed in the window title bar. The initial mode is "update”.

When you leave the Generation-Print window, the current mode is saved. When the Generation-Print
window is next opened, the window automatically opens in this mode.

Update mode

Validation mode

NOTE

Initial mode. This mode allows you to directly update Generation-Print
commands (C1 option) and JCL lines (C4 option). See ?...=F1 for Command
Input Guide Facility.

Once updating is complete, select this command to validate the Generation-
Print requests (C1 screen) and JCL lines (C4 screen) to be submitted.

When this mode is active, lines cannot be updated. However, they can be
deleted by entering 'D' in the Action Code field (labeled A).

Validation is performed by a simple click on the desired line or by positioning
the cursor on the appropriate line and pressing the F2 key. A validated line
changes color and the letter "V" is placed to the left of the line. (See "Note on
Color Setting" at the end of the chapter.)

Requests (C1)
Once the Job is submitted, the validated Generation-Print requests (C1 screen)
automatically lose their validated status.

JCL (C4)

On the JCL updating (C4) screen, the lines remain validated until you expressly
change their status.
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The Screen Menu

Screen Menu Copy Host Screen
Print Host Screen...

Copy Host Screen
Copies the current Host Screen in the SPAC\BASE\SPAC.PRT. When you
select this command, a dialog box offers you either to reinitialize the file, or to
add the screen at the end of the existing file.

Print Host Screen...

Prints the current Host Screen.

The Help Command

?..=F1 Command Input Guide Facility. Available when you are in Input mode.
C1 option screen

Dialog boxes open to help with your Generation-Print requests:

= Guide
List of Entities
Programs
Reports

Database Blocks

User Manuals
Documents
Parameterized Input Aids

List of Commands

LCV List of Documents sorted by code

LKV List of Documents sorted by keyword

DCV Documents as defined and described

DCV S Selected Document as defined and described
PCY Print all Documents

PCY S Print Selected Document

OK Cancel

Select an entity and a Generation-Print command for the selected entity.

If the selected Generation-Print command requires additional input, another
dialog box opens up to help you.
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The System Menu

System Menu

Context...
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=] PCV

Occurrence code:

Print level:

Level-1 section:

Level-2 section:

0OK Cancel

Caution: this dialog box displays the contents of the command being pointed by
the cursor. Be careful where you position your cursor.

To edit VisualAge Pacbase reports in RTF format (via a word processor), refer
to chapter "The WorkStation Manager Window", Host Access menu, Local
Volume Printout choice.

Once all parameters have been entered, the line where the cursor is located is
updated and you will see the modified C1 option screen. Press ENTER or select
Same Page in the Update+Display menu in order to perform the actual
updating. Commands are re-sequenced in alphabetical order.

C4 option screen

The F1 key on the JCL Updating option causes the word “JCL" to be entered in
the Command field on the line where the cursor is located.

Context...
Displays the current context.

For more information about the context, refer to the subchapter “Context”,
chapter “WorkStation Connection”.
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The Generation-Print Monitor is available only for VisualAge Pacbase
under OS/2, UNIX and Windows NT.

The Generation-Print Monitor allows you to consult, print and delete job output
(produced by procedure GPRT).

A maximum of four files may be displayed as job output by the Generation-Print
Monitor: Execution Report, Results, Volume and User Manual.

Getting to the Windows

NOTE

The Generation-Print Monitor can only be accessed if you are connected to the
host.

The Job List window is accessed via Generation-Print Monitor in the Host-
Access menu in the WorkStation Manager window.

To display a file generated by a specific job, select the job and the file in the Job
List window and select Display file in the Display menu in the Job List window.
This opens the Job File window.

In order for the Generation-Print Monitor command to be active, you must
define an access path. For additional information, refer to the Communications -
VisualAge Pacbase WorkStation and PAW Manual.
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The Menu Bar of the Job List Window

The Job List window displays the list of executed jobs (and the files generated
for each job) submitted by the connected user:

= Jobs List HE

Display Print Delete Path...

Mumber Date Hour File Size

00006 29/07/9417:22:34

00M7 26/07/9313:34:12 Generated SOL 00003313 GAQ
00018 26/07/9313:34:12 Server generated 00003313 GY
00019 26£07/9313:34:12 Execution report 00001463 1A
00020 26/07/9313:34:12 Results 00011725 1D

00021 26/07/9313:34:12
00022 26/07/9313:34:12

Refresh list every |5_ seconds

A special feature of this window is that you can specify how often the list of
executed jobs is refreshed. Check the refresh check box and specify the
number of seconds desired between each refresh, then exit the input field for
this period to be accepted.

Display This menu contains a command that displays the file selected in the Job List
window.
Print Prints the file selected in the Job List window. You can also set options and

printers. If the first command in this menu is not available, your WorkStation is
not connected to a printer.

Delete Deletes the files selected in the Job List window.
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The Display Menu
Display File

File Opens the Job File window displaying the selected file.

The Print Menu

Print Print file...
Printer...
Print file... Displays the Printing parameters dialog box which contains the name and port

of the current printer, and in which you can select the font and its size and
specify the margins size and the printing length. The Setup... button allows you
to display the printer’s setup dialog box described below.

= Printing parameters
Printer: HP Laszerlet 4 Pluz/4M Pluz on LPT1: | Setup... I
Font: Courier Hew 8 +
= Courier 10
Letter Gothic
LinePrinter 14 | Cancel I
Lucida Sans Typewriter 16

18

-Marginz

Left |2,uu Right |u— ® Cm
Top |l] Bottom ||] ' Inch

-Range

® Al

Pages O E"Jml to I Copies |1—

Printer... Opens the Available Printers dialog box in which you specify the printer to be
used and define the printing orientation and the paper size.
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The Delete Menu

Delete Delete file
Delete job

Delete file
Deletes the selected files.
If you select several output files, the Display and Print menus are disabled.

NOTE You cannot delete the execution report file from this menu. To do so, you
must request job deletion.

Delete job
Deletes the selected job(s).
If you select several jobs, the File field of the Job List Window cannot display an

output file. You cannot therefore delete the output files. In addition, the Display
and Print menus are disabled.
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The Menu Bar of the Job File Window

The Preferences Menu

Preferences... Opens the Preferences dialog box in which you change the display font and
scroll keys:
=| Preferences
™ Display font r Scroll Keys
Name Size Label FKey
Courier New 8 [+ |||Top L +]|Shift F10 +
Lucida Sans Typewriter 10 | Bottom L_I[Shift F11
12 Previous screen Shift F12
14 |+ Mext screen PgUp
Full screen 33Inx 88 cl Up N screens PgDn j
Down N screens End
Screen 25Inx 88 cl Previous line +|(Home +
oK Bestore Cancel

When you select a font name, the size assigned to it is highlighted. To change
the font size, select the font name and select a non-highlighted size.

When you select a scroll key label, its function key assigned to it is highlighted.
To change the function key of a scroll key, select the scroll key label and select
a non-highlighted function key. (If the function key is already assigned to a scroll
key, you will hear a "beep". To make this function key available, assign its scroll
key to another function key.)

Click OK to save changes and to close the dialog box. Click Restore to cancel

changes and to leave the dialog box open. Click Cancel to cancel changes and
close the dialog box.
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The Scroll Menu

Scroll

Top

Bottom

Next screen
Previous screen

Down N screens...

Up N screens...

Next line
Previous line

Down N lines...

Up N lines...

Memorize screen...

25-7

Top
Bottom

Next screen
Previous screen
Down N screens...
Up N screens...

Next line
Previous line
Down N lines...
Up N lines...

Memorize screen...
Recall screen...

Displays the beginning of the job output file.
Displays the end of the job output file.
Displays the screen after the current screen.
Displays the screen before the current screen.

Displays a dialog box which requests the number of screens (N) and then
displays the screen N screens below the current screen.

Displays a dialog box which requests the number of screens (N) and then
displays the screen N screens above the current screen.

Displays the current screen shifted down one line.
Displays the current screen shifted up one line.

Displays a dialog box which requests a Number of Lines (N) then displays the
current screen shifted down N lines.

Displays a dialog box which requests a Number of Lines (N) then displays the
current screen shifted up N lines.

Displays a dialog box which requests a screen number (1,2,3) under which the
current screen will be memorized.
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Recall screen... Displays a dialog box which requests the memorized screen number (1,2,3) to
be displayed.
NOTE All commands in the Scroll menu may be assigned a function key via the

Preferences dialog box opened via Preferences... in the Job File window. Once
a function key has been assigned it is displayed in the Scroll menu. Since the
Memorize Screen and Recall Screen commands can be assigned several
function keys specific to each output file, these function keys do not appear in
the menu.
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IMPORTANT NOTE
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The Emulator window allows you to consult and update host screens. Some
host screens can be accessed through the Emulator window only (i.e. Libraries,
Parameterized Input Aids (P.l.A.), Keywords, and User Entities with their
occurrences and User Entity Relationships).

You should therefore use the Emulator mainly to access these screens. You
can access all the other screens through dedicated WorkStation windows.

Emulator window colors can be customized via Colors in the System menu.

You may use Emulator windows exactly like host screens and choose to use
the Input Guide facilities for the Choice and Operation Code fields. In so doing,
you will not have to explicitly enter values in these fields because the Emulator
does it for you.

When the Emulator window opens, it displays the List of Libraries (selected
Library and those above).

The Emulator does NOT allow you to display a non-system screen (any screen
which is not a VisualAge Pacbase host screen). Do NOT try to use it for any
other purpose than accessing host screens.

Getting to the Window

The Emulator window allows you to update or interrogate the Specifications
Database. A host connection is required.

To access the Emulator window select the Emulator command in the Host-
Access menu of the WorkStation Manager window.
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The Menu Bar of the Emulator Window

Update+Display

Special choices

View...

Options

Screen
?=F1

System Menu

NOTE

This menu contains commands that allow you to update and memorize screens,
navigate between screens (previous, same, next), consult the Journal and
access the Generation-Print window.

This menu contains commands that allow you to consult the differences
between sessions, search and replace character strings and renumber lines.

This command activates the field Input Guide Facility for the Operation Code
field.

This menu contains commands that allow you to select the update mode:
implicit or explicit.

This menu allows you to copy and print the current window.
This command activates the field Input Guide Facility for the Choice field.

In addition to standard commands, the system menu allows you to consult the
context of the current window.

It also allows you to customize the colors of the window.

For more information about the context, refer to chapter "WorkStation
Connection", subchapter "Context".

On the Screen Simulation screen (Equivalent host choice: cH: o ...... sim),
this Menu Bar is not displayed. To exit this screen, press the PF key used to
call the Simulation again or the F2 key (clear screen).

Function Keys and Mouse Control

For the use of function keys and mouse in this screen, see the Appendix at the
end of this manual.
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The Update+Display Menu

Update+Display

Update + Memorize Screen
Update

Previous Screen
Same Screen
Next Screen

List of Journalized Transactions
Generation-Print

Update + Memaorize Screen

Memorize

HELPFUL HINT

NOTE

Previous Screen

Same Screen

Next Screen

List of Journalized
Transactions

NOTE

This command updates the screen, if necessary, and calls another screen if it is
specified in the Choice field. If no update has been entered and if the Choice
field is left blank, this command calls the next screen. For the logical sequence
of screens, see the Specifications Dictionary Reference Manual.

This command updates the screen, if necessary, and calls another screen if it is
specified in the Choice field. It is the screen that is called in the choice field or
the next logical screen which is memorized and displayed in another Emulator
window.

If you wish the currently displayed screen to be memorized, enter Ji in the
Choice field prior to selecting Memorize .

This Screen Memorization/Recall facility benefits from the multi-windowing
capabilities. However, attention should be paid to the fact that if you update a
screen that has been previously memorized, and if you then open the icon of
this memorized screen, an obsolete image of this screen will be displayed. To
refresh it, enter Ji in the choice field and press ENTER.

The Screen Memorization/Recall facility as implemented in the host system
(Mn/Rn in the Operation Code field) cannot be used in Emulator screens.

Jumps to the previous screen (Equivalent host choice: cH: JP).
Jumps "in place" to the same screen (Equivalent host choice cH: Ji).
Jumps forward to the next screen (Equivalent host choice cH: JF). For the

logical sequence of screens, see the Specifications Dictionary Reference
Manual.

Allows you to consult the List of Journalized Transactions (i.e. the transactions
entered in the Database to which you are connected).
For complete information, refer to the User Interface Guide, chapter "Online

Access Language", subchapter "Journal Consultation". You may also refer to
chapter “The List of Journalized Transactions Window” in this manual.
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Generation-Print Allows you to consult and update Generation-Print commands as well as the
JCL lines used by the GPRT procedure. When JCL lines and GPRT
command(s) are validated, the corresponding job can be submitted from this
window.

NOTE For complete information, refer to the User Interface Guide, chapter
"Generation and/or Printing". You may also refer to chapter "Generation-
Print" in this manual.
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The Special Choices Menu

Special choices Differences between sessions...

Search string...

Replace string...

Renumber...

For a complete description of this menu, refer to chapter "The Formatted

Description Window", subchapters “The Special Choices Menu” and "Auxiliary
Dialog Boxes".

The View... Command

View... This command opens the View dialog box which allows you to use the field
Input Choice Facility for the Operation Code field. The selections that you make
in this dialog box are automatically copied into the Operation Code field.

For a complete description of the View dialog box, refer to chapter "The Host
Occurrence List Window", subchapter "Auxiliary Dialog Boxes".

The Options Menu

Options Implicit Updates
Explicit Updates

Implicit Updates Automatically creates or modifies the screen after you press ENTER or select
Update in the Update+Display menu.

This option remains valid while you are connected to the Emulator.
NOTE Deletions are necessarily explicit.
Equivalent host choice: cH: .u (default option).
Explicit Updates Updates the screen when the relevant action codes are entered.
This option remains valid as long as you are connected to the Emulator.
Equivalent host choice: cH: .NU

When you click on either of these commands, the screen Choice field displays
the new value.

Press the ENTER key or select Update in the Update+Display menu: the
corresponding update mode is activated.

NOTE For complete information, refer to the User Interface Guide, chapter "Online
Access Language", subchapter "Online Updating".
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The Screen Menu

Screen Menu Copy Host Screen
Print Host Screen...

Copy Host Screen
Copies the current Host Screen in the SPAC\BASE\SPAC.PRT. When you
select this command, a dialog box offers you either to reinitialize the file, or to
add the screen at the end of the existing file.

Print Host Screen...

Prints the current Host Screen.

The Help Command

. ?=F1 Calls the Choice field Input Guide Facility which opens the Help on
Choice dialog box. This dialog box displays the list of entities available on the
host, depending on which functions are installed at the site. This list allows you
to select the type of entity you wish to work on. The selections you make in this
dialog box are automatically translated in the Choice field.

For details concerning the Help on Choice dialog box, see subchapter "Auxiliary
Dialog Boxes".

The System Menu

System Menu  Context...
Context... Displays the current context.

For more information about the context, refer to the subchapter “Context”,
chapter “WorkStation Connection”.

Colors... Displays the Colors dialog box. For complete details, refer to subchapter
"Auxiliary Dialog Boxes".
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The Colors Dialog Box

This dialog box allows you to change the colors of the Emulator window:

VisualAge Pacbase WorkStation Reference Manual

‘=‘ Colors
~Set current field Field colors
® Yes O No Status line
Mode Status line background
Current field
Host Colors

Personalized Colors IPHRIEICS

Monochrome _
-

‘Background
C WINDOWS ® Other

Status line

0K Cancel Beset

Set current field

Yes
The color of the characters in the current field (the field in which the cursor is
located) can be specified in the Field Colors list box.

No
The color of the characters in the current field will have no specific color.

Mode

Host Colors
The colors of the characters will be those of the host. You can also select
specific colors for the items in the Field Colors list box.

Customized Colors
You can select the colors for all items in the Field Colors list box.

Monochrome
The colors of the characters will be the color selected on the scroll bar. You
can also select specific colors for items in the Field Colors list box.
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Background

WINDOWS
The background color will be the background color defined in wiINDOWS.

Other
The background color will be the color selected on the scroll bar.

Field colors
The color of the following fields (characters and backgrounds) can be set by
selecting the desired field in the list box and selecting the color on the scroll
bar.

(Available for Host Colors mode)
Status line
Status line background
Current field
This command is available if you request current field settings.

(Available for Customized Colors mode)
Status Line
Status line background
Current field
This command is available if you request current field settings.
Input fields
Protected fields
Highlighted input fields
Highlighted protected fields
Invisible fields
Attribute characters

(Available for Monochrome mode)
Status Line
Status line background
Current field
This command is available if you request current field settings.
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The Help on Choice Dialog Box

This dialog box opens when you select ?=F1 in the Emulator window.

‘=-‘ Help on Choice
Entity

Library +
Session

Keywaord

Data Element/{ Attribute
Text

Yolume

User Manual
Parameterized Input Aid
Data Structure
Segment

Report E|
Choice

OK

Cancel

The ?=F1 command opens the Help on Choice dialog box which displays the
list of entities available on the host, depending on which functions are installed
at the site.

* Select the entity in the list of entities

* Specify the type of description you want to access

* Enter the occurrence code (except for lists)

* Enter the Display Key (optional)

The Choice field value is therefore built progressively.

* You may choose to Cancel the operation

* If you click the ok button, the dialog box closes and the screen Choice field
displays the new value

Press the ENTER key or select Update in the Update+Display menu: the
corresponding screen is displayed.

When you next open the Help on Choice dialog box, it displays the last

selections entered before it was closed: Entity, Choice, and primary and
secondary occurrence codes.
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This dialog box also offers an occurrence code memorization function. This
function is described in detail on the following pages:

PRINCIPLE:

2*n occurrence codes can be memorized, n being the number of entities

managed through the Emulator.

Memorizations are kept until you close the Emulator window.

EXAMPLE:

In the Entity list box, select Program. In the Choice list box, select Definition.
Enter an occurrence code in the Program field: PROGL1.

At this point the primary Program occurrence code is PROG1:

‘ |

Entity

Help on Choice

Parameterized Input Aid
Data Structure

Segment

Report

Program

Screen

Database Block

Model Entity

User Entity

User-Defined Relationship

User Entity Occurrence
Choice -> UPDATE

T -Parameters
Program | prog1
Definition
3

Definition

Documentation

List of locked Entities
Assigned Texts
X-References (all)
X-References to Yolumes

[+

Built Choice: IP prog

OK

Cancel

Select another item in the Choice list box: Procedural Code. PROG1 is re-
displayed in the Program field. Replace this code by PROG2: it is memorized in

plac

e of PROGL.
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At this point the primary Program occurrence code is PROG2:
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‘ |

Entity

Help on Choice

Parameterized Input Aid
Data Structure
Segment

Report

Program

Screen

Database Block

Model Entity

User Entity
User-Defined Relationship
User Entity Occurrence

Choice -> UPDATE

1t

-Parameters

Program | prog2
Procedural Code

starting with :

Function

Sub-Function

Line number

Call of Data Structures (Zoom)

Call of Parameterized Macro-Structures
Beginning Insertions Modifications

Work Areas
Procedural Code
Reverse Procedural Code

Built Choice:

IPprog2 P

OK

Cancel

Select another item in the Choice list box: Call of Parameterized Macro-
Structures. PROG2 is re-displayed in the Program field and in the Starting With
field . In this last field, replace PROG2 by PROG3.
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At this point the primary Program occurrence code is PROG2 and the
secondary occurrence code is PROG3:

‘ |

Entity

Help on Choice

Parameterized Input Aid
Data Structure
Segment

Report

Program

Screen

Database Block

Model Entity

User Entity
User-Defined Relationship
User Entity Occurrence

Choice -> UPDATE

-Parameters
Program

Parameterized
starting with :

Line number

prog2

Macro-Struct.

prog3

Work Areas
Procedural Code
Reverse Procedural Code

Call of Data Structures (Zoom)
Call of Parameterized Macro-5tructures
Beginning Insertions Modifications

Built Choice:

IP prog2 CP prog3

OK

Cancel

Now, in the Entity list box, select Data Element/Attribute. In the Choice list box,
select X-References to Programs. Your primary selection is now Data
Element/Attribute and your secondary selection is X-References to Programs
(the displayed secondary occurrence code is PROG3). There is now no
occurrence code in the Data Element/Attrib. field.

Enter DATEL1 in the Data Element/Attrib. field.
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At this point the primary selection is DATEL1 and the secondary selection is

PROG3:
|=-‘ Help on Choice
Entity
Library B Parameters
Session Element/Attrib. | datell
Keyword B
Data Element Attribute *References to Program
Text starting with : | prog3
Volume
User Manual
Parameterized Input Aid
Data Structure
Segment
Report z|
Choice
*-References to Reports +
*-References to Reports (Call of Elements)
*-References to Programs oK
*-References to Program (Work Areas)
*-References to Program (Procedural Code)
%-References to Program (pure COBOL!-8) + Cancel

Built Choice:

[E datel1 XP prog3

For each entity, two occurrence codes can be memorized: in the previous
exercise, PROG2 and PROG3 for the Program entity. These codes are displayed,
if they exist, in the corresponding fields.
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Correspondence between WorkStation and Host commands

Standard Entities
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The table below lists the standard entities which can be accessed from the
Workstation or the Host. The first column shows the entity name, the second
shows the description label in the WorkStation, the third shows the module via
which the description is accessed, the fourth shows the corresponding Host
command and the fifth shows the reference manual(s) documenting the entity.

STANDARD ENTITY WORKSTATION COMMAND | MODULE HOST ASSOCIATED
COMMAND | MANUAL(S)
DATA ELEMENT Host description Pacdesign / bench E.... Specifications
General Documentation Pacdesign / bench E.....G Dictionary
Description (Values...) Pacdesign / bench E.....D
DATA STRUCTURE Host description Pacdesign / bench D.. Repository
General Documentation Pacdesign / bench D..G
DATABASE BLOCKS Host description Pacdesign / bench B...... Repository +
General Documentation Pacdesign / bench B.....G Specif. Database
Descrip.
HIERARCHICAL Hierarchical Block Descript. Pacbench B......DH Repository + DL1,
DB BLOCKS Hierarchical Block Docum. Pacbench B.....DH..G | SPD
CODASYL - DB2 | Codasyl-DB2 Block Descript. Pacbench B.....DC Repository +
DB BLOCKS Codasyl-DB2 Block Docum. Pacbench B.....DC...G ggcli)asyl and DB2,
Activity on a set (Codasyl) Pacbench C.....ACT
RELATIONAL - SQL | Relational-SQL Block Descript. | Pacbench B.....DR Specif. Database +
DB BLOCKS - SQL Relational-SQL Block Docum. Pacbench B....DR..G | SQL, SDD
Generation of SQL commands Pacbench B.....GEN
Building of Relational/SQL key Pacbench B.....DR..K
TURBOIMAGE Turboimage Block Descript. Pacbench B.....DT Repository +
DB BLOCKS Turboimage Block Docum. Pacbench B.....DT..G | Turboimage, SDD
SCREEN Host description Pacdesign / bench O...... On-Line Syst. Dev
DIALOG General Documentation Pacdesign / bench 0.....G ;;2‘:;?2::‘ cis
C/S SCREEN Calls of Elements” Pacdesign / bench O.....CE Pacbench C/S
BUSINESS COMPONENT | Host Mapping* Pacdesign / bench O....M User's Guide, Vol.
FOLDER Host Simulation* Pacdesign / bench O.....SIM 1.
Addressees of Elements* Pacbench O.....ADR
Calls of Segments Pacbench 0O.....Cs
Calls of P.M.S. Pacbench O....CP
Beginning Insertions Pacbench O....B
Work Areas Pacbench O....W
Local Specific Codes Pacbench O.....P
Procedure Titles** Pacbench 0.....TO
Proced. Titles and Conditions** | Pacbench 0...TC
Dialog Complement Pacbench 0.....0

* These commands do not concern the Business Component entity nor the Folder.
** These commands concern the Screen and the Dialog only.
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STANDARD ENTITY WORKSTATION COMMAND MODULE HOST ASSOCIATED
COMMAND | MANUAL(S)
PROGRAM Host description Pacdesign / bench P..... Structured Code +
General Documentation Pacdesign / bench P...G Batch Systems
Development
Calls of Data Structures Pacbench P.....CD
Calls of P.M.S Pacbench P.....CP
Beginning Insertions Pacbench P....B
Work Areas Pacbench P...W
Procedural Code (P) Pacbench P....P
Procedural Code (-8) Pacbench P.....8
Procedural Code (Cobol) Pacbench P.....9
Reverse Prog Source Code Pacbench P.....SC
Procedure Titles Pacbench P....TO
Proced. Titles and Conditions Pacbench p....TC
Reverse Program Structure Pacbench P.....STR
Procedures generated Pacbench P.....PG
REPORT Host description Pacdesign / bench R... Batch Systems
General Documentation Pacdesign / bench R..G Development
Layout Pacdesign / bench R...L
Call of Elements Pacdesign / bench R...CE
Description Pacbench R...D
SEGMENT Host description Pacdesign / bench S... Specifications
LOGICAL VIEW General Documentation Pacdesign / bench S..G Dictionary +
. Pacbench C/S
Call of Elements Pacdesign / bench S...CE Reference +
General Documentation on El. Pacdesign / bench S....DED Pacbench C/S
Data Element Details Pacbench S...CE..G ILIJ'?er's Guide, Vol.
Level-Address-Length Pacbench S....LAL
Statistics Pacbench S...STA
SQL View Description Pacbench S....DBE
Distributed Activities Pacbench S....ACT
TEXT Host description Pacdesign / bench T...... Specifications
Contents Pacdesign / bench T....G Dictionary
General Documentation Pacdesign / bench T....D
DOCUMENT/VOLUME | Host description Pacdesign / bench V... Personalized
General Documentation Pacdesign / bench V.....G Documentation
. Manager (PDM)
Plan and Call of Contents Pacdesign / bench V.....D
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The table below lists the entities which can be accessed only from the Emulator
window. The first column indicates the entity name with the entity code on the
host in brackets: the second column specifies the manual detailing the entity.

HOST ENTITY (Host code))

ASSOCIATED MANUAL

KEYWORD (K) Repository
LIBRARY (B) User's
PARAMETERIZED INPUT AID (1) Repository

USER ENTITY (F)

Dictionary Extensibility

USER-DEFINED RELATIONSHIP
(Q)

Dictionary Extensibility

USER ENTITY OCCURRENCE ($)

Dictionary Extensibility

USER MANUAL (U)

Repository
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Special Uses of Keyboard and Mouse in Logical Screens

The keyboard and mouse special uses apply to all logical screens (Windows:
List of Host Occurrences, Definition, Formatted Description, Host Mapping,
Generation-Print, Emulator, List of Journalized Transactions and Keyword
Search).

KEYBOARD

Esc
Restores the initial content of the field and repositions the cursor on the
first character.

Shift+Esc
Fills in the rest of the field with a dotted line. To exit this mode, press
Enter.

Ctrl+Home
Places the cursor on the first character in the field. To quit this mode,
press Enter.

Ctrl+Home
Positions the cursor on the first character in the field.

Shift+Home
Selects from the beginning of the field to the character to the left of the
cursor.

End
Positions the cursor to the right of the last character in the field or on the
last character if the field is full. The dotted line (Shift+Esc) is ignored.

Shift+End
Selects from the position of the cursor to the end of the field.

Ins
Switches from Typeover to Insert mode and vice-versa and modifies the
shape of the cursor.

Shift+Del
Deletes the selected field in the screen and transfers it to the clipboard.

Ctrl+Ins
Copies the selected field in the screen and transfers it to the clipboard.

Shift+lns
Inserts the content of the clipboard in the field at the cursor position.

Backspace
Deletes the character to the left of the cursor and moves the contents of
the field and the cursor one character to the left.

Alt+Backspace
Cancels the last edit action.

Del
Deletes the character to the right of the cursor and moves the contents of
the field one character to the left of the cursor without changing the
cursor position.

Left arrow
Moves the cursor one character to the left.

Right arrow
Moves the cursor one character to the right.
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Up arrow
Moves the cursor one line up.

Down arrow
Moves the cursor one line down.

Shift+Left arrow
Selects the character to the left to the cursor.

Shift+Right arrow
Selects the character to the right to the cursor.

Ctrl+Alt+Space bar
Selects the character string on which the cursor is positioned.

Ctrl+Space bar
Selects the entered field and the input field.

Ctrl+Shift+Space bar
Selects the entire input field.

MOUSE

Mouse buttons: cursor positioning

= Left button : positions the cursor where you click.

= Right button : opens the Related Entity dialog box, if the field in which
the cursor is placed can accept an occurrence code. This action is similar
to activating Related Entity in the Entity menu.

Mouse buttons: selection

= Left button : selects the contents of the field over which you slide the
mouse pointer.

= Citrl+Left button : selects the entered field of the input field.
= Ctrl+Shift+Left Button : selects the entire input field.

= Double-click with Left button : selects the character string on which the
cursor is positioned.
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Error Messages

There are approximately 3,000 error messages which may appear during
operations with the VisualAge Pacbase WorkStation. It is thus difficult to list
them all here, especially as these messages are frequently modified. It is
therefore worthwhile explaining the standards adopted for writing these
messages, which are generally explicit, with a few exceptions, created for
security reasons, which do not appear during normal use of the VisualAge
Pacbase WorkStation.

Structure of Error Message Boxes

The error messages are displayed in message boxes. There are two categories
of error messages.

Error Messages from the Host

Some messages come directly from the host and appear in a message box
such as the one below:

=|  MESSAGE FROM HOST

ENTITY TO BE CREATED

Error Messages from the WorkStation

The structure of most message boxes is standardized.

Application code

‘='| LI v Y nu.'ning
@ 9499 Please terIninate all Commands in progress

__________________________

Error number Message |
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The part corresponding to the title of the message box contains:

The emitting application code. For an exhaustive list of these application
codes, refer to the next section.

The error gravity to the right of the application code. Five gravity levels
are used.

¢+ System error :
Serious error preventing the WorkStation from operating normally.

BIBSS - System Error

1401 File BIBLLLIS or SESSION.LIS not found. Please Restore

¢+ Error:
You must react according to the message.

‘ |

@ 10036 Cannot close Window while command in progress

l GRAPH - Error

+ Question :
You must answer the question.

|

P.ﬁHCEX - Please confirm...

9 Download is ovell. Do you wish to access the Description?

| Non

+ Warning (or Note):

Minor error.

‘ |

@ Non-transmitted modifications will be lost...

DESCF - Warning

Annuler
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+ Information

\=.\ lDESCF ~ Information

0 Requested occurfence is not a Segment. itis a Logical View

The other part of the message box normally contains, in addition to the
message itself, an error number, button(s) and an icon which varies according
to the gravity level.

It is important to communicate the "Application code + Error number"
combination to your HelpDesk when requesting an explanation of a given

message. These two elements are used to determine the usual
circumstances causing the error and for troubleshooting.

Question and Information categories do not contain error numbers.
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List of Application Codes

APPLICATION CODE

The VisualAge Pacbase WorkStation consists in applications (executable
programs) which may emit error messages. This alphabetical list allows you to
identify the application emitting the message from the application code
generally contained in the message box. If necessary, this 5-character code and
the error number should be communicated to your HelpDesk.

FUNCTION or CORRESPONDING WINDOW

BIBSS
BOUCH

CHAIN

HELP
CONNX
DEFIN
DESCF
DESCL
DSTXT
DVACS

ECRCS

EDGEN
EMPAC
EXTMQ

GPMON

GRAPH

ILRTF

JOURN
LIENS
LISTE

MAQCE

Library/Session.
Lock transfer (started up from the Local List).

Backup of X-references between a graph and its content. Sub-
application of GRAPH.

Online Help

Connection and Disconnection.

Definition Screens.

Formatted Descriptions.

Non-Formatted Descriptions.

Chart Facility.

Call of segments (semi-local) (for Folder and Folder View entities)

Call of Segments (semi-local) (for Screen, C/S Screen and Business
Components entities).

Generation-Print.
Emulator.
Data Extraction.

Generation-Print monitoring (available if the VisualAge Pacbase host is
0S/2, UNIX Or WINDOWS NT type).

Processing of graphs.

Local Printing of Volumes to the RTF format. See chapter "The
WorkStation Manager Window", Host-Access menu, Local Volume
Printouts choice.

Consultation of the Journal.

Update link/X-refs. in a graph. Sub-application of GRAPH.

Host Occurrence Lists and Cross-references.

Host Mapping of Screens.
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FUNCTION or CORRESPONDING WINDOW

MAQLO
NAMES
PACEX
PEXEC
PGMCD
SIMCE
SIMLO

STRUC

TEXT
UP_DW

VALID

WSRCH

WSTIM

Local Mapping of Screens.

Update of icon names or links in a graph. Sub-application of GRAPH.
WorkStation Manager.

Start-up application of the WorkStation

Call of Data Structures

Host Simulation of Screens.

Local Simulation of Screens.

Local Specific Code (Program, Screen, Client / Server Components and
Dialog).

Text Processing.

Upload and Download of an occurrence description.

Validation of a graphic description by checking the consistency of the
links between the occurrences represented in the graph. Sub-application
of GRAPH.

Keyword Search.

Application allowing to activate the WorkStation applications from an
exterior tool as project management applications.
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